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Preface

CIMS Web Reporting is a key portion of the CIMS Server chargeback system. It offers a
full range of IT resource reporting features that are accessible via your Web browser.

The technology behind CIMS Server and CIMS Server Web Reporting is based on CIMS
Lab’s many years of experience in the development and implementation of Resource
Accounting, Capacity Planning and IT Chargeback products.

About CIMS Lab

Founded in 1974, CIMS Lab has focused on meeting the financial and resource reporting
requirements of Information Services Departments. CIMS has evolved with corporate IT
management requirements. Focused commitment to client service and support sets
CIMS apart from competing products. Our goal is to provide the best chargeback and
resource reporting software in the world at the lowest possible cost to our customers.

CIMS Lab strongly believes in and executes the concept of continuous product
improvement. Customers have access to CIMS product development personnel to
ensure that customer feedback and other critical issues are incorporated into the next
release of the product.
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Contacting CIMS Lab

To contact CIMS Lab with questions, comments, or problems, please use one of the
following methods:

For product assistance or information:

USA & Canada, toll free - (800) 283-4267

International - (916) 783-8525

FAX - (916) 783-2090
World Wide Web - http://www.cimslab.com

Mailing Address:

CIMS Lab, Inc.

3013 Douglas Blvd., Suite 120

Roseville, CA 95661-3842

About This Guide

This guide explains how to use CIMS Server Web Reporting. Note that some features
described in this guide might have been customized for your organization. In this case,
consult your CIMS Server administrator for assistance.

CIMS Server Web Reporting is a component of CIMS Server. This guide assumes that you
have the CIMS Server system installed and configured as described in the CIMS Server
Administrator’s Guide.

This guide contains the following chapters:.

Ch.

No.

1

Chapter Name

Getting Started

Running Reports

Working With Reports

Running and Working
With CIMS Advanced
Spreadsheets

Administering CIMS
Server Web Reporting

Content Description

Introduces the CIMS Server Web
Reporting interface and provides steps
for logging in and out and other tasks.

Introduces the different report types
and describes how to run these reports.

Describes how navigate and use
generated reports.

Describes how to use CIMS Advanced
Spreadsheets.

Describes how to configure user-
specific and system-wide
administration settings for CIMS Server
Web Reporting.
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. Chapter Name

Content Description

Describes how to use Miscellaneous,
Recurring, and Credit transactions.

6 Using Transactions

7 Troubleshooting Describes problems you may
encounter while using CIMS Server

Web Reporting and how to solve them.

A Standard Reports Describes the standard graphs, reports,
spreadsheets, and templates available

with CIMS Server Web Reporting.

Terminology Used in This Guide: Reports, Graphs, and Spreadsheets

For simplicity, in this guide, the term “report” refers to reports, graphs, and spreadsheets
unless noted otherwise.

Conventions
Some or all of the following conventions appear in this guide:

Symbol or

Type Style

Represents Example

Alternate hyperlinked cross-references to ... see Related Publications.
color other sections in this guide; if you
areviewing this guide online, you
can click the cross-reference to
jump directly to its location
Italic words that are emphasized ...the entry after the current entry...
a new term ...by identifier values.
the titles of other manuals CIMS Server Administrator’s Guide
Bold names of interface items such as The Reports menu
tabs, boxes, buttons, lists, and
check boxes. Select the Change Password check
box
The Group Tree appears in the
Preview tab
Monospace directories, file names, command Server folder

names, computer code, computer
screen text, system responses,
command line commands, what
the user types

ProcTransactions.wsf script

Typeiisreset /restart

CIMS Server Web Reporting User’s Guide
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Symbol or
Type Style Represents Example
<> the name of a key on the Press <Enter>
keyboard
» navigating a menu or a folder Reports » View Published Reports

Related Publications

As you use this guide, you might find it helpful to have the CIMS Server Administrator’s
Guide available for reference.
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Getting Started

This chapter describes how to get started using CIMS Server Web Reporting. CIMS Server
Web Reporting is accessible via your Web browser (see Starting CIMS Server Web
Reporting on page 1-2).

About CIMS Server Web REPOItiNG ....ovvvuitiiiiiiiieiiiiiieieieieieieieeesenenccnnns 1-2
Types of CIMS Server Web Reporting USers .......ccoeuiuieienininieneneneenenencncenenens 1-2
Starting CIMS Server Web RepoOrting .......covuiuiiiiiiiiiiiiiiiiiiiieiieieiencnnencnens 1-2
Logging On To CIMS Server Web Reporting ..........cceviiiiiiieieiiiiienenincenenennns 1-3
USiNgthe MeNU BAr .......ouiiiiiiiiii it ittt ittt ittt i eieeseeennns 1-5
Changing YOUr PassSWOrd .......ouvenieninieieiiiinieieienienenensesesescasenescscasencncns 1-5
LOgEINgG Off ..ttt iiiiiiiiiiiiitttitieiteeesesensnsrersesssssscscnsncnnns 1-6
ViewingOnline Help .....ouvuiiniiiiiiiiiiiiiiiiiiiiiiiiiieittieieienteteencnsenencncnns 1-6
11011 =00 1 T 1-6
Assigning CIMS Server Folder Security PEermissions ...........c..coeiviiiiiieiiiieieiennnns 1-7
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B Getting Started

About CIMS Server Web Reporting

About CIMS Server Web Reporting

CIMS Server Web Reporting enables you to generate and view IT chargeback and
resource accounting reports from a Web browser. These reports include invoice, budget,
summary, trend, and variance reports in report, graph, and spreadsheet format.

You can save, copy text from, and print reports. In addition, many reports generated
using CIMS Server Web Reporting include multi-level drill down capabilities that enable
you to view detailed resource usage and cost information.

CIMS Server Web Reporting supports reports written in any of the following:
m SQL Server Reporting Services
m Crystal Reports

m XML (this is the format used for CIMS Advanced Spreadsheets, see Chapter 4, Running
and Working With CIMS Advanced Spreadsheets)

Note ¢ Although CIMS Server Web Reporting is designed to use the preceding
reporting tools, you might be able to use other reporting products. For more
information, contact CIMS Lab (see Contacting Technical Support on page 7-5).

Types of CIMS Server Web Reporting Users

There are two types of CIMS Server Web Reporting users:

B Administrators. Administrators can perform administrative functions in CIMS Server
Web Reporting such as changing the configuration options for the application (see
Configuring System-Wide Settings on page 5-8). Administrative access is assigned by
your CIMS Server administrator. For more information, refer to the CIMS Server
Administrator’s Guide.

m End Users. End users have no administrative privileges.

The terms CIMS Web administrator and CIMS Web end user are used in this guide to
differentiate the two user types when needed.

Starting CIMS Server Web Reporting

H 1-2

To start CIMS Server Web Reporting, open your Web browser and enter the [/RL for
CIMS Server Web Reporting in the Address bar. The specific URL depends on your
organization—see your system administrator for the URL. The following is an example
of a URL for CIMS Server Web Reporting:

http://<intranet>/cims/

If you are running the browser on the server that is running CIMS Server Web Reporting,
enter the URL http://localhost or http://servername, where servername is the name of
the local server.

CIMS Server Web Reporting User’s Guide
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Logging On To CIMS Server Web Reporting

Logging On To CIMS Server Web Reporting
There are two methods for logging on to CIMS Server Web Reporting:

m Auto logon. Auto logon enables you to use CIMS Server Web Reporting without first
logging on to the application through the Login page. If your CIMS Server
administrator has enabled auto logon for your user ID, you will see the following
message on the home page when you start CIMS Server Web Reporting:

Welcome username, you are currently signed on as userid

If you are a CIMS Web administrator, you can click Login to open the Login page and
log on as another user if needed (see the steps under the following bullet, Manual log
on). If you are a CIMS Web end user, the Login page is inactive.

® Manual logon. If your CIMS Server administrator has not enabled auto logon for
your user ID, you will see the following message on the home page when you start
CIMS Server Web Reporting:

Not currently signed in, please click Login to begin
To log on, do the following:

1 On the CIMS Server Web Reporting home page, click Login to open the Login
page.

2 Enter the following information, and then click OK:

e Your user ID and password (required). If you do not know your user ID and
password, contact your CIMS Server administrator.

The password is case-sensitive. Type the password exactly as provided by your
CIMS Server administrator.

e Your company or organization name (if the Your Company or Organization
box is present). Your CIMS Server administrator determines whether this box is
present on the Login page. For more information, refer to the CIMS Server
Administrator’s Guide.

Your company/organization name is saved in a cookie so that you do not have
to re-enter it each time that you log on.

The CIMS Server Web Reporting home page reappears as shown in example
Figure 1-1 on page 1-4.

CIMS Server Web Reporting User’s Guide 1-3 W
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Logging On To CIMS Server Web Reporting

H 14

CIMS5 Server - Microsoft Internet Explorer

File:

Edit  View Favorites  Tools  Help

@Back < J @ @ \hh pSearch *Favorites @Media Q‘B 2 w2 :\?\— E _J tﬁ

Address @ http: fflocalhost fdef aulk, asp

CIMS

Server

Login Reports Spreadsheets Favorites Admin Help Logout Home

C l MS LAB, INC.
Login successful

Welcome CIMS Server Administrator, you are currently signed on as admin

CIMS Server is the Enterprise Wide Systern for managing IT costs, A central repository of resource usage data is
collected from OS/390, NT, UNIX, Metwork, e-Commerce, and more, Any source of resource usage can be
collected and reported on. Web based reporting makes resource usage information immediately available across
your organization. & complete system for today's complex IT processing environment,

CIMS Lab, Inc.
3013 Douglas Blvd,, Suite 120
Roseville, T4 95661

www.cimslab.com
Phone: (9163 783-8525 | Toll-Free: (G00) 283-4267 | Fax: (916) 783-2090
Copyright @2001 CIMS Lab, Inc - All rights reserved Created 10/10/2003 1:28:53 PM

Figure 1-1 « CIMS Server Web Reporting Home Page

CIMS Server Web Reporting User’s Guide
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Using the Menu Bar

Using the Menu Bar

The menu bar enables you to easily navigate CIMS Server Web Reporting features. The
use of the links and menus contained on the menu bar are discussed in the following
chapters.

Figure 1-2 provides an overview of the functions of each of the links and menus on the
menu bar.

(lick here to log on to the system Point here to view your favorite reports

Point here to access reporting features Point here for administrative options

| Point here to view Help

'h Spreadsheets Favorites Admin

Help Logout Home

Run Rports ‘

¥iew Published Reports Click here  Click here to return
Create a Report tolog out to the home page

Figure 1-2  CIMS Server Web Reporting Toolbar

Changing Your Password

Note ¢ If you are a CIMS Web end user and are using auto logon, the information in
this section is not applicable. However, if you are a CIMS Web administrator using
auto logon, you can change the password of other users using the following steps.

Your CIMS Server administrator assigns user IDs and passwords using the CIMS Server
Administrator program. If the Change Password check box is present on the Login page,
you can change your password as follows:

1 Click Login to open the Login page.

2 Type your user ID, current password, and company or organization name (if
required).

3 Select the Change Password check box and then click OK.

4 On the Change User Password Page, type your current password and the new
password as directed. The password is alphanumeric and case-sensitive and can be a
maximum of 16 characters.

5 Click OK to change the password and return to the home page.

Your CIMS Server administrator determines whether the Change Password check box is
included on the Login page. For more information, refer to the CIMS Server
Administrator’s Guide.

CIMS Server Web Reporting User’s Guide 1-5 |
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Logging Off

Logging Off

Note ° If you are a CIMS Web end user and are using auto logon, this section is not
applicable.

If you are a CIMS Web administrator using auto logon, you can log on and off as other
users during the same session by clicking Login and following the steps for a manual log
on page 1-3.

If you are not using auto logon, click Logout to enable one user to log off and another
to log on during the same session. The home page opens with the prompt:

Not currently signed in, please click Login to begin.

Viewing Online Help

To view online Help, click Help.

Timing Out

If you are inactive for a period longer then the amount of time specified on the Edit
Configuration page (Admin » Configuration), the CIMS Server Web Reporting session
times out. If the session has timed out, one of the following occurs when you attempt to
perform another task:

m If you are a CIMS Web end user and are using auto logon, you are automatically
logged out and directed to Please Togin. Simply click Login to log on automatically.

m For all others, you are automatically logged out and are returned to the Login page to
log on again.
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Assigning CIMS Server Folder Security Permissions

Note ¢ Your CIMS Server or Windows® administrator should have already set the
required folder security permissions described in this section. For more information,
refer to the CIMS Server Administrator’s Guide.

All CIMS Server Web Reporting users must have the following security permissions for
the CIMS Server program folders shown. If CIMS Server is installed in the default
location, the folders are in C:\Program Files\CIMSLab.

Folder Required Permissions

Server Read & Execute
Server\Web\temp Full Control
Server\Reports\Published Read & Execute, Write
Admin Read & Execute
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Running Reports

This chapter describes how to run reports in CIMS Server Web Reporting.

Note ¢ For simplicity, the procedures in this section reflect commands in the Reports
menu. However, these procedures are also applicable to spreadsheets. For example,
if you are instructed to click Reports » Run Reports, the corresponding sequence for
spreadsheets is Spreadsheets » Run Spreadsheets.

This chapter is not applicable to the CIMS Advanced Spreadsheets feature. This
feature is discussed in Chapter 4, Running and Working With CIMS Advanced

Spreadsheets.
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About Account COAES . ... . i 2-7
Example: Running a Report . ... ... .. 2-8
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Deleting a Web User Created Report ......... ... ... i, 2-10
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PUDIiShing RepOIts . . ... o e e 2-12
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Introduction to Report Types

There are four types of reports that you can generate using CIMS Server Web Reporting:

m Standard or Custom Reports. CIMS Server includes a variety of standard Crystal and

SQL Server Reporting Services reports. These standard reports include invoice, budget,
summary, trend, and variance reports in report, graph, and spreadsheet format (see
Appendix A, Standard Reports).

The report descriptions and examples used in this guide reflect the standard CIMS
reports. Typically, your report developer will customize the standard reports for your
organization or will create new reports. Therefore, the parameters, look, and content
of reports for your organization might differ.

To run standard and/or custom reports, click Reports » Run Reports and follow the
steps in Running Reports on page 2-3

CIMS Web User Created Reports. These reports are created using report templates
that are supplied with CIMS Server Web Reporting (see Templates on page A-104) or
developed by your report developer. Template reports differ from the standard or
custom reports discussed previously in that CIMS Web users can create reports that
contain the data and format that they want directly within the CIMS Server Web
Reporting interface.

To create a report, click Reports » Create a Report and follow the steps in Creating
and Running CIMS Web User Created Reports on page 2-9.

Published Reports. These reports are created from generated reports. Publishing a
report enables other CIMS Web users to view the report with the data as it appeared
at the time the report was generated.

To publish a report, follow the steps in Creating and Viewing Published Reports on
page 2-12.

CIMS Advanced Spreadsheets. CIMS Advanced Spreadsheets have more advanced
features than Crystal Reports or SQL Server Reporting Services spreadsheets,
including drill down and sorting capability. CIMS Advanced Spreadsheets are
discussed in Chapter 4, Running and Working With CIMS Advanced Spreadsheets.
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Running Reports

This section provides the steps for running a report from the CIMS Server Web Reporting
application. You can also run and publish reports in batch mode as described in Creating

and Viewing Published Reports on page 2-12.

To run areport:

1

Reports

= invoices

Invoice by Account Level
Application Cost ;”_“)
Account Total Invoice
Alternate Invoice

Invoice with Budget

Invoice with Shifts

Run Total Invoice with Shifts
Run Total Invoice

Run Total Percent

Run Total Rate Group Percent
Zero Cost Center Invoice
Invoice by Account Level ¥2

Account Reports
Top Usage Reports
Variance Reports
Trend

Resource Detail
Other

Figure 2-1 « Report Links

Running Reports

Click Reports » Run Reports. The report page opens displaying reports categorized
by groups.

To expand the group, click + next to the report group that contains the report that you
want to run.

Links to the available reports appear. Click the link for the report that you want to run
as shown in example Figure 2-1.

4 If the report requires parameters, enter the parameters on the parameters page and

CIMS Server Web Reporting User’s Guide

then click OK to generate the report. For a description of the standard parameters
supplied by CIMS Lab, see Using Report Parameters on page 2-4.
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Running Reports

You can do many things with the information in the generated report such as drill down
on data and print and save the report. For more information, see Chapter 3, Working With
Reports.

Note ¢ Drill down is not available for graphs, spreadsheets other than advanced
spreadsheets (see Chapter 4), or CIMS Web user created reports.

You can also publish the report so that others can view it in CIMS Server Web Reporting.
Published reports are saved with the data that was generated at the time the reports were
published. For more information, see Publishing Reports on page 2-12.

Using Report Parameters

H 24

Table 2-1 provides a description of the report parameters that are supplied by CIMS Lab.

Your reports might use other parameters that are custom for your site. For information
about creating custom parameters, refer to the CIMS Server Administrator’s Guide.

The parameter values that you enter are stored in a cookie so that you do not have to re-
enter the values each time you run a report (unless you want to change the values).

Note ¢ Parameters vary by report.

Parameter Description

Account Code Level The account code level that you want to view in the report.
For example, the account code AABBBBCCC might contain
three levels: the two-digit company code AA, the 6-digit
division code AABBBB, and the 9-digit department code
AABBBBCCC. The resource use and charge data will reflect
the level that you select.

For more information about account codes, see About
Account Codes on page 2-7.

Audit Type The type of changes that you want to view in CIMS Client,
Rate, and Transaction table audit reports: all changes,
additions, updates, or deletions.

Calendar Period The calendar period for the data that you want to appear in
the report.
Display Graph If this parameter is Y (the default), a graph appears before

the report. If this parameter is N, the graph does not appear.

From/To The beginning and end dates for the data that you want to
appear in the report.

Table 2-1 « Report Parameters
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Running Reports
Parameter Description
Identifier This parameter provides data by the selected identifier. An

identifier is a unique key that denotes the source of a
resource that has been consumed (for example, a device
name, server name, user ID, phone number).

Invoice Number Some invoice reports contain separate invoices for the
account codes selected. If this parameter is blank (the
default), invoice numbering begins with 1. Use this
parameter to begin invoice numbering from a another
number (if needed).

Your CIMS Server administrator determines whether this
parameter appears for invoices. If this parameter is not
available, the invoice number set in the
CIMSConfigOptions table in the database is used and
invoice numbers continue to increase sequentially each
time you run an invoice. For example, if the last invoice in
a report was 99, the next invoice that you run will begin
with invoice number 100. For more information, refer to
the CIMS Server Administrator’s Guide.

Prorate The amount that you want to prorate across accounts in
proration reports.

Rate Code This parameter provides data by the selected rate code. A
rate code represents resource units consumed (for example,
CPU time used, pages printed, e-mail message sent).

Rate Group This parameter provides data for the selected rate group. A
rate group contains rate codes.

Report Month The month for the data that you want to appear in the
report.

Report Year The year for the data that you want to appear in the report.

Set the Date Range The date range or the data that you want to appear in the
report.

Start and End Value The starting and ending identifier value.

Table 2-1  Report Parameters (Continued)
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Parameter Description
Starting and Ending This parameter works in conjunction with the Account
Account Code Code Level parameter and specifies the account codes for

that level that appear in the report.

If you want all account codes for that level to appear in the
report, click Lowest Possible Account for the starting
account code and Highest Possible Account for the ending
account code.

If you want specific account codes, click the appropriate
start and end codes or click Custom and type the start and
end codes.

Transaction ID Start and This parameter provides data by the selected CICS

End transaction ID range. For example, if you want data for the
following three transaction IDs: CESF, DEGV, and TINQ,
type CESF as the start and TINQ as the end.

TopN This parameter specifies the number of account codes that
appear in a report or the drill down for a report. For
example, if you type 1, only the account code that used the
most resources or incurred the most charges appears. If you
type 2, the highest and second highest account codes
appear.

Transaction Type This parameter provides data for the selected transaction
type. For more information about transactions, see
Chapter 6, Using Transactions.

Zero Cost Processing The Zero Cost Invoice report may be processed in two ways:

Option m A-Factor Total. This factors the invoice total by the zero

cost amount.

m B-Factor Rates. This factors each resource rate by the zero
costamount.

Zero Cost Amount The zero cost amount. You can type this amount with or
without the decimal point. For example, 100000 or
100000.00. For more information about zero cost, refer to
the CIMS Server Administrator’s Guide.

Table 2-1 + Report Parameters (Continued)
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About Account Codes

An account code is an alphanumeric string that identifies the hierarchy of a resource
record. Account codes contain sufficient information to describe what resource was used
by what entity. These codes may contain levels such as Company, Division, Cost Center,
etc.

For example, if your organization cost center structure is:

Level 1 Company

Level 2 Division

Level 3 Department within division
Level 4 Cost Center within department
Level 5 Application within cost center

Your account code structure might be designed as shown in Table 2-2.

DESCRIPTION (LEVEL) EXAMPLE

Full Account Code AABBBBCCCDDDAPP1
Company Code AA

Division Code BBBB

Department Code CCC

Cost Center Code DDD

Application Code APP1

Table 2-2 « Example Account Code Structure

The account codes and account code levels that appear on the parameters page are set by
your CIMS Server administrator. For more information, refer to the CIMS Server
Administrator’s Guide.
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Example: Running a Report

Figure 2-2 provides an example of the parameters used to create an Invoice by Account
Level report for the month of June. In this example, Division is the first level of the
account code. Figure 2-3 shows the resulting report.

A CIMS Server - Microsoft Internet Explorer, E\Iﬁl@

File Edit View Favorites Taools  Help
Q- Q @& ) ssarch 'z Favores ) - _\? ol .

Address @ hitp: [ fwwws. cimsserver . comfgov/nethook, asp?reportfile=rinvc007 rptareporttemplatefle=greportname=Invoice:20by%20Account %2 0Level v B @

CIMS

Server

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Invoice by Account Level
Please select parameters for Reports.
Account Code Level :
Invoice Number :
Display Graph :
Starting Account Code : | | Lomest Possible Account ]
Ending Account Code : | |[Highest Possible Account ]
Set the Date Range :
oK Canoel
v
£ >
&) © Intermet
—

Figure 2-2 « Example Parameters for the Invoice by Account Level Report

2 CIMS Server - Microsoft Internet Explorer,
File Edt View Favorites Tools Help >

Qe - ©) @ @ __7;} /ﬁ Search “T:E‘Favw\tes [ 2] [f{v ; B 3 év

acddress | ] hitpe fum, cmsserver.comfgovCrystalReportsnteractiveiswer sspPlnvaicel evel=1&:ConfigOrgame=The+Big+Time-+GovernmentiConfighddressLine1 =fny+3tat | [ G0 @

Invaice by Account Level

Publish Return

® PP A | E

-administrative Services
Health & Human Services
‘Department of Transportation Tnvoice
f-Department of Corrections  pilling Period: 11/1/2004 to 11/30/2004 Date I'ange Seleded
E-Department of Education ; . A A
Invsice No. 20 Starting invoice number selected
The Big Time Government
Any State, USA,
Level 1 Ab - Administrative Services
account codes
Units Rate Charge
Mainframe Jobs Started 9 2.00000000 18.00
Mainframe Steps Started 9 0.20000000 1.80
Mainframe Batch charges 19.80
Tzo Cpu Minutes 1.09 2500000000 27.24
Tzo Connect Minutes 755,31 002500000 18.87
Tso Inputs 1124 zoooonooo M 2.37
Tso Dutputs 1,297 1.00000000 M 1.31
Tso Cpu Minutes (Initiator) 0.34 0.00000000 0.00
Tso Cpu Minutes (All) 1.52 000000000 0.00
[Mainframe Tso charges 079 | v
&) B Internet

Figure 2-3 « Example Invoice by Account Level Report
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Creating and Running CIMS Web User Created Reports

This section describes how to create and run reports using the report templates provided
by CIMS Lab. Note that templates created by your report developer may differ.

Creating or Updating a CIMS Web User Created Report

The report templates provided by CIMS Lab enable you to choose the rate codes that you
want to appear in the report. You can specify that the report display the resource usage
per rate code, the resource cost per rate code, or both usage and cost. All cost and usage
is displayed by account code and rate code. Once you have created a report, you can
update the report (for example, select different rate codes) at any time.

To create or update a report:

1 Click Reports » Create a Report. The Build a Report page opens.

2 Enter or update the following parameters for the report:

Go to Report. Click New Report to create a new report or click an existing report
to update the report.

Report Type. Click the report type that you want to create:

* Resource (resource usage by account and rate code description)

e Cost (charges by account and rate code description)

e Both (resource and cost information)

Report Name (required). The name that you want to assign to the report.
Report Description. A brief description of the report.

Make visible to all users. If this check box is not selected (the default), the report
is available only to those in your user group. If this check box is selected, the report
is available to all CIMS Web users.

Resource. In the column select boxes, choose the rate code that you want to
appear in that column. You can choose up to four columns/rate codes for Both
reports and eight columns/rate codes for Cost or Resource reports.

Decimal Places. Type the number of decimal digits that you want to appear in the
resource usage amount.

3 Ifyou are creating a new report, click Add. If you are updating a report, click Update.

Once created, reports appear on the Reports page (Reports » Run Reports) under a
report group determined by your CIMS Server administrator (see Figure 2-4 for an
example). For more information about setting the report group for these reports, refer to
the CIMS Server Administrator's Guide.
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Running a Web User Created Report

To run areport:

1 Click Reports » Run Reports. The Reports page opens displaying reports categorized
by groups.

2 Expand the report group that contains the created reports, and then click the report
that you want to run as shown in example Figure 2-4.

Reports

Invoices
Account Reports
Top Usage Reports
Yariance Reports
Trend
Resource Detail
Audit
Other
= web user
CPU Cost Report
Storage Resource Report

Job Rep%t

Figure 2-4 - Example Links for Web User Created Reports

3 Enter the parameters for the report on the parameters page and then click OK to
generate the report. For a description of the parameters, see Using Report Parameters
on page 2-4.

You can do many things with the information in the generated report such print and save
the report. For more information, see Chapter 3, Working With Reports.

You can also publish the report so that others can view it in CIMS Server Web Reporting.
Published reports are saved with the data that was generated at the time the reports were
published. For more information, see Publishing Reports on page 2-12.

Deleting a Web User Created Report

To delete a report:
1 Click Reports » Create a Report.

2 On the Build a Report page, click the report in the Go to Report select box.

3 Click Delete and then click OK in the confirmation dialog box to delete the report.
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Example: Creating and Running a Web User Created Report

Figure 2-5 shows the creation of a Both report called Job Report. Figure 2-6 shows the
resulting report that has been run from the Reports menu.

A CIMS Server - Build a Report - Microsoft Internet Explorer

File Edt View Favorites Tools Help L
: Al e P

Q- Q @0 S sesrch Slpravores €8 (- L o -

Address @ hittp: . cimsserver . comygov,DefineCustSumRpts. asp?OLtpUL Type=RaReset=true v B @

CIMS

Server

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Build a Report

Please select parameters for Report
Go to Report: | (New Report) v
Report Type: |Both v

Report Name: | Joh Report |

Report Description: |

[Imake visible to all users

Resource

Column 1: | Z001 - Mainframe Jobs Started v

Column 2: [ Z003 - Mainframe Cpu Minutes v|

Column 3: | v|

Column 4: | v|

Add

&) @ Internet
=

Figure 2-5 « Example of Creating a Report

2 CIMS Server - Microsoft Internet Explorer,

File Edit ‘View Favorites Tools  Help ai
Q- O X [@ 6 P Jrrom @ (3 15 g3 A
address @http:waw‘c\mssarver.mqunvfcrystaIRapnrtsInteractwawewar.asp?lr\vmceLevE\:l&RatEC o RateCode2=200 RateCode3=aRateCaded: V| Be @

Job Report Publish Return

Administrative Services

Heatth & Human Services CIMS : ..

Department of Transpartation Job Report

Department of Carrsctions

Account Range: All Accounts
Date Range: 11/1/2004 to 11,/30,/2004

Account Mainframe
Jobs Started Jobs Started  Cpu Minutes Cpu Minutes
Cost Cost

Af-Administrative Services

9.00 18.00

BB-Health & Human Services
117.00 234,00 2.61 @6.10

CC-Department of Transportation

6.00 12.00 39,66 396,65
DD-Department of Corractions

2.00 18.00 0.32 3.24
Run Total 141.00 252,00 49,60 495,99

E3

|~

® Tnternst

| DI

Figure 2-6 « Example Web User Created Report
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Creating and Viewing Published Reports

Once you have generated a report, you can publish the report. Publishing a report
enables other CIMS Web users to view the report without having to regenerate it.

Note * Reports that involve a wide range of dates or account codes can require
excessive system time and resources to generate. Consider publishing or saving these
reports for quicker access (see Publishing Reports vs. Saving Reports).

Published reports can be created directly within CIMS Server Web Reporting as described
in this section or in batch. CIMS Server includes a powerful feature that enables you to
generate published reports in batch and then distribute the reports to recipients via e-
mail. For more information about generating and distributing reports in batch, refer to
the CIMS Server Administrator’s Guide.

Publishing Reports vs. Saving Reports

Both publishing and saving a report saves a report that you have generated. However,
publishing a report saves the report on the Web server so that you and others can view it
from within CIMS Server Web Reporting. (Your CIMS Server administrator determines
where the published reports are stored on the server. For more information, refer to the
CIMS Server Administrator’s Guide.)

Saving a report saves the report to the local or network drive that you choose. In this case,
the report is not accessible via the CIMS Server Web Reporting interface. For more
information about saving reports, see Saving Reports on page 3-8.

Publishing Reports

m 2-12

To publish a report:

1 Run a report.

2 On the report page, click Publish. The Save Report window appears. Enter the
following:

¢ Report File. The file name of the published report. You can use the default file
name or type another name. If you want to include the report in your favorites list,
you need to use the default file name (see Working With Favorite Reports on
page 5-2).

e Location. Location specifies the subfolder name for the published reports within
the overall published reports folder. By default, this folder is named Pub1ishedand
isin C:\Program Files\CIMSLab\Server\Reports<type>. For example, if you click
User, the published reports are stored in the user subfolder within the Published
reports folder.
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Location also determines the accessibility of the report as follows:

e User. The report is available to the specified user only. If you are a CIMS Web
administrator, you can choose any user ID within your user group. If you are not
an administrator, the user defaults to your user ID.

e Group. The report is available to those in your current user group.

e Account. The report is available to CIMS users in a group that is allowed to view
the selected client account code. (To enable client account code access to a
group, refer to the CIMS Server Administrator’s Guide). The report is stored in a
subfolder with the same name as the account code that you click in the account
list. The Account option appears only if you are a CIMS Web administrator.

¢ Global. The report is available to anyone using CIMS Server Web Reporting. The
Global option appears only if you are a CIMS Web administrator.

Note ¢ The preceding access permissions are applicable only within CIMS
Server Web Reporting—it does not affect the ability of Windows users to access
reports from the hard drive. If you want to control access to reports via
Windows, you need to set Windows security for the folders that contain the
published reports. CIMS Web users, however, must have the permissions
shown in Assigning CIMS Server Folder Security Permissions on page 1-7.

¢ Reporting Period. The date period assigned to the report for storage and retrieval
purposes. This date period does not affect the date of the data in the report.

e Replace Existing Report. Select this check box to replace any existing published
report with the same file name with this report.

3 Click OK to publish the new report to the location that you specified.
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Viewing Published Reports

Note ¢ Links to published reports that are designated as favorite reports appear in
the left side of the home page. Click these links to quickly access these reports. For
more information about favorite reports, see Working With Favorite Reports on

page 5-2.

To view a published report:
1 Click Reports » View Published Reports.

2 The Published Reports page opens. The reports that appear on this page are
determined by the location that was set when the report was published (see Publishing
Reports on page 2-12) and the Date Range and Location parameters on the page (see
Filtering the List of Published Reports on page 2-15).

3 Click the report date, name, or location (if present, see the following note) to open
the report.

Note ¢ By default, published reports include the full path to the folder that
contains the report. You can choose to show or hide the path (see page 5-5).

Drill down capability in published reports varies by report.
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Filtering the List of Published Reports

You can filter the list of published reports using the Date Range and Location
parameters as follows.

Date Range This parameter lists reports by the reporting period that was assigned
when the published report was created (see Publishing Reports on
page 2-12). This may or may not be the date of the data in the report.

From and To Enter the beginning and end date of listed reports if you cannot select the
date that you want from Date Range.

Click the Calendar button to choose a beginning or end date for listed
reports.

it

Location Click one of the following:
m All. All published reports that you can view appear.

m Global. All published reports that were assigned to a Global location
appear.

m User. All published reports that were assigned to a User location that
you can view appear.

® Group. All published reports that were assigned to a Group location
that you can view appear.

m Account. All published reports that were assigned to an Account
location that you can view appear. If you click a specific account code,
published reports for only that account code appear.

Sorting the List of Published Reports
To sort the list of published reports by date or report, click Date or Reports, respectively.
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Example: Creating and Viewing a Published Report

Figure 2-7 shows the creation of a published Invoice by Account Level report.

Figure 2-8 shows the link for the resulting report on the Published Reports page

(Reports » View Published Reports).

2 CIMS Server, - Microsoft Internet Explorer \;Hﬁl@

Save Report Invoice by Account Level

Flease set parameters to save report

Repart File: ot

Location

OGVDUP Adrnin v
O sccount E

O Global

Reporting Period: Current 6/1/2003-6/30/2003 v

[replace existing Repart?

OK | Cancel |

Figure 2-7 « Example of Creating a Published Report

] http:/hwww.cimsserver.com/gov/Tsavedcntl.asp?select=1 - Microsoft Internet Explorer,

File Edit View Favorites Tools  Help

Q- Q @& ) search e Favores ) =2 :; - [l -

DEx

ke | ] htp: o, cmsserver,com/gov/Tsavedumt, aspselect=1

len @

CIMS

Server —

Login

Reports Spreadsheets Favorites Admin  Help Logout Home

Published Reports

Date Range: Current 11/1/2004 11/30/2004
From: 200 v

Date Reports Location
114372004 104835 A Invoice by Account Level

Location: | All hd

&

® Tnternst

Figure 2-8 » Example Published Report Link

B 2-16

CIMS Server Web Reporting User’s Guide



Running Reports H
Creating and Viewing Published Reports

Deleting Published Reports

Note ¢ To delete published reports, you need to have access to the server that
contains the reports.

To delete published reports, start Windows Explorer and navigate to the Published
folder. Delete the reports from the applicable subfolder.
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Working With Reports

This chapter describes how to navigate and use generated reports.

Working With REPOIES ....ouvniiiiiiiiiiiiiiiiiiiiiieieieieieieeececnceesesacacncnccenns 3-2
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Working With Reports

This section describes how to navigate and use reports. Except where noted, the
information in this section is applicable to all report types.

The figures in this section reflect Crystal Reports 9 using the default HTML viewer. If you
are not using this setup, the interface will appear similar.
About the Report Interface

Figure 3-1 provides an introduction to the report interface. The use of the interface,
including how to use the toolbar, is discussed in the following sections.

(lick here to return to the report parameters page

(lick here to publish the report

(lick here for Help

2 CIMS Server - Microsoft Internet Explorer I;I@EI
File Edt Wew Favortes Tools Help o

@rac - () d |§| _;j /"=Search ‘-;:E‘Favnrites & - 5 el 3 é-

cdivess [ €] httpsjjwy,cimsserver comigaviCrystaReportsInteractiveliewer, aspTlnvoiceL evel=1&/Corfigorghiame=The +Big-+Time-+ GovementaCorfighddhefsLine1=Any-+5tat

B @

Invoice by Account Level Publish Return Help

[ 1 Rl e =

Administrative Ssrvices
Health & Human Services
Departrnent of Transportation Toyoice
Department of Corrections
Department of Education

Billing Period: 11/1/2004 to 11,/30,/2004

Invoice No, 20

The Big Time Government
Any State, USA

AA - Administrative Services

Units Rate Charge
Group tree Mainframe Jobs Starmed s 2,00000000 1800
p Mainframe Steps Started s 0.20000000 1.80
Mainframe Batch charges 19.80
Tso Cpu Minutes 1.09 25.00000000 27.24
Tso Connect Minutes 755,31 0.02500000 1887
Tso Inputs 1,184 2.00000000 M 2,37
Teo Outputs 1,297 1.00000000 /M 131
Tso Cpu Minutes (Initiator) 0,34 0.00000000 0.00
Tsa Cpu Minutes (All) 1.52 0.00000000 0.00
[Mainframe Tso charges 4079 | ¥
&) & Intsrnst

Figure 3-1  Report Interface
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Using the Reporting Toolbar

This section provides an overview of the report toolbar options.

Printing a Report

To print a Crystal report, click the Print button. The Print button does not appear in the
toolbar for Reporting Services reports. To print these reports, you must export the report
to a PDF file from the toolbar.

5 2 R Y ® © COTEEA ® ?

Print button

Saving a Report

To save a report, click the Export button. For more information about saving reports, see
page 3-8.

® 2 R Y ® © COTEEA ® ?

Export button

Navigating a Report

To navigate through the pages of a report, click the page arrows or type a page number.
To open and close the Group Tree that appears to the left of the report, click the Show/
Hide Group Tree button. For more information about the Group Tree, see page 3-4.

2 % R S ® © COTEEA ® ?

Show/Hide Group Tree I—Page navigation: first, previous, next, last, go to a specified page

Zooming In or Out

To enlarge or shrink the size of information displayed in a report, click the Zoom button.

Al » o PETEEe o 2

Zoom button

Searching Text in a Report

To search for text in the report, type the text that you want to search for and then click
the Search button.

Al » ©° DETEEe o 2

Search text box and button Advanced search button
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Stopping a Report from Loading (ActiveX Viewer Only)

If you are using the ActiveX viewer, you can click the Stop Loading button |E| to stop a
report from loading. This button is available only when the report is loading.

Navigating Using the Group Tree

The Group Tree appears to the left of the report (see Figure 3-1 on page 3-2). This tree
view enables you to navigate down to data.

Note ¢ If the Group Tree does not appear, click the n toggle button.

Similar to the manner in which Windows Explorer displays folders and files, items in the
report are listed in the Preview tab as an expandable hierarchy.

To view the item in the report, click the item. To expand or collapse an item, click the +
or - beside the item.

Drilling Down in Reports

For certain items in a report, you can drill down to view information specific to that item
or you can drill down to generate a separate report for the item. For example, in invoices,
you can drill down on resource units to open a report that breaks out the units by
identifier (see Report Drill Down Example on page 3-6).

If you are using the ActiveX viewer, the cursor becomes a magnifying glass O\ when you
point to an item that enables you to drill down to more detailed information within the
report.

The icon becomes a hand l{b when you point to an item that enables you to drill down
to another report.

If you are using the HTML viewer, the hand cursor appears for both types of drill down.

To drill down in a report:

1 Place the cursor on the appropriate item in the report. For example, a rate or charge.

2 Double-click the item. Detailed information about the item appears.

3 You can continue to drill down where allowed to view additional detailed
information.
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To drill down to another report:

1 Place the cursor on the appropriate item in the report. For example, an account code
Or resource units.

2 Click the item. Depending upon item that you click, the report either appears in the
same browser window or in a separate window. If the report opens in a separate
window, the parameters page for the report appears first.

Note ¢ Drill down to another report is available only in invoice reports.

Closing the Drill Down View

To close the drill down view in a report:

If you are using the HTML viewer, click the Back button in the browser toolbar or Main

Report button on the report toolbar (Crystal 9 only).

If you are using the ActiveX viewer, click the close button El on the report toolbar or
right-click the drill down view tab and then click Close Current Drill Down View.

To close a drill down report:

Click the close button in the browser window @
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Report Drill Down Example

The drill down example shown in example Figure 3-2 shows a drill down on resource
units.

<2l CIMS Server - Microsoft Internet Explorer,

Fle Edit View Favorites Toos Help o
o ) A | O A A - B 3 >

Qe - © ¥ @ & ) search P Favares ) (- L H3a

acdcress | ] hitp fumw, cmsserver.comfgav/CrystaleportsInteractivebiensr .55p v B

Invoice by Account Level Publish Return

“Department of Transportation Tnyoice

#-Department of Corrections  pilling Period: 11/1/2004 to 11/30,/2004

E-Department of Education Invoice No. 2

The Big Time Government

Any State, USA

EE - Health & Human Services

Units Rate Charge
Mainframe Jobs Started 187 2.00000000 374.00
Mainframe Steps Started £R1 0,20000000 126.20
Mainframe Cpu Minutes 15% 10,00000000 167.31
Mainframe Cpu Minutes (Initiators) 4.63 0.00000000 0.00
Mainframe Cpu Minutes (All) z1.81 0.00000000 0.00
Mainframe Batch charges 677.51
Tso Cpu Minutes 9.75 2500000000 243,79
Tso Connect Minutes 2,883.75 0,02500000 72.10
Tso Inputs 2,300 z.00000000 /M 18,60
Tso Outputs 11,015 100000000 /M 11.02
Tin Cn Minuess (Tnirisrarl 1.4 nanAnAnAn n.on M
&) http: fumaws cimsserver..com/gov/detident  asp7reportfile=IINXC004.rptarepart ID=08AccountCodest art=EB&ACcauntLength=28DatesStart=11] B Internet.

Figure 3-2 « Drill Down on Units

The parameters page for the drill down report opens as shown in example Figure 3-3 on
page 3-7. This page enables you to break down and view the resource units by identifier
or identifiers.

Note that the possible identifiers that you can select include Usage Dates and
Accounting Dates. Usage dates are the actual start and end dates in the CIMS Server
Resource Records. Accounting dates are derived from the usage end date as described in
the CIMS Server Administrator’s Guide.

In Figure 3-3 on page 3-7, the identifiers Usage Dates and Jobname are selected.
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2 CIMS Server - Microsoft Internet Explorer,

Fie Edt View Favorites Tools Help
o D S - B = 3 -
cﬁack > \ﬂ @ _h ) search 5 ¢ Favaries ) = ﬁ 3 é
acddress €] hitpe fumw, cmsserver.comfgav]nethaok. sspPreportl=IINXCDD4 rptéreportID=0BAccount CodeStart—BBAccountL ength=280steStart=11/1j20048DsteEnd=1113 ¥ | [£] G0 @
-~
CIMS Reporting
Please select parameters for Reports.
Identifierl : [Usage Dates v
Identifier2 : |Jobname v
Identifierd : [**Optional™* ||
Identifierd : | **Optional**  ~
Identifiers : [**Optional™*
oK g Cancel |
v
< 3
(&) javascript:submitForm(}; # Internet

Figure 3-3 « Select Report Parameters

Figure 3-4 shows the resulting report. The units are broken down by usage dates and job
names.

ZA CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Taools  Help ~a’
) ( s n| @, B

Ow O BEG P drmo @3 BSLH B A

ke | ] hp: fwwmw,cimsserver com/gov/rystalReportsInteractiveizwer 2, asp | %o @

Publish Return

9.2 n JRE

Invoice Drilldown
BB - Health & Human Services
Mainframe Steps Started

Date Range: 11/1/2004 to 11/30/2004

Usage Dates
Jobname
11/1/2004-11/1/2004
CIMS0E 1
CIMSO3AL z
CIMSOFTM 1
CIMSO4 z
CIMSOE z
CIMS0E 1
CIMS10 3
CIMS10AL 3
CIMS10R z
CIMS1ORN 34
CIMSSMFD 2z
11/1/2004-11/1/2004 76
~
&) B Internet

Figure 3-4 « Drill down by Identifier Report
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Publishing Reports

See Publishing Reports on page 2-12.

Saving Reports

Note ¢ Saving a report is distinct from the process of publishing a report. Saving a
report saves the report to a local or network drive. When you save a report, users can
access the report from this location. When you publish a report, users can access the
report directly from the CIMS Server Web Reporting application. For more
information about published reports, see Creating and Viewing Published Reports on
page 2-12.

CIMS Server Web Reporting enables you to save reports that you generate so that you or
other users can access the report again without regenerating the report. For example, if
you run a daily report that others need to view, you can generate the report each day and
save it in an accessible drive or folder.

Note ¢ Reports that involve a wide range of dates or account codes can require
excessive system time and resources to generate. Consider publishing or saving these
reports for quicker access.

To save a report:

1 On the report page, click the Export button on the report toolbar E

2 Follow the instructions in the dialog boxes that are presented.

If you want to share the saved report with others, choose a network drive when you save
the report.

Copying Text From a Report

To copy an item in a report, right-click the item, and then click Copy. The system places
the text in the Windows clipboard, enabling you to paste the text into other applications.
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Working With Spreadsheets

This section describes how to use CIMS Server spreadsheets. When you run a
spreadsheet, CIMS Server Web Reporting presents the report data in Microsoft® Excel.
You must have Excel installed on the client running the spreadsheet.

About the Spreadsheet Interface

Figure 3-5 provides an introduction to the spreadsheet interface. You can view and/or
publish the spreadsheet from this interface or you can open the spreadsheet in Microsoft
Excel and save, print, and/or edit the spreadsheet.

Click here to return to the spreadsheet parameters page
Click here to publish the spreadsheet
Click here to open the spreadsheet in Excel

2 CIMS Server - Microsoft Internet Explorer

(lick here for Help

E=ES
ﬂr

File Edit View Favorites Taools  Help
Q- O KB G Loy @ 34

counts&Account Cods

a2 E-0d

Adidress | 48] hitps s, cimsserver. com/gov/Reptinvoke asp7ImvoiceLevel=18ACRangeDisplay=fccount+Range I

countiCol

Open with

Spreadsheet Invoice Excel

>

Publish Return

0433 - A

[ 8 [ ¢ ] D [ E T F a8
| 1 |Spreadshest Invoice 5
| 2 |Account Range: All Accounts =
| 3 |Date Range: 11/1/2004 to 11/30/2004
| 4 |AccountMame AccountCode RateCode RateDescription RateGroup | GroupTitle
| & |Administrative Services Ab oo Mainframe .Johs Started 2 Mainframe Batch
| 6 |Administrative Serices Ab 002 Mainframe Steps Started 2 Mainframe Batch
| 7 |Administrative Services Ab 20 Tso Cpu Minutes 3 Mainframe Tso
| 8 |Administrative Services Ab 4 Tso Connect Minutes 3 Mainframe Tso
| 9 |Administrative Services Ab mn21 Tso Inputs 3 Mainframe Tso
| 10 | Administrative Services Ab 22 Tso Qutputs 3 Mainframe Tso
11 |Administrative Services Al 703s Tso Cpu Minutes (Initiator) 3 Mainframe Tso
| 12 | Administrative Senices AR 2036 Tso Cpu Minutes (All) 3 Mainframe Tso
13 |Administrative Services Al 700 Total Sl0s & Mainframe Input/Qutput ck
| 14 | Administrative Services Ab 2006 Disk SI0s & Mainframe Input/Output ck
15 |Administrative Services Al 7008 3390 S510's & Mainframe Input/Qutput ck
16 | Administrative Services Ab 016 Lines Printed - Local 6 Mainframe Printer/Reader
17 | Administrative Services Ab w7 Lines Printed - Remote & Mainframe Printer/Reader
| 18 | Administrative Senices Ab 17 Pages Printed - Lacal 6 Mainframe Printer/Reader
19 |Administrative Services Al IRMTPAGE Pages Printed - Remate G Mainframe Printer/Reader
| 20 | Administrative Services Ab SMFENLR  Psf Mumber Of Lines Printed 6 Mainframe Printer/Reader
21 |Administrative Services Al SMFEPGE  Psf Number Of Pages Printed G Mainframe Printer/Reader
| 22 | Administrative Senices Ab SMFEIMPS  Psf Mumber Of Impressions 6 Mainframe Printer/Reader
23 |Administrative Services Al SMFEFEET  Psf Number Of Feet Of Paper G Mainframe Printer/Reader
| 24 | Administrative Services Ab L6 Disk Data Sets 7 Mainframe Storage
| 25 | Administrative Services Al IDSK@@01 Disk Space Allocated (MB days) 7 Mainframe Storage
| 26 | Administrative Senvices AR ZDSK@EED2 DISK Space Used In Above(MNan Wsarn) (MB days) 7 Mainframe Storage
| 27 | Administrative Services Al IDSK@@03 Secondary Space Allocated(Mon Veam)(ME days) 7 Mainframe Storage 3
1O b Sheet1/ o B 2 = T - — - = =
A
&) Done & Internet
—

Figure 3-5 + Spreadsheet Interface

Publishing Spreadsheets

See Publishing Reports on page 2-12.
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Opening a Spreadsheet in Excel

To open a spreadsheet in Excel:
Click Open with Excel.

The spreadsheet opens in Excel within the Web browser. You can then save, print, and/
or edit the spreadsheet using the Excel commands and toolbar.

If the Excel toolbar does not appear, click the Tools button @ on the browser toolbar.

Working With Spreadsheets in Excel

B 3-10

To save a spreadsheet:

1 Click File » Save As on the browser menu bar.

2 Navigate to the folder that you want to save the file in, and then enter the file name
and file type in the File name and Save as type select boxes.

3 Click Save to save the file to the location you selected.

Note * You need to click Save As each time you want to save the spreadsheet.
Clicking the Save button on the Excel toolbar will not save the spreadsheet.

For more information about the benefits of saving spreadsheets rather than regenerating
them, see Saving Reports on page 3-8.

To print a spreadsheet:

1 Click File » Print on the browser menu bar or the print button on the Excel toolbar.

To edit a spreadsheet:

Edit the spreadsheet as required and then follow the steps in To save a spreadsheet:.

To close a spreadsheet in Excel:
Click Back to return to the CIMS Server Web Reporting spreadsheet interface.

Note * Any changes you made to the spreadsheet while the report was open in Excel
are not saved in CIMS Server Web Reporting.
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Running and Working With
CIMS Advanced Spreadsheets

This chapter describes how to run and use CIMS Advanced Spreadsheets. Your CIMS
Server administrator determines whether CIMS Advanced Spreadsheets are available in
CIMS Server Web Reporting. For more information, refer to the CIMS Server
Administrator’s Guide.

About CIMS Advanced Spreadsheets ..........c.coiiieiiiiiiiiiiiieieieieieiececncncnenenss 4-2
Running CIMS Advanced Spreadsheets .............ccciiiiiiiiiiiiiiiiieiiiiiieieeienenen. 4-3
Running a Drill Down or Static Advanced Spreadsheet ................................ 4-3
Running a Crosstab Advanced Spreadsheet ............ . ... ... ... i, 4-6
Working With CIMS Advanced Spreadsheets ...........c.coeiiiiiiiieieiiieiiiiiienenenenss 4-8
About the CIMS Advanced Spreadsheet Interface ........... ... ... ... 4-8
Advanced Spreadsheet Column Description .......... .. .. ..., 4-9
Drilling Down in a Spreadsheet . ... ... ... . . . 4-10
Working With CIMS Advanced Spreadsheetsin Excel ...................... .. ... . ... 4-12
Standard Advanced Spreadsheet Descriptions ............ccocviiiiiieiiiieieieninienenes 4-14
Complete SUMMArY VIEW . . ... e 4-15
Summary By Account Code ... ... i e 4-18
Summary By Rate Code . ........... . i e 4-21
summary By Rate Group ... ... 4-24
Crosstab Spreadsheet . .......... ... e 4-27
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About CIMS Advanced Spreadsheets

H 4-2

The CIMS Advanced Spreadsheets feature enables you to build spreadsheets that provide
more options than the standard spreadsheets described Appendix A, Standard Reports,
including drill down and sorting capability.

The descriptions and examples used in this chapter reflect the advanced spreadsheets
provided with CIMS Server. The spreadsheets used by your organization, including the
names, parameters, look, and content of the spreadsheets, might differ for your
organization.

There are three types of standard advanced spreadsheets. The data that appears in the
spreadsheets is based on the parameters and columns that you select for the spreadsheet.

B Static. Provides a static view of data.

m Drill down. Provides the ability to drill down on data in a spreadsheet to view
detailed data.

m Crosstab. Crosstab spreadsheets are synonymous with PivotTable reports in Excel.
These spreadsheets provide the ability to change rows and columns to see different
summaries of data.

Crosstab spreadsheets can also provide drill down capability depending on the fields
that you select (see Running a Crosstab Advanced Spreadsheet on page 4-6).

For a description of each of the standard advanced spreadsheets provided with CIMS
Server, see Standard Advanced Spreadsheet Descriptions on page 4-14.
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Running CIMS Advanced Spreadsheets

This section provides the steps for running CIMS Advanced Spreadsheets. The steps differ
if you are running a drill down or static spreadsheet or a crosstab spreadsheet.

Running a Drill Down or Static Advanced Spreadsheet

To run a drill down or static advanced spreadsheet:

1 Click the link for the spreadsheet that you want to run as shown in example
Figure 4-1. Note that in this example the report group Advanced Spreadsheets has
been created for CIMS Advanced Spreadsheets. This group is not included by default.
For the steps required to create report groups and add reports to the groups, refer to
the CIMS Server Administrator’s Guide.

a http:/flocalhost/test/TReports.asp?select=3 - Microsoft Internet Explorer. E”E‘g‘
v

File Edt Wiew Fawortes Took  Help 4
@Back - @ @ (0| D search 7 Favortes ) = ol 3 é-
Addiress [ €] httpsfjlacahhostitest TReports. aspselect=3 v B @
Server .
Login Reports Spreadsheets Favorites Admin  Help Logout Home
Spreadsheets
Standard Spreadsheets
B Advanced Spreadsheets
Summary Complete
Summary Account Code
Summary Rate Code
Summary Rate G p
Summary Crosstab
GCrosstabs
Proration
Expand All E collapse all
@ & Local intranst

Figure 4-1 « Selecting a CIMS Advanced Spreadsheet

The parameters page for the selected spreadsheet opens.
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2 In the Please select parameters for Spreadsheets area, enter the parameters for the
data that you want to appear in the spreadsheet. The following are descriptions of the
parameters for the standard advanced spreadsheets provided with CIMS Server. Your
spreadsheets might use other parameters that are custom for your site.

The parameter values that you enter are stored in a cookie so that you do not have to
re-enter the values each time you run a spreadsheet (unless you want to change the

values).

Account Code Level

Starting and
Ending Account Code

Set the Date Range

From/To

The account code level that you want to view in the
spreadsheet. For example, the account code
AABBBBCCC might contain three levels: the two-
digit company code AA, the 6-digit division code
AABBBB, and the 9-digit department code
AABBBBCCC. The resource use and charge data will
reflect the level that you select.

For more information about account codes, see About
Account Codes on page 2-7.

This parameter works in conjunction with the
Account Code Level parameter and specifies the
account codes for that level that appear in the report.

If you want all account codes for that level to appear
in the report, click Lowest Possible Account for the
starting account code and Highest Possible Account
for the ending account code.

If you want specific account codes, click the
appropriate start and end codes or click Custom and
type the start and end codes.

The date range for the data that you want to appear in
the spreadsheet.

The beginning and end dates for the data that you
want to appear in the spreadsheet if you cannot select
the date that you want from Set the Date Range.

You can click the Calendar button to choose

the from and to date.
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3 Each spreadsheet includes default columns for the data. However, you can select
additional columns to include in the spreadsheet and specify the sort order and
conditions for the data in these columns (if applicable).

In the Please select spreadsheet column and sorting options area, select the
optional columns that you want to include in the spreadsheet. To select a column,
click Select, Sort Ascending, Sort Descending, or Condition (see the following
descriptions). Note that available options depend on the column.

If you do not want a column to appear in the spreadsheet, click Hide.

Fields that are designated as * Drilldown Only appear only in the spreadsheet that is
opened when you drill down on data (see Drilling Down in a Spreadsheet on
page 4-10).

Select The column appears in the spreadsheet.

Hide The field column does not appear in the spreadsheet.

Sort Ascending The column appears in the spreadsheet and the
column values are displayed in ascending order. Note
that if preceding columns are set to ascending or
descending, the sort option for the preceding
columns takes precedence beginning from left to
right.

Sort Descending The column appears in the spreadsheet and the field
values are displayed in descending order. Note that if
preceding columns are set to ascending or
descending, the sort option for the preceding
columns takes precedence beginning from left to
right.

Condition The column appears in the spreadsheet and the field
values must be greater than (>), less than (<), or
equal (=) to the value that you specify. For example,
if you want costs greater than $100 to appear in a
spreadsheet, click the greater than symbol (>) and
type 100. Use a decimal as needed, e.g., type $225.75
as 225.75.

For a description of the columns for the standard advanced spreadsheets provided
with CIMS Server, see Advanced Spreadsheet Column Description on page 4-9.

4 Click Submit to generate the spreadsheet.

You can do many things with the information in the generated spreadsheet such as drill
down on data (if you run a drill down spreadsheet), open the spreadsheet in Excel, and
print and save the report. For more information, see Working With CIMS Advanced
Spreadsheets on page 4-8.
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Running a Crosstab Advanced Spreadsheet

The crosstab spreadsheets are synonymous with PivotTable reports in Excel. The
parameters page for a crosstab spreadsheet includes a wizard that enables you to choose
the fields that you want to appear in the spreadsheet.

To run a crosstab advanced spreadsheet, follow Step 1 through Step 2 in Running a Drill
Down or Static Advanced Spreadsheet and then use the crosstab wizard as follows:

1 Click CLICK HERE TO SHOW THE WIZARD.

The CIMS Crosstab Wizard opens. The wizard presents the spreadsheet divided into
three areas. On the right are the fields that you can place in each of these areas (one
field per area).

2 Drag the field that you want into one of the three areas of the spreadsheet as shown
in Figure 4-2. In this example, the resulting spreadsheet will show charges by rate
code for each account code as shown in Crosstab Spreadsheet Example on page 4-28.

The following fields provide drill down capability when they are placed in the main
content area: Money Value, Rate Index, Rate Group, Resource Units.

<23 CIMS Crosstab Wizard - Microsoft Internet Explorer, |Z||:|r>__<|

This is the column head
area. In this example, rate

codes will appear inthe  ——f— Rate Code .
column heads. —|°°°“” ame
This is the first column Maneyialue
area. In this eXample, Click and drag to the proper location
a((ount codes W[” appeal’ double click ko add an equality
in this column. —
Rate Indexl

This is the main content —

. . o i
area. Numeric value fields Description|
such as Money Value and _Comments|
Resource Units are usually

. . o P Rate G

placed in this field. In this Rate Group|
example, the Money Value Resource Units |
field is placed in this area. Cate Groun T
Costs by rate code and Rate Group Tite |

account code will appear as
column values. For an
example of the resulting
spreadsheet, see

Figure 4-19 on

page 4-28.

o TR cvoe |

Figure 4-2 « CIMS Crosstab Wizard
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3 Apply optional settings to the fields as follows:

a You can apply =, >, or < conditions to any of the fields. For example, if you want
to view data for rate code Z001 only, double-click the Rate Code field and set the
condition in the Condition Wizard to Rate Code = Z001 as shown in Figure 4-3.

b Numeric value fields such as Money Value are usually placed in the main content
field. Values in the main content field are aggregated by sum. To change the
aggregation type, double-click anywhere in the field to open the Function Wizard
as shown in Figure 4-3.

You can change the aggregation type to any of the following:

e Sum (sum of all aggregated values is presented)

e Maximum (largest value that is included in the aggregation is presented)

e Minimum (smallest value that is included in the aggregation is presented)
e Count (count of all aggregated values is presented)

» Average (average of all aggregated values is presented)

e Standard Deviation (the standard deviation for all aggregated values is
presented)

e Variance (the variance for all aggregated values is presented)

2} CIMS Crosstab Wizand - Microsoft Internet Explorer |:||:,r>__<|
Double-click a field to —] et Codel
open the Condition Wizard z Account Name |

Money \.-'aluel
S 5 : shift
Double-click anywhere in this area to [stie]
open the Function Wizard. Rate Index|

Descriptionl
| Commentsl
tSOeltic: ?ensjlggsr:t?ate function to apply Rate GrDLIDl
“

Sum

M aximum

Resource Units

Rate Group Titlel

Minimum

Count

Forerage

Standard Deviation
Wariance

o TR cvoe |

Figure 4-3 « Using the Condition and Function Wizards

4 Click OK to generate the spreadsheet.
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Working With CIMS Advanced Spreadsheets

This section describes how to use CIMS Advanced Spreadsheets. When you run a
spreadsheet, CIMS Server Web Reporting presents the spreadsheet data in Microsoft
Excel within the browser if you have Excel installed on the client running the
spreadsheet. If you do not have Excel installed, the data appears in HTML.

About the CIMS Advanced Spreadsheet Interface

Figure 4-4 provides an introduction to the CIMS Advanced Spreadsheets interface. You
can view and drill down on data in this interface. If you want to edit, save, or print data,
click Open with Excel.

Click here to return to the spreadsheet parameters page

Click here to open the spreadsheet in Exce

< CIMS Server - Microsoft Internet Explorer.

File Edi View Favorites Tools Hslp
a | = 9

Qm- © REG Lo B TRV

Address | 8] httpsflocalhost/Demofnethook, aspireportfile=55_SUMMARY_RATECODE. xmigreportiemplafefile=8repartname=5ummary%:20R ate % 20Cade v Go

CIMS

Server

>

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Summary By Rate Code Open with Excel Return
Al - & Rate Code
A B C 1
|l Rate Code _!Rale Index (a:c) Description p g Rate Value |Resource Units | Cojm
| 2 2001 1|Mainframe Jobs Started Mainframe Batch charges 2 829
| 3 |7002 3 Mainframe Steps Started Mainframe Batch charges 02 2728.00
| 4 7003 5 Mainfrarne Cpu Minutes Mainfrarne Batch charges 10 132370 1
| 5 7032 7 Mainframe Cpu Minutes (Initiators) Mainframe Batch charges 1] 19.96
6 |A033 8| Mainframe Cpu Minutes (Al Mainfrarme Batch charges o 1,366.31 LK
Key column 7 oo 15T Cpu Wit &0 Wiz T chargega = 787
. . B8 | 2704 15 Tso Connect Minutes Mainfrare Tso charges 0.03 17.,383.48
ClICk a l]nk to IM 16 Tso Inputs Mainframe Tso charges 2 55,019.00
. 10 (202 18 Tso Outputs Mainfrare Tso charges 1 B60,613.00
drl” dOWﬂ to more I& 20 Tso Cpu Minutes (Initiator) Mainframe Teo charges 1] 55
detailed information [ 12 | 7096 21 Tso Cpu Minutes (All) Mainframe Tso charges 0 45.74
e e . 13 | 2005 30 Total 5105 Mainframe Input/Output charges 0 16,192681.00
(if viewing drill down 14| 7005 32 Disk S10s Mainfrarme Input/Output charges 003 9.250794.00
Spreadsheets) | 16 | 7007 34 Tape Sl0s Mainframe Input/Output charges 0.04 B 941 887 .00
| 16 | 2008 353390 SI0's Mainfrarne Input/Output charges o 9,260,794.00 —
| 17 12014 70 Input Records Mainframe Printer/Reader charges 1 13,283.00
| 18 | ZNE 80 Lines Printed - Local Mainfrarne Printer/Reader charges o 1,297 728.00
| 19 |Z707 84 Lines Printed - Remote Mainframe Printer/Reader charges 0 157 944.00
| 20 | 27 87 Pages Printed - Local Mainfrarne Printer/Reader charges o 30,528.00
| 21 |ZRMTPAGE 88 Pages Printed - Remate Mainframe Printer/Reader charges 1] 4 B56.00
| 22 |SMFENLR 100 |Psf Murnber Of Lines Printed Mainfrarne Printer/Reader charges o 1,323,168.00
I 23 |SMFEPGE 102 Psf Mumber Of Pages Printed Mainframe Printer/Reader charges 0 158,636.00 ™
< | >
&) % Local intranet

Figure 4-4 - CIMS Advanced Spreadsheet Interface
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Advanced Spreadsheet Column Description

Table 4-1 provides a description of the columns that appear in the standard advanced
spreadsheet fields that are provided with CIMS Server. The columns that appear depend
on the default columns for the spreadsheet and any optional columns that were selected
when the spreadsheet was generated (see Step 3 on page 4-5).

Your spreadsheets might contain other columns that are custom for your site.

Column Description

Account Code Contains account codes.

Rate Code Contains rate codes. A rate code represents resource units
consumed (for example, CPU time used, pages printed, e-
mail message sent).

Description Contains the description for the rate code.

Rate Index Contains the index number for the rate code. The index
number specifies the order in which the rate code appears
in reports.

Rate Value Contains the amount to be charged for the consumption of

the resource represented by the rate code.

Group Title Long Contains the rate group description for the rate code. A rate
group description can be a maximum of 255 characters. The
rate group description and title can be the same.

Group Title Contains the rate group title for the rate code. A rate group
title can be a maximum of 32 characters.

Resource Units Contains the number of resource units consumed for the
rate code.

Cost Contains the cost for the resources consumed.

Account Name Contains account names (if assigned).

Table 4-1 « Standard CIMS Advanced Spreadsheet Columns
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Working With CIMS Advanced Spreadsheets

Drilling Down in a Spreadsheet

B 4-10

Drill down spreadsheets enable you to drill down on the values in the key column (for
example, the Rate Code column in the Summary By Rate Code spreadsheet).

To view detail data for a value, click the link as shown in example Figure 4-5. In this
example, the link for the rate code Z005 opens a second spreadsheet with detailed
information about the rate code as shown in Figure 4-6 on page 4-11.

A CIMS Server, - Microsoft Internet
File  Edit

Wiew  Favorites

Explorer

Tools  Help

Q- © ¥ @ & O search 5o Favries ) R ;

IEYS

Address [ €] http:flocahhast Demojnethaok, aspireportfie=55_SUMMARY_RATECODE. xmisreporttemplatefie=areportnsme=3urmary:20R ate%20Cods

CIMS

Server

Login

Summary By Rate Cade

Al -

E=IE

.l‘.

Reports Spreadsheets

£ Rate Code

Favorites

Admin  Help

Open with Excel

Logout

Home

Return

Description

D
Group Title Long

[E3

Click a value in the key column to drill down

Figure 4-5 « Example Drill Down

]

2 (2001 1 Mainframe Jobs Started Mainframe Batch charges 829

3 (2002 3 Mainframe Steps Started Mainframe Batch charges 02 2,728.00

4 [Z003 5 Mainframe Cpu Minutes Mainframe Batch charges 10 132370 1

5 |2032 7 Mainframe Cpu Minutes (Initiators) Mainframe Batch charges 0 19.96

B (7033 8 Mainfrarme Cpu Minutes (All) Mainframe Batch charges 1] 1,366.31 L

7 (2020 13 Tso Cpu Minutes Mainfrarne Tso charges 25 37.87

8 [Z704 15 Tso Connect Minutes Mainframe Tso charges 0.03 17 ,383.48

9 (2021 16 Tso Inputs Mainfrarne Tso charges 2 55,015.00

10 |7022 18|T=0 Outputs Mainframe Tso charges 1 B0,613.00

11 |2035 20 Tso Cpu Minutes (Initiator) Mainfrarne Tso charges 0 5.53

12 |7036 21 Tso Cpu Minutes (Al Mainframe Tso charges 1] 4574

13 BJE% 30 Total SI0s Mainframe Input/Dutput charges o 16,192 B81.00

14 |Zhs 32 Disk Sl0s Mainframe Input/Output charges 0.03 9 250,794 .00

15 | 2007 34 Tape 5105 Mainframe Input/Dutput charges 0.04 B 941 887.00

16 |Z008 353350 510's Mainframe Input/Output charges 0 9 250,794 .00 —

17 |2014 70 Input Records Mainfrarne Printer/Reader charges 1 13,283.00

18 |Z016 80 Lines Printed - Local Mainframe Printer/Reader charges 0 1,297 728.00

19 |Z07 84 Lines Printed - Rermote Mainfrarne Printer/Reader charges o 157 944.00

20 | 2017 87 Pages Printed - Local Mainframe Printer/Reader charges 0 30,528.00
| 21 |ZBMTPAGE 83 Pages Printed - Remote Mainfrarne Printer/Reader charges 0 4656.00

22 |SMFENLR 100 |Psf Mumber Of Lines Printed Mainframe Printer/Reader charges 0 1.323,168.00

23 [SMFEPGE 102 Psf Mumber Of Pages Printed Mamframn‘a Printer/Reader charges 0 15636.00 ]
< >
&) & Local intranet
—
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2 CIMS Server - Microsoft Internet Explorer

File Edit Wew Favorites Tools  Help

N T A |~ Y T
Q- © [ [ G P frroons @ 3 B3 A
address | ] httpiffiocalhost Demojnethaok, sspPreportfile=55_SUMMARY_RATECODE. xmiéreporttemplates ummary s 20R ke 20Code: v Be

CIMS

Server

|

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Summary By Rate Code Open with Excel Return

Al - & Account Code

Tatal 5 Mainframe Input/Output charges
30 Total SI0s Mainframe Input/Dutput charges o 2077.00
30| Tatal S10s Mainframe Input/Output charges 0] 14,008 631.00
30 Total SI0s Mainframe Input/Dutput charges o 1,131 A76.00

alnafmf === [ | [ [ = | = _

i}

v

)

el

& Local intranet

[E

Figure 4-6 « Example Drill Down
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Working With CIMS Advanced Spreadsheets in Excel

If you want to print, edit, or save the spreadsheet, you should open the spreadsheet in
the Excel.

To open a spreadsheet in Excel:
1 Click Open with Excel.

The spreadsheet opens in Excel in a separate Web browser window.
2 Click View » Toolbars » Standard.

3 You can then save, print, and/or edit the spreadsheet using the Excel commands and
toolbar.

If you are opening Excel for the first time from CIMS Server Web Reporting:

If you have Excel installed, you might be prompted to download the spreadsheet file the
first time that you open Excel from CIMS Server Web Reporting. This enables Windows
to recognize the spreadsheet as an . x1s file and to automatically open Excel in the future.

In the Windows File Download dialog box, do the following:
1 Click Open.
2 Click Select the program from a list, and then click OK.

3 In the Open With dialog box, click Microsoft Excel or click Browse to find Excel, and
then click OK.

To edit a spreadsheet in Excel:

Edit the spreadsheet as required and then follow the steps in To save a spreadsheet in Excel:
on page 4-13.

To print a spreadsheet in Excel:

1 Click File » Print or click the Print button on the Excel toolbar.
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Working With CIMS Advanced Spreadsheets

To save a spreadsheet in Excel:

You can save advanced spreadsheets that you generate so that you or other users can
access the spreadsheet again without regenerating the spreadsheet. For example, if you
run a daily spreadsheet that others need to view, you can generate the spreadsheet each
day and save it in an accessible drive or folder.

Note ¢ Spreadsheets that involve a wide range of dates or account codes can require
excessive system time and resources to generate. Consider saving these spreadsheets
for quicker access.

1 Click File » Save As.

2 Navigate to the folder that you want to save the file in, and then enter the file name
and file type in the File name and Save as type select boxes.

3 Click Save to save the file to the location you selected.

To close a spreadsheet in Excel:

Click File » Close or the Close [¥] button.
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Standard Advanced Spreadsheet Descriptions

Standard Advanced Spreadsheet Descriptions

B 4-14

Note ¢ The standard advanced spreadsheets described in this section can be
customized for your organization. For more information, see Creating Custom
Advanced Spreadsheets on page 5-12.

This section describes the standard advanced spreadsheets that are provided with CIMS
Server. Each spreadsheet description includes the following information:

XML File Name The name of XML definition file for the spreadsheet.

Stored Procedure The stored procedure used for the spreadsheet. A
stored procedure is a set of SQL statements that can
perform both queries and actions that allow the
system to generate spreadsheets.

Key Column The column by which all other columns in the
spreadsheet are sorted. For example, the Rate Code
column in the Summary By Rate Code spreadsheet or
the Account Code column in the Summary By
Account Code spreadsheet.

If you are viewing a drill down spreadsheet, you can
drill down on the values in the key column to view
detailed data for that value.

Parameters The parameters for the spreadsheet. For a description
of these parameters, see Step 2 on page 4-4

Columns The default and optional columns for the
spreadsheet.
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Complete Summary View

This spreadsheet shows a break down of resource units consumed and charges by rate
code for each account code for the parameters selected. This spreadsheet does not
include drill down.

XML file name: SS_SUMMARY_COMPLETE . xm]
Stored Procedure: CIMSSP_Summary

Key Column: Account Code

Parameters:

m Starting and Ending Account Code

m Account Code Level

B Date Range

Spreadsheet Columns (one or more of the following must be selected):
m Account Code

m Rate Code (optional)

m Rate Index (optional)

m Description (optional)

m Group Title (optional)

m Rate Value (optional)

m Resource Units (optional)

m Cost (optional)
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Standard Advanced Spreadsheet Descriptions

B 4-16

Complete Summary View Example

Figure 4-7 provides an example of the parameters and columns used to create a

Complete Summary View spreadsheet.

Figure 4-8 on page 4-17 shows the resulting spreadsheet.

File Edt Wiew Favorites Tools

2 CIMS Server - Microsoft Internet Explorer

Help

Qe - € - Iﬂ @ ;h /__TSearch \‘?:'\’E‘Favuntes & E/:iv ;.

“d3a

Address [{€] http:jjw. cimsserver.cominethook. aspreportfile=55_SUMMARY_COMPLETE

portname=Summary%20Complete

Summary Complete

Login Reparts Spreadsheets

Starting Account Code :
Ending Account Code :
Account Code Level :
Set the Date Range :
From :

To:

Account Code :
Rate Code :
Rate Index :
Description :
Group Title :
Rate Yalue :
Resource Units :

Cost :

<

Please select parameters for Spreadsheets.

Favorites Admin H

elp Logout Home

|| Lowest Passible Account

|| Highest Possible Accaunt

Application, length 4
This Manth
14172004

1/30/2004

<

Please select spreadsheet column and sorting options

--Select--

Sort Descending v
--Select--
--Select- ¥

Hide

--Selsct--
--Selsct--

--Select--

OK Cancel |

L

&) javascript: SubmitForm();
L

& Internet

Figure 4-7 « Example Setup for the Complete Summary View Spreadsheet
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A CIMS Server - Microsoft Internet Explorer

Favorites  Tools

File

Edt  Visw Help

Qu- QO X @ & ) ssarch

3‘:‘\'( Favories {§2) ]~ :\?

Standard Advanced Spreadsheet Descriptions

s A

Adress [ €] httpsfjlacalhostjDemojnethook, aspTreportfile=55_SUMMARY_COMPLETE xmiéreporttemplatef

20Complete

CIMS

Server

Lagin
Complete Summary Yiew

A Account Code

Reports

Spreadsheets  Favorites

Admin  Help

Logout

Home

k3

Open with Excel

Return

Description

Rate Value

DR V0 Artivity (Get Panps)
|

DB2 Accumulated Elapsed Minutes 0.15 4.27 08
7738 508|DB2 Accumulated Elapsed Minutes 0.15 235 0.36
7733 508|DE2 Accurnulated Elapsed Minutes 0.15 1,340.58 20112
7738 508|DB2 Accumulated Elapsed Minutes 0.15 437 0.6
7733 508|DE2 Accurnulated Elapsed Minutes 0.15 2532.68 379.92
7738 508|DB2 Accumulated Elapsed Minutes 0.15 103224 154 .8
2738 508|DE2 Accurnulated Elapsed Minutes 0.15 59.97 9
7738 508|DB2 Accumulated Elapsed Minutes 0.15 0.33 1]
2738 508|DE2 Accurnulated Elapsed Minutes 0.15 9.52 1.44
7738 508|DB2 Accumulated Elapsed Minutes 0.15 0.51 0.12
737 504 |DB2 Accurnulated Cpu Minutes 5 0.33 1.68
7737 504|DB2 Accumulated Cpu Minutes 5 0.61 3
737 504 |DB2 Accurnulated Cpu Minutes 5 104.33 521.64
7737 504|DB2 Accumulated Cpu Minutes 5 03 1.44
737 504 |DB2 Accurnulated Cpu Minutes a 22199 1,110.00
7737 504|DB2 Accumulated Cpu Minutes 5 86.61 433.08
737 504 |DB2 Accurnulated Cpu Minutes 5 14.86 74.28
7737 504|DB2 Accumulated Cpu Minutes 5 0.0 0.12
737 504 |DB2 Accurnulated Cpu Minutes 5 1.51 7.56
7737 504|DB2 Accumulated Cpu Minutes 5 0.31 1.56
7TAR a7 n A2 144 00 n3R

(NEY

[

3

% Local intranet

Figure 4-8 « Example Complete Summary View Spreadsheet
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Summary By Account Code

This spreadsheet shows a summary of resource units consumed and charges by account
code for the parameters selected. You can drill down on the account code to view a break
down of the resource usage and charges by rate code.

XML file name: SS_SUMMARY_ACCOUNTCODE . xm]
Stored Procedure: CIMSSP_Summary

Key Column: Account Code

Parameters:

m Starting and Ending Account Code

B Account Code Level

m Date Range

Top-level Spreadsheet Columns: Drill Down Spreadsheet Columns:
m Account Code B Account Code

m Resource Units m Rate Code

m Cost B Rate Index

B Account Name m Description (optional)

m Comments

m Rate Group (optional)

m Group Title Long (optional)
m Rate Value (optional)

B Resource Units

m Cost

B Account Name

B 4-18 CIMS Server Web Reporting User’s Guide



Running and Working With CIMS Advanced Spreadsheets W

Standard Advanced Spreadsheet Descriptions

Summary By Account Code Example

Figure 4-9 provides an example of the parameters and columns used to create a
Summary By Account Code spreadsheet.

Figure 4-10 shows the resulting spreadsheet.

Figure 4-11 on page 4-20 shows an example drill down.

<3 CIMS Server, - Microsoft Internet Explorer

Filg Edit Wiew Favorites Tools Help
O - B semer. J7 5| . B - .

Qe - @ - ¥ B i POsach Srreots £ (- L ol .

diess [ €] https s, cmsserver.comfnethook. aspreportfie=55_SUMMARY_ATCOUNTCODE smigreporttemplatefile=grepartname=Summary % 20Account %20Cade

CIMS

Server

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Summary Account Code

Please select parameters for Spreadsheets.

Starting Account Code : |[Lowest Possible Account v|

Ending Account Code : |[Highest Possible Account v|

Account Code Level : | Application, length 4

I
i <

Set the Date Range : | This Month
From : |11/1/2004
To : [11/30/2004

Please select spreadsheet column and sorting options
Description * ositldows Oly 1 | --Select-- w
Rate Group * Drifidown Oply 1 | —-Select--
Group Title Long * orilldown [fige
nly ©

Rate Yalue * orifidows Only ¢ | Sort Descending ¥

i

& >
@ javascripk: SubmitForm(); B Intemet

Figure 4-9 - Example Setup for the Summary By Account Code Spreadsheet
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Standard Advanced Spreadsheet Descriptions

3 CIMS Server, - Microsoft Internet Explorer

Favorites  Toals

Fils
Qu-Q HEG S sesrch Slpravores 8 (- :;, ol -

cdivess [ €] bt flocahhast/Demojnethack, aspPrepartfile=55_SLMMARY_ACCOLNTCODE xmiéreporttemplatef 20Account*20Code v

CIMS

Server —

Login Reports Spreadsheets Favorites Admin

Edt  View Help

Help Logout Home

Summary By Account Code Open with Excel Return

Al - & Account Code

1 I Cost AccountName
| 2 |ATh - 1675848 950.24|  2035.91 ATM Transactions
3 (O 524 870,580.17 | B4 662.23 Credit Card
4 [COmM 483,837 403.38| 12 614.40 | Carmmercial Loans
5 [DAC 306,191 526 25 2846 16 Drafis and Collections
B [DEF 565,707 882.26| 14659.21 Electronic Depasits
7 MTG 1,502,191,169.44| 57 420 62 Mortgages
8 [ONE 486 ,061,303.68| 12,805.04 Online Electronic Payments
9 [ETM 252179891185 3.749.57 Retirement
10 |25 241082 686.14| 52 B11.11|Secure Sales - Intemet Commetice
11 |TEL 2,191,795 54477 10,197.58 Telephone Transactions
2 [WTH 763,168 398.94| 7 ,170.26 Wvire transfers
13 |Run Total 11,364 554 366.82| 240,772.10 -
14

Click a value in the key column to drill down

I
[

% Local intranet

CIMS Server - Microsoft Internet Explorer

File Edt Wew Favortes Toos Help i
Qe - ) ¥ @] @0 Osach Sloraones £ (- L s A
Address |@ http: [ flocalhost/Demajnethook. asp?reportfile=55_SUMMARY_ACCOUNTCODE. xmids eporttemplatef 20Account®:20Code V| Go
CIMS 2
Server
Login Reports Spreadsheets Favorites Admin  Help Logout Home

Summary By Account Code Open with Excel Return

Al - £ Account Code
1 Rate Index De
2 |ATM 402/ CICS Cpu Minutes 30 |
3 |ATM 502 DBZ Transaction Cpu Minutes a I
4 |ATM 504 DB2 Accumulated Cpu Minutes 5 |

WS Exchange Mailbox Count (Mailbox
5 |ATM EXMBRCNT 644 days) 29 0.2
B |ATM IC31 400 |CICS Transaction Minutes 9 01g |
7 |ATM LLB10S 735 Unix Background System CPU (minutes) 13 015 ]
g [ATM 738 508 |DB2Z Accurnulated Elapsed Minutes 10 015 LJ
9 |ATM EQUIP 914 Equipment 34 0.1
10 | ATM LLB106 736 | Unix Background Total CPU (minutes) 13 0.1 7.
11 |ATM SOLWRITE B04 MS Windows S0L Server Writes 26 0.08 104 34
12 |ATM LLAT10 710 Unix Interactive Loging 12 0.07
13 |ATM LLB104 734 Unix Background User CPU {minutes) 13 0.04
14 | ATM LLATO7 707 |Unix Interactive Total CPU (minutes) 12 0.03
15 |ATM WPRTPRPC B73 MS Windows Print Page Count 32 0.03 -
16 | AT LLATOD 709 | Unix Interactive Image Count 12 0.0z
17 |ATM LLA10G 706 Unix Interactive Systern CPU (minutes) 12 0.0z
18 |ATHM 1PRT 212/ One Part Forms a 0.02 3541
19 |ATH SaLcPU B02 MS Windows S0L Server CPU (seconds) 26 0.0z 1
20 | ATM STD 228 Standard Forms a 0.02 2,10
21 |ATM 7CS3 404 CICS Transactions &l 0.0z
22 |ATM ICS4 406 |CICS Input Messages 9 00z ™,
< >
@ % Local intranet

Figure 4-11 + Example Summary By Account Code Drill Down
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Summary By Rate Code

This spreadsheet shows a summary of resource units consumed and charges by rate code
for the parameters selected. You can drill down on the rate code to view a break down of
the resource usage and charges for the rate code by account code.

XML file name: SS_SUMMARY_RATECODE . xm1
Stored Procedure: CIMSSP_Summary

Key Column: Rate Code

Parameters:

m Starting and Ending Account Code

m Account Code Level

B Date Range

Top-level Spreadsheet Columns: Drill Down Spreadsheet Columns:
m Rate Code B Account Code

m Rate Index m Rate Code

m Rate Description (optional) m Shift

m Group Title Long (optional) m Rate Index

m Rate Value (optional) m Description (optional)

B Resource Units m Comments

m Cost m Group Title Long (optional)

m Rate Value (optional)
B Resource Units

m Cost
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Standard Advanced Spreadsheet Descriptions

B 4-22

Summary By Rate Code Example

Figure 4-12 provides an example of the parameters and columns used to create a
Summary By Rate Code spreadsheet.

Figure 4-13 on page 4-23 shows the resulting spreadsheet.

Figure 4-14 on page 4-23 shows an example drill down.

A CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools Help

Qu- Q- @ & S search 'z Favores )

2 @A

Acdivess [ €] it flocahast testinethoak asprepartFle=S5_SUMMARY_RATECODE. xmiereporttemplatefile=treportname=Summary%:-20Rate%20Cade

CIMS

Server

Login Reports Spreadsheets Favorites Admin  Help

Summary Rate Code

<

To

Starting Account Code :

Ending Account Code :

Account Code Level : | Application, lsngth 4

Please select parameters for Spreadsheets.

Logout Home

|[Lowest Possible Account

|[Highest Possible Account

Set the Date Range :
From : |11/1/2004 I

v
v

143072004

Please select spreadsheet column and sorting options

Account Code * Drifidows Only t
Rate Index :

Description :

Group Title Long :
Rate ¥alue :

OKU ] Cancel

[E3

| v

&) javascript: SubmitForm();
=

% Local intranet

Figure 4-12 « Example Setup for the Summary By Rate Code Spreadsheet
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23 CIMS Server - Microsoft Internet Explorer

Fils
Qu-Q XE@& ) search o Favores ) LB 3 A

Adiress [ €] httpsfflocahast/Demojnethack, aspPrepertfie=55_SLMMARY_RATECODE  xmiéreporttemplatefie=treportname=Summary%:20Rate%20Cade

CIMS

Server

Edit Wiew Favorites Tools  Help

3

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Summary By Rate Code Open with Excel Return

A - A& Rate Code

B

3 Description
1|Mainframe Jobs Started 829| 1,658.00
3 Mainframe Steps Started 0.2 272800 5456
5 |Mainfrarne Cpu Minutes 10 1,323.70( 13237.04
7 Mainframe Cpu Minutes (Initiators) o 19.96 o
8| Mainframe Cpu Minutes (All) a 1,366.31 0 =
13/ T=o Cpu Minutes 25 3787 946.69
15|Tso Connect Minutes 003 17 383.48 434.58
16 T=o Inputs 2 55,019.00 110.05
18] Tso Outputs 1 60,613.00 60.65
20 Tso Cpu Minutes (Initiator) o 555 o
21/ Ts0 Cpu Minutes (All) a 45,74 0
30 Total 5105 0 16,192 581.00 0
32|Disk 5103 003 9,250 794.00 231.26
34 Tape 5105 0.04 6,941 587.00 242.97
35/3390 SI0's 0 9,250 794.00 1] =
70 Input Records 1 13 283.00 13.31
80 Lines Printed - Local a 1297 728.00 1.2
84 Lines Printed - Remote a 157 94400 0.36
87 Pages Printed - Local a 30 5268.00 o
88 Pages Printed - Remaote a 4 B5E.00 0
100 |Psf Murnber Of Lines Printed a 1,323,168.00 o
102 Psf Mumber Of Pages Printed 0 15 636,00 0 L]

%) Local intranet

Click a value in the key column to drill down

Figure 4-13 « Example Summary By Rate Code Spreadsheet

<A CIMS Server - Microsoft Internet Explorer

File
- A (] =Y ; S B = .

Qo © FEAG] Lo drroe @3- % @ UE B A

address ] htipiffiocalhest Demejnethask, sspirepertfle=55_SUMMARY_RATECODE xmisseporttemplatef 20Rate%20Code B

CIMS

Server

Edit  Wiew Favorites Tools  Help

Home

Login Reparts Spreadsheets Favorites Admin  Help Logout

Summary By Rate Code Open with Excel Return

Al - A Account Code

0
Tso Inputs 37 77400

519 104
16,726.00) 3345

COm 7021 1 16 T=o Inputs
WX |21 1 16 Tsa Inputs

b
L3

% Lacal intranet

BB
ra[na[ra[ra 2 [ = s | = [ [ s | = [ _

Figure 4-14 « Example Summary By Rate Code Drill Down
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Summary By Rate Group

This spreadsheet shows a summary of resource units consumed and charges by rate
group for the parameters selected. You can drill down on the rate group to view a break
down of the resource usage and charges for the rate group by account code and rate code.

XML file name: SS_SUMMARY_RATEGROUP . xm1
Stored Procedure: CIMSSP_Summary

Key Column: Rate Group

Parameters:

m Starting and Ending Account Code

m Account Code Level

B Date Range

Top-level Spreadsheet Columns: Drill Down Spreadsheet Columns:
m Group Title Long m Account Code

B Resource Units m Rate Code

m Cost m Rate Index

m Description (optional)

m Comments

m Group Title Long (optional)
m Rate Value (optional)

m Resource Units

m Cost
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Standard Advanced Spreadsheet Descriptions

Summary By Rate Group Example

Figure 4-15 provides an example of the parameters and columns used to create a
Summary By Rate Group spreadsheet.

Figure 4-16 on page 4-26 shows the resulting spreadsheet.

Figure 4-17 on page 4-26 shows an example drill down.

A CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Taools Help
Qu- Q-3 & D ssarch 'z Favortes ) - _; ol .

Adiress [{€] https s, cmsserver.comfnethook. aspreportfie=55_SUMMARY_RATEGROUP. smiEreporttemplatefie=8reportname=Summary %20R ate%206roup

CIMS

Server

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Summary Rate Group

Please select parameters for Spreadsheets.

|[Lowest Possible Account v|

Starting Account Code :

|[Highest Possible Account v|

Ending Account Code :

Account Code Level : | Application, length 4 v
Set the Date Range : | This Month -
From : |11/1/2004 I

+ 1143072004

To

Please select spreadsheet column and sorting options

Description * ositidows Only © | --Select- v |
Graup Title Long :
Rate Value * prifidown Only : |-Select— v

()V\'E ) Cancel |

&)
&) javascript:SubmitForm(};
=

& Tnternst

Figure 4-15 « Example Setup for the Summary By Rate Group Spreadsheet
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2 CIMS Server - Microsoft Internet Explorer

File

Edit Wiew Favorites Tools Help

Al & A > B
- A ) ~rd - = -
Qu-Q HEAG D ez pavories ) & | o
cdivess [ €] httsflocahast/Demojnethack, aspTrepertfile=55_SLMMARY_RATEGROLP,amisreporttemplatef 20Rate%20Group v B

CIMS

Server

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Summary By Rate Group Open with Excel Return

Al - # Group Title Long
A B C D E F G H | J =

Bl Group Title Long Resource Units | Cost

2 |Mainfrarme Batch charges 6,266.95 15 44064

3 |Mainframe CICS charges 162,164.30 B76.32

4 |Mainfrarme DBZ chaes — ————— 0 044 175 286.09 5 925.00

5 |Mainframe Input/Ouit charges 41 636,156.00 47423

B |Mainfrarme Print charges 50,784.00 0.6

7 |Mainframe Printer/Reader charges 2,880,287.00 40.19

B |Mainfrarme Storage charges 265253678 2086384

9 |Mainframe T=o charges 133,104.61 155197

10 |MS Exchange Mailbaox 492 98.4

11 |MS Exchange Sent and Received 1344 527 506.00 1,277 46

12 |MS IS 3454154 454.00) 3379.48

13 |MS Windows Print B4,143.00 7052

14 |MS Windows Processes 1,110 609 ,404.27 | 1289031

15 |MS Windows S0 Server 54 258,177.40 31537

16 |MS ¥Windows storage charges 173476312 346832

17 |Shared Services 843 84.3

18 |Unix background job type charges 9196 ,076.71 157062

19 |Unix DB2 charges 155688.00 125528

20 |Unix filesystem 4862157 744.00) 2985.41

21 |Unix interactive job type charges 8203335365 7.817.00

22 |Unix Oracle charges 33 965,135.91 | 160 586.84

23 |Run Total 11.364 654 366.82 240 772.10 b
< >

&) CIms server is ready. % Local intranet

(lick a value in the key column to drill down

Figure 4-16 + Example Summary By Rate Group Spreadsheet

A CIMS Server - Microsoft Internet Explorer
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File Edit Wiew Favorites Tools  Help
Qu-Q XE@A® ) search 57 Favores ) - & B 8 A
Addre55|@ http:/flocalhast/Demafnethook asprreportfile=55_SUMMARY_RATEGROUP. xmigreporttemplatef 20Rate%20Group Vl d G0
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Server
Login Reports Spreadsheets Favorites Admin  Help Logout Home
Summary By Rate Group Open with Excel Return
Al - £ Account Code
1 [ q Rate Value =
2 |ATM 7732 502|DB2 Transaction Cpu Minutes Mainframe DB2 charges ) 0.3
3 | ATM 2733 500|DB2 Transactions (Records) Mainfrarme DB2 charges 0.02 16
4 |ATM 7734 506|DB2 Transaction Elapsed Minutes Mainframe DB2 charges 0.02 4.6
5 |ATM 735 510/DB2 Entry/Exit Events Mainframe DB2 charges 0.0 46 992.0
B |ATM 7736 512|DB2 11O Activity (Get Pages) Mainframe DB2 charges 1] 32,1440
7 AT 737 504 DB2 Accurnulated Cpu Minutes Mainfrarme DB2 charges 5 0.3
8 |ATM 7738 508|DB2 Accumulated Elapsed Minutes Mainframe DB2 charges 0.15 4.2
9 |CCX 7732 502 |DB2 Transaction Cpu Minutes Mainfrarme DB2 charges 5 0.7
10 |CCX 7733 500|DB2 Transactions (Records) Mainframe DB2 charges 0.02 28
11 |CCX 2734 506 |DB2 Transaction Elapsed Minutes Mainfrarme DB2 charges 0.02 E.1
12 |CCX 7735 510|DB2 Entry/Exit Events Mainframe DB2 charges 0.01 4382400
13 |CCX 736 512|DB2 VO Activity (Get Pages) Mainfrarme DB2 charges 0 135 816.0
14 |CCX 7737 504|DB2 Accumulated Cpu Minutes Mainframe DB2 charges ) 0.6
15 |CCX 738 508/ DB2 Accurnulated Elapsed Minutes Mainframe DE2 charges 0.15 23
16 |COM 7732 502|DB2 Transaction Cpu Minutes Mainframe DB2 charges ) 105.2 =
17 |COM 2733 500|DB2 Transactions (Records) Mainfrarme DB2 charges 0.02 13200
18 |COM 7734 506|DB2 Transaction Elapsed Minutes Mainframe DB2 charges 0.02 33856.9
19 |[COM 735 510/DB2 Entry/Exit Events Mainframe DB2 charges 0.0 2570504.0
20 |COM 7736 512|DB2 11O Activity (Get Pages) Mainframe DB2 charges 0] 110,882,256.0
21 |COm 737 504 DB2 Accurnulated Cpu Minutes Mainfrarme DB2 charges 5 104.3
22 |COM 7738 508|DB2 Accumulated Elapsed Minutes Mainframe DB2 charges 0.15 13405
23 IDAC 732 502/DE2 Transaction Cou Minutes IMainframe DE2 charaes ) i} |
< >
@ CIMS Server is ready. % Local intranet

Figure 4-17 « Example Summary By Rate Group Drill Down
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Crosstab Spreadsheet

Standard Advanced Spreadsheet Descriptions

The data that appears in this spreadsheet is user-defined. The CIMS Crosstab Wizard is
used to generate this spreadsheet. This wizard enables users to dynamically change rows
and columns to see different summaries of data. For more information, see Running a
Crosstab Advanced Spreadsheet on page 4-6.

XML file name: SS_CRTAB. xm1

Stored Procedure: CIMSSP_Summary

Key Column: User-defined

Parameters:

m Starting and Ending Account Code

m Account Code Level

Date Range

Possible Spreadsheet Fields

Rate Code
Account Name
Money Value
Account Code
Shift

Rate Index
Description
Comments
Rate Group
Resource Units

Rate Group Title
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Crosstab Spreadsheet Example
Figure 4-18 shows the fields selected for the spreadsheet in the CIMS Crosstab Wizard.

Figure 4-19 and Figure 4-20 on page 4-29 show the resulting spreadsheet and an
example drill down.

A CIMS Crosstab Wizard - Microsoft Internet Explorer : : i

Rate Code
Account Narme

account Code [l Money value

B

Rate Index
Description
Comments
Rate Group
Resaurce Units
Rate Group Titls

Lo I e

Figure 4-18 « Example Crosstab Spreadsheet Wizard

2 CIMS Server - Microsoft Internet Explorer,

Fle Edt Wew Favories Took Help
Q- O (¥ [ & ) searh 57 Favortes 47) R ;, [Jid 3 A

Address [ ] bttp:flacalhostiD haok.aspPreportfile=55_CRTAB xmiseporttemplatef ummary % 20Crosstab v Be

CIMS

Server

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Cross Tab Spreadsheet Open with Excel Return
A1 b b3
-~

1 1PRT DISKFILE DISKSIZE EQUIP EXBYRCV EXBYSNT EXEMRCV EXEMSNT EXMBXCNT FCSBytes FIIS2 FIIS-3 FIIS4 Figs

2 o o g o a a

3 |cex 0 43h] [ ] 2556 0.22 0 0 72 0 0

4 |COM 0] 1745.08 0 El 2514 0.28 0 0 9B 0 0

5 |DAC 0 21.34 0 2.4 48.47 417 0 i}

5 _|DEP 0 24717 o 5.4 485 3 o a 144 082 008 a o

7_|MTG 0 25613 1] P 365 0.04 1] a 14.4

8 |OME 0 76.83 0 9.9 005 0 95

9 |RTM 0 767 0 215 35626 33.29 0 i} 24 0

10 |551 0 49.79 0 2.2 24779 2.73 0 0 9B

11 |TEL 0 442.07 0 7 168

12 |WTx 0 107.8 0 3.2 35665 7.09 0 i} X 0 ul
13
4]

15

16 .. =
7| This is an example of a crosstab spreadsheet
B that includes drill down capability. Click a value to drill down.
Ed
121
2]

3 v
< &
IQ & Localinkranst

Figure 4-19 « Example Summary Crosstab Spreadsheet
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A CIMS Server - Microsoft Internet Explorer

Fle Edt View Favorites Tools Help
s A B somen o e 2 A
Qe - O \ﬂ E" ) O search 7 Favoriss ) & ol § é

e | ] i flocahhost/Demofnethook. asp

CIMS

Server —

Login Reports Spreadsheets Favorites
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Figure 4-20 + Example Summary Crosstab Drill Down
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Administering CIMS Server
Web Reporting

This chapter describes user-specific and system-wide configuration settings for CIMS
Server Web Reporting. It also provides information about other administrative tasks
such as creating custom report parameters and customizing CIMS Advanced
Spreadsheets.

Note ¢ For simplicity, the procedures in this section reflect commands for reports.
However, these procedures are also applicable to spreadsheets. For example, if you
are instructed to click Favorites » Add » Reports, the corresponding sequence for
spreadsheets is Favorites » Add » Spreadsheets.

Configuring User-Specific Settings ........coviiuiiiiiiiiiiiiiiiiiiiiiiiiiieiiieecenenenens 5-2
Working With Favorite Reports ... 5-2
Showing or Hiding Folder Paths for Published Reports .......... ... ... ... ... ... .... 5-5
Selecting an Account Code Structure for Reports ............... ... i 5-5
Choosing a Crystal Report Viewer . ......... . e 5-6
Changing Your E-mail Address ............ .. 5-7
Resetting the BrOWSer . ... ... oo e e 5-7
Configuring System-Wide Settings ...ttt 5-8
Accessing CIMS Financial Modeler and CIMS Web Console .............ccocvvuiuinnenennn. 5-11
Creating Custom Advanced Spreadsheets .............cociiiiiiiiiiiiiiiiiiiiiiieiienenes 5-12
About the XML Spreadsheet Definition File Structure . ............ ... . ... . ... . ... 5-13
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Configuring User-Specific Settings

Configuring User-Specific Settings

The settings described in this section can be different for each CIMS Web user. These
settings are not applied system wide.

Working With Favorite Reports

B 5-2

You can designate reports as favorite reports. This feature enables you to easily access
favorite reports from the Favorites page (see Figure 5-2 on page 5-4) or from shortcuts in
the left frame of the home page (see Figure 5-1 on page 5-3).

Note ¢ Although you can designate multiple reports as favorites, only the first five
reports that you add as favorites will appear on the home page.

To add a report as a favorite:
1 Click Favorites » Add » Reports.

2 On the Maintain Favorites-Add Reports page, expand the report group that contains
the report that you want, and then click the report.

The report is designated as a favorite as shown in example Figure 5-1 and appears on the
Favorites page (see Figure 5-2 on page 5-4).

Maintain Favorites - Add Reports

Account Total Invoice has been added
B 1nvoices
F&% Invoice by Account Level
Fa&% Application Cost
F&% Account Total Invoice
Alternate Invoice
Invoice with Budget
Invoice with Shifts
Run Total Invoice with Shifts
Run Total Invoice
Run Total Percent

Run Total Rate Group Percent
Zero Cost Center Invoice

Invoice by Account Level ¥2
Account Reports
Top Usage Reports
Yariance Reports
Trend
Resource Detail
Other
Custom

Note * When you add a report as a favorite, any published reports created from that
report are also automatically included as favorites if the default file name was used
when the published reports were created (see Publishing Reports on page 2-12). If a file
name other than the default was used for a published report, the system will not add
the report as a favorite and you cannot add the report manually.
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To access a favorite report from a shortcut:

Click the report link in the left frame of the home page (see Figure 5-1). If the report has
a correlating published report for the current period, the most current published report
opens.

If the favorite report does not have a correlating published report for the current period,
the parameters page for the report opens.

2 CIMS Server - Microsoft Internet Explorer =X
Fle Edt Wew Favortes Tooks Help [
O~ O [A (8 @ P Srawns @ (3- % VY
Address [ ] http:jjw. cimsserver.comidefault. ssp v Be @
CIMS I
Server .

Login Reports Spreadsheets Favorites Admin  Help Logout Home
CIMS Lse. ince
weelcofne John Q. Customer, you are currently signed on as know
| CIMs Herver is the Enterprise Wide System for managing IT casts, & central repository of resource usage data is
collectdd fram OS/390, NT, UNIX, Metwork, e-Cormmerce, and more, Any source of resource Usage can be L
collectdd and reported on. web based reporting makes resource usage information immediately available across
your oijanization, & cormplete system for taday's complex IT processing environment,
CIMS Lab, Inc.
3013 Douglas Blvd, Suite 120
Roseville, CA 95661
www.cimslab.com
Fhone: [916) 763-6525 | Tall-Free: (00) 263-4267 | Fax: (916) 783-2090
Copyright ©2001 CIMS Lab, Inc - &ll rights reserved Created 11/11/2004 12:12:07 PM
v
& Internet

List of favorite reports

Figure 5-1 « Favorite Report Links
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To access a favorite report from the Favorites page:
1 Click Favorites » Reports.

The Favorites page opens displaying a hierarchy of reports that you have saved as

favorites.

2 Navigate to the appropriate report (see Figure 5-2) and expand it.

3 Do one of the following:

¢ Click Run Report to run the report.

e Click a published report (if available) to view the report. You can hide or display
the folder path that appears for the published report. See Showing or Hiding Folder

Paths for Published Reports on page 5-5.

A http:/fwww.cimsserver.com/Tfavorites.asp?select=Reports - Microsoft Internet Explorer

File Edit View Favorites Tools  Help

Q- O @ & S serch 5l pavories 62 - iz

B s A

EEX

>

Address @ hitp: [ fuwes, cimsserver.com| TFavarites, asp?select=Reparts

len @

CIMS

Server

Favorites

E  Favorite Reports
B 1nvoice by Account Level
— Run Report

\Reportsirinyc007.rpt

Account Total Invoice
application Cost

(lick here to run the report

€l

Login Reports Spreadsheets Favorites Admin  Help Logout Home

18/ 1 il .com\C:\Prog ilesy A \Rep A i AR \ \
11/8/2004 1:32:53 pMiwww.cimsserver.com\C:\Program Files\CIMSLab%Server\Reports90%Published\\user\know4200411

Click here to view
the published report

B Internet

Figure 5-2 « Navigating to a Favorite Report

To remove a favorite report:
1 Click Favorites » Delete.

2 On the Maintain Favorites—Remove Reports page, click the report that you want to

remove.

The report is removed from Favorites list.

Note ¢ Removing a favorite report simply removes the report from your list of

favorites. It does not delete the report from the system.
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Showing or Hiding Folder Paths for Published Reports

By default, published reports that appear on the Published Reports and Favorites pages
include the full path to the folder that contains the report. You can choose to show or
hide these paths.

To hide or display folder paths of reports:
1 Click Admin » User Options.
2 On the Set User Options page, do the following:

¢ To show the full folder paths on the Published Reports and/or Favorites pages,
click Y in the appropriate box.

e To hide folder paths, click N in the appropriate box.
3 Click Update.

The system shows or hides the directory paths as you requested.

Selecting an Account Code Structure for Reports

If your CIMS Server administrator has assigned multiple account code structures to your
user group, you can choose the account structure that you want to appear in reports.

To select the account code structure:
1 Click Admin » User Options.

2 On the Set User Options page, click the account code structure that you want to use
in the Account Code Structure select box.
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Choosing a Crystal Report Viewer

In most cases, your CIMS Server administrator will have set the appropriate Crystal
Report viewer for your browser. (For more information, refer to the CIMS Server
Administrator’s Guide.) However, you can change the viewer as needed from CIMS Server
Web Reporting. The viewer that you select should be based on the specifics of your
browser and computer. For the advantages and disadvantages of each viewer, see

page 5-8.

Note ¢ If you are using SQL Server Reporting Services for reporting, use the
Default viewer.

To choose a Crystal Report viewer:

Note ¢ The following steps are applicable to selecting a viewer for an individual
CIMS Web user only. To set the viewer for all users, see Configuring System-Wide
Settings on page 5-8. CIMS Server Web Reporting uses the viewer set for the individual
user if it differs from viewer set for all users.

1 Click Admin » User Options.

2 On the Set User Options page, click one of the following in the Crystal Web Viewer
select box:

e Default. This option uses the viewer set on the Edit Configuration page (see
page 5-8).

e ActiveX. This option works only in Internet Explorer.

e Java using Browser JVM. This option works in Netscape Navigator or Internet
Explorer. This viewer requires the Java™ Virtual Machine. Because this viewer
might be more difficult to set up, CIMS Lab recommends that you use the HTML
or ActiveX viewer.

e HTML. This option is appropriate for users with lower powered computers with
minimal memory (64MB or less). It offers a smaller feature set.

3 Click Update to change the viewer.
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Changing Your E-mail Address

CIMS Server includes an automatic report distribution feature. If your CIMS Server
administrator has enabled this feature for your user ID or user group, you will receive
published reports via e-mail. Your CIMS Server administrator determines the reports that
you will receive.

If needed, you can change the e-mail address at which you receive reports. To change
your e-mail address:

1 Click Admin » User Options.
2 In the Email Address box, type your e-mail address, and then click Update.

For more information about publishing and distributing reports in batch, refer to the
CIMS Server Administrator’s Guide.

Resetting the Browser

Important! « You should reset the browser only after consulting CIMS Lab.
This feature is for debugging purposes only.

You can reset your browser to the default values by clicking Admin » User Options and
then clicking OK under Browser Reset.
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Configuring System-Wide Settings

You must be a CIMS Web administrator to edit the configuration settings described in
the section. If you are not an administrator, you can view these settings in a read-only
capacity.

B 5-8

These configuration settings are saved to the CIMS Server database and are applied to all
CIMS Web users.

Note * Many of these settings can also be configured using CIMS Server
Administrator.

To edit the configuration settings:

1 Click Admin » Configuration.

2 Edit the settings on the Edit Configuration page as follows:

CIMS Data Source ID and ODBC DSN (not editable). These fields identify the
database that CIMS Server Web Reporting is pointing to. The value for the CIMS
Data Source ID setting is always Default. The default CIMS Data Source is defined
in CIMS Server Administrator. The default CIMS Data Source points the ODBC
Data Source shown in the ODBC DSN box, which points to the database. For
more information about setting up CIMS Data Sources and ODBC Data Sources,
refer to the CIMS Server Administrator’s Guide.

ODBC DSN (not editable). The name of the ODBC-compliant Data Source that
the default CIMS Data Source is pointing to.

Localization ID (LCID) (not editable). The LCID assigned to the user’s regional
setting in Windows.

Organization Name and Address Fields. Address information for your
organization (maximum of 255 characters for each box). This information appears
in the standard invoices provided with CIMS Server.

Path to Standard/Custom/Published Reports Folder. The paths to the folders
that contains the standard, custom, and published reports used for Web reporting
(maximum of 255 characters for each box).

Invoice Number. This invoice number is used only if the Invoice Number report
parameter is not available (see page 2-5).

Session Timeout Minutes. The number of minutes of inactivity that are allowed
before users are automatically logged out of CIMS Server Web Reporting. The
minimum is 1 minute and the maximum is 9999 minutes. The default is 60
minutes.

Note ¢ If you change this setting, the change will not take effect during the
same session. You need to log out and the log on again.
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e Crystal Web Viewer. This setting determines the particular Crystal Viewer used to
view reports. You can choose one of the following:

Note ¢ If you are using SQL Server Reporting Services for reporting, leave this
box set to Default.

e Default. If you are using Crystal Reports 9 or 10, the default is the HTML viewer.
If you are using Crystal Reports 8.5, the default is the ActiveX viewer.

» ActiveX. This option works only in Internet Explorer. This viewer has the
following advantages and disadvantages:

Advantage: This viewer provides more features than the HTML viewer provides.

Disadvantage: This viewer requires that the Crystal Smart Viewer for ActiveX be
installed on the user’s computer (for more information, refer to the CIMS Server
Administrator’s Guide). The user might not have the administrative privileges
required to install and run the viewer.

e Java using Browser JVM. This option works in Netscape Navigator or Internet
Explorer. This viewer requires the Java Virtual Machine. Because this viewer
might be more difficult to set up, CIMS Lab recommends that you use the HTML
or ActiveX viewer.

e HTML. This option works in Internet Explorer or Netscape Navigator. This
viewer has the following advantages and disadvantages:

Advantage: This viewer works with any browser and does not require any
additional files or set up.

Disadvantage: This viewer provides fewer features than the ActiveX viewer
provides.

e Display Account Code Selection to Level. This setting determines the level of
account codes that appear in the Starting Account Code and Ending Account
Code lists on a report parameters page. For example, if you type 1, only the top
level account codes appear. However, if you type 3, the first, second, and third level
account codes appear.

¢ Current Database Version (not editable). The version of the database currently
used by CIMS Server.

¢ Last Reporting Date. The last reporting date that CIMS Web end users can view.
For example, if the date is December 31 2010, end users cannot view reports for
dates after December 2010. The default is December 31 2199.

Note « CIMS Web administrators can view reports for any date.
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3 When you are finished, click Update Configuration to change the settings.

Note ¢ Update Configuration also refreshes additional configuration options that
are set in CIMS Server Administrator and stored in the Web server cache. For more
information about the configuration options that you can set for CIMS Server
Web Reporting, refer to the CIMS Server Administrator’s Guide.

About Updating Identifiers

A key feature of viewing invoices in CIMS Server Web Reporting is the ability to drill
down on the units consumed for a resource by identifier. This feature uses the
CIMSRateldentifiers table, which contains the rate codes that are processed from the

input resource file(s) and correlates them to their corresponding identifier names in the
CIMSIdent table.

If the identifiers in and/or a rate code or codes in the input file have changed, the
CIMSRateldentifiers table will retain unused data in addition to the current data.
Although this does not cause processing problems, the table can accumulate a large
amount of data. You can click Update Identifiers Cache to update the table so that it
contains only the current data; however, in most cases this step will already be
completed by your CIMS Server administrator.

For more information about maintaining identifiers, refer to the CIMS Server
Administrator’s Guide.
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Accessing CIMS Financial Modeler and
CIMS Web Console

If your CIMS Server administrator has enabled access to CIMS Financial Modeler and/or
CIMS Web Console for your user group, links to these applications appear in the Admin
menu.

CIMS Financial Modeler provides an interface for performing IT finance-related tasks,
such as cost analysis and allocation and rate calculation. For more information about
this application, refer to the CIMS Server Administrator’s Guide.

CIMS Web Console provides an interface for creating job files, viewing job log files, and
performing some CIMS Server administration tasks. CIMS Web Console is a beta release
in CIMS Server 4.3. For more information about this application, contact CIMS Lab.

CIMS Server Web Reporting User’s Guide 5-11 W



B Administering CIMS Server Web Reporting

Creating Custom Advanced Spreadsheets

Creating Custom Advanced Spreadsheets

B 5-12

Note ¢ The information in this section is pertinent only if you want create custom
CIMS Advanced Spreadsheets. For more information about CIMS Advanced
Spreadsheets, refer to Chapter 4, Running and Working With CIMS Advanced Spreadsheets.

This section assumes that you have knowledge of XML and SQL concepts and
conventions. If you are using an Oracle or DB2 database, contact CIMS Lab for
information about using CIMS Advanced Spreadsheets.

Each advanced spreadsheet is defined by an XML file. CIMS Lab provides XML definition
files for the standard spreadsheets described in Standard Advanced Spreadsheet Descriptions
on page 4-14. If CIMS Server is installed in the default location, these files are in
C:\Program Files\CIMSLab\Server\AdvSpreadsheets\Standard. To create custom
advanced spreadsheets, you can modify the standard XML definition files or you can
create new files.

Note ¢ To use an advanced spreadsheet, you must move the spreadsheet XML file
from the AdvSpreadsheets folder to the folder that contains the Crystal or Reporting
Services reports. For more more information, refer to the CIMS Server Administrator’s
Guide.

The section About the XML Spreadsheet Definition File Structure on page 5-13 defines the
required structure for the advanced spreadsheet definition files. Whether you are
modifying an existing file or creating a new file, you need to follow this structure.
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About the XML Spreadsheet Definition File Structure

The spreadsheet
name and
description are
defined here. For
more information,
see page 5-14.

The SQL stored
procedure, view, or
table is defined here.
For more
information, see

page 5-15.

The spreadsheet
fields are defined
here. For more
information, see

page 5-17.

The XML definition file for each spreadsheet is composed of three parts:
m The name and description of the spreadsheet.

m The SQL stored procedure, view, or table used to retrieve data.

m The fields that appear in the spreadsheet.

The structure of each of these parts is shown in the following XML definition file for the
crosstab spreadsheet, SS_CRTAB. xm1.

Sample XML Definition

<?xml version="1.0" encoding="utf-8"7>

<{SpreadSheet name="Crosstab Spreadsheet">

<!I--Generic description for the report, retained for future UI implementation-->
<Description>Account Crosstab Spreadsheet</Description>

<I--SQL Types...-->
<SQL type="storedprocedure" name="CIMSSp_Summary" crosstab="1"
crosstabdrilldown="1">

<l--Param types...-->

<Param name="AccountCodeStart" type="custom"/>

<Param name="AccountCodeEnd" type="custom"/>

<Param name="Invoicelevel" type="custom" SQLIgnore="1"/>
<Param name="AccountStart" type="custom"/>

<Param name="AccountlLength" type="custom"/>

<Param name="DateRange" type="custom" SQLIgnore="1"/>
<Param name="DateStart" type="custom"/>

<Param name="DateEnd" type="custom"/>

<Param name="UserID" type="system"/>

<Param name="Subtotallength" type="constant">2</Param>

</SaL>

<Fields>
<{!--These are the fields that will be displayed in the report...-->
<Field name="RateCode" xaxislevel="1">Rate Code</Field>
<Field name="AccountName" yaxislevel="1">Account Name</Field>
<Field name="MoneyValue" xaxislevel="2" >Money Value</Field>
<Field name="AccountCode" drilldown="1" secondaryDrill="1" criteria="1">
Account Code</Field>
<Field name="Shift" drilldown="1">Shift</Field>
<Field name="Ratelndex" function="max">Rate Index</Field>
<Field name="Description" selectable="1">Description</Field>
<Field name="Comments" drilldown="1">Comments</Field>
<Field name="RateGroup" selectable="1" sort="1">Rate Group</Field>
<{Field name="ResourceUnits" sum="1" >Resource Units</Field>
<Field name="GroupTitlelong" >Rate Group Title</Field>

</Fields>
</SpreadSheet>
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Defining the Name and Description of the Spreadsheet

The spreadsheet name is an attribute of the root SpreadSheet element and is defined as
follows:

{SpreadSheet name="Name{string}">

Note ¢ The spreadsheet name that is defined here is the name that appears on the
Spreadsheets page. For example, if you define the spreadsheet name as <SpreadSheet
name="Invoice Spreadsheet">, the name Invoice Spreadsheet appears on the
Spreadsheet page.

The spreadsheet description is defined in the Description element. This element cannot
have attributes and is defined as follows.

<Description>Description{string}</Description>

The Description element is usually the first child of the SpreadSheet element.
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Defining the SQL Stored Procedure, View, or Table

The SQL stored procedure, view, or table that is used to retrieve the data for the
spreadsheet is defined as an attribute of the SQL element. The SQL element is a child of
the root SpreadSheet element and is defined as follows:

<SQL type="storedprocedure | view | table" name="SQL Object Name{string}" crosstab="1"

crosstabdrilldown="1">

SQL Element Attributes
The attributes of the SQL element are defined as follows.

Attribute Description

type="storedprocedure
| view | table"

name="SQL Object
Namef{string}"

crosstab="1"

crosstabdrilldown="1"

The type of SQL object that is used to retrieve data. If the
type is a view or table, then a select statement is built and
executed on the specified view or table name.

If the type is a stored procedure, then the stored procedure
is executed with parameters passed in (see Param Element
Attributes on page 5-16).

The name of the SQL object in the database.

If this attribute is present, the spreadsheet is a crosstab
spreadsheet. You must define four or more fields for a
crosstab spreadsheet (see Defining the Fields That Appear in
the Spreadsheet on page 5-17). Otherwise, the CIMS
Crosstab Wizard does not appear on the parameters page
for the spreadsheet.

If this attribute is present, the crosstab spreadsheet includes
drill down on the values in the main content area of the
spreadsheet (see Running a Crosstab Advanced Spreadsheet on
page 4-6).

If the crosstab attribute is not present, this attribute is
ignored.

Table 5-1 « SQL Element Attributes
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Param Element Attributes

If the type attribute is a view or table, then input parameters are not used. A simple select
statement is generated based on the specified table or view name.

If the type attribute is a stored procedure, then Param elements are used to define the
input parameters for the store procedure. The Param elements are child elements of the
SQL element. Param elements are defined as follows:

<Param name="Name{string}" type="custom | system | constant" SQLIgnore="1"/>

The attributes of the Param element are defined as follows.

Attribute Description

name="Name{string}" The parameter names must match the names of the
parameter defined in the stored procedure.

type="custom | system | The type attribute has three allowable string values:

constant”
m custom This type specifies that an external Web

control should be loaded to provide user
input for this parameter. For example, to
select the start and end dates fora
spreadsheet.

m system This type specifies that the value for the
parameter should be pulled from system
internal data such as a user or group ID.

m constant  This type may be used if you want to pass a
constant as a parameter. In this case, the text
entered for the Param element will be passed
to the stored procedure.

SQLIgnore="1" If this attribute is present, the parameter is not passed to the
stored procedure. This attribute enables you to load custom
controls.

Table 5-2 « Param Element Attributes
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Defining the Fields That Appear in the Spreadsheet

The Fields element defines the fields that appear in the spreadsheet. The Fields element
is a child of the root SpreadSheet element and has child Field elements. The Fields and
Field elements are defined as follows:

<Fields runtotal="1">
<Field name="Column Name{string}" sort="1" selectable="1" criteria="1"
groupby="1" drilldown="1" format="string" sum="1" function="Function
Name{string}" xaxislevel="1|2" yaxislevel="1">Display Name{string}</Field>
</Fields>

Note ¢ Display Name {string} = the field name.

Fields Element Attributes

The Fields element has a single attribute, runtotal="1". If this attribute is present, a Run
Total row appears at the bottom of the spreadsheet. If the Field attribute groupby is not
present, runtotal is ignored.

Field Element Attributes
The attributes of the Field elements are defined as follows:

Attribute Description

name="Column The name of the field as it is returned from the database.
Name{string}"

sort="1" If this attribute is present, users can select whether the
spreadsheet rows are sorted by the values in this field.

selectable="1" If this attribute is present, users can show or hide this field
in the spreadsheet.

criteria="1" If this attribute is present, users can apply a condition for
data displayed in the spreadsheet. These conditions are
based on the data value being equal to, greater than, or less
than the value specified by the user.

groupby="1" If this attribute is present, users can drill down on values in
the field to view detailed data.

drilldown="1" If this attribute is present, the field appears only when users
drill down on data in the spreadsheet. This enables you to
display more relevant data in the detail view while hiding
the detail when viewing summary data.

If the groupby attribute is not present, this attribute is
ignored.

Figure 5-3 -+ Field Element Attributes
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Attribute Description

format="string" This attribute specifies the format for the field. The
formatting model follows that of the Microsoft .NET
Framework. All numbers are formatted using the Number
format by default. Additional internationalization will be
automatically applied to the formatting.

The format characters are:
¢, C Currency format

d, D Decimal format

e E Scientific (exponential) format
f, F Fixed-point format
g G General format

n, N Number format

x, X Hexadecimal format

sum="1" If this attribute is present, the values in the field are
summed based on the groupby attribute. If the groupby
attribute is not present, this attribute is ignored.

If the criteria attribute is present, only those values that
meet the condition set by the criteria attribute will be
summed and included in this field.

function="Function This attribute applies aggregate functions to columns in the
Name{string}" spreadsheet. The following aggregates are supported:
Sum (Sum)

Avg (Average)

Min (Minimum)

Max (Maximum)

Count (Count)

StDev (Statistical standard deviation)
Var (Statistical variance)

If the groupby attribute is not present, this attribute is
ignored.

Functions applied to crosstab spreadsheets can be
overridden by the end user using the CIMS Crosstab Wizard
(see Running a Crosstab Advanced Spreadsheet on page 4-6).

Note that all functions applied to fields are also reflected in
the Run Total row.

Figure 5-3 « Field Element Attributes (Continued)
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Attribute Description

xaxislevel="1]2" This attribute is used only for crosstab spreadsheets. This
attribute may have a value of "1" or "2".

The value "1" specifies that the values for this field will
occupy the first row of the spreadsheet.

The value "2" specifies that the field will contain the content
of the spreadsheet.

If the criteria attribute is present, only those values that
meet the condition set by the criteria attribute will be
summed and included in this field.

The values for this attribute can be overridden by the end
user using the CIMS Crosstab Wizard (see Running a
Crosstab Advanced Spreadsheet on page 4-6).

yaxislevel="1" This attribute is used only for crosstab spreadsheets.

This attribute specifies that the field will occupy the first
column of the spreadsheet.

This attribute can be overridden by the end user using the
CIMS Crosstab Wizard (see Running a Crosstab Advanced
Spreadsheet on page 4-6).

Figure 5-3 « Field Element Attributes (Continued)
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Using Transactions

This chapter describes how to create miscellaneous, recurring, and credit transactions.

Working With Transactions .........ccoiiiiiiiiiiiiiiiiieieieiiieiiieieieienecncncnenenss 6-2
Adding Transactions . . ... i e 6-3
Editing Transactions ......... ... . 6-4
Deleting Transactions .. ... ... ... i e 6-4
Navigating Transactions . . .. ... . 6-4

CIMS Server Web Reporting User’s Guide 6-1 W



B Using Transactions

Working With Transactions

Working With Transactions

The CIMS Server Resource (CSR) file is used to input data into CIMS Server. This file
provides usage data from any IT source in a common format. CSR files are generated
from usage metering files produced by systems in your organization, for example, IIS log
files, SQL Server trace files, or disk usage output files.

In some circumstances, you might want to generate a CSR file for occurrences that are
not contained in a usage metering file. For example, you might want to generate a CSR
file to apply a credit for an overcharge or to charge for a one time occurrence such as the
cost of providing a computer to a new employee. In these cases, you can create a
transaction that contains the chargeback information that you want to include in the
CSR file.

In summary, a transaction enables you to generate charges or credits for any item or
resource that is not contained in a usage metering file.

There are three types of transactions:

m Miscellaneous Transactions. These are transactions that occur on a one-time basis.
For example, charging for the services of a consultant who worked on a project for two
days.

® Recurring Transactions. These are transactions that re-occur over a period of time.
For example, charging for a set number of computers that are delivered to a
department each quarter.

m Credit Transactions. These are transactions that apply a credit for resources units
consumed or monetary charges.

To process transactions, you need to use the CIMS Data Collector for Transactions. For
more information about this collector, refer to the CIMS Data Collectors for Microsoft
Windows Installation and User Guide.
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Adding Transactions

To add transactions:

1 Click Admin » Transactions » Miscellaneous/Recurring/Credit. Note that
Miscellaneous, Recurring, and Credit are separate commands.

2 On the transaction list page, click Add.

3 On the add transaction page, enter the following parameters for the transaction:

e Account Code or account code levels. Depending on the configuration set by
your CIMS Server administrator for your user group, the first setting that appears
on the page will be either Account Code, in which you can enter an overall
account code, or account code level boxes, in which you can enter levels of the
account code. For more information about configuring this setting, refer to the
CIMS Server Administrator’s Guide.

¢ Rate Code. The rate code for the transaction.

e Shift Code (optional). The shift code for the transaction. Shift codes are set by
your CIMS Server administrator. For more information, refer to the CIMS Server
Administrator’s Guide.

¢ Amount. The amount of the transaction. Usually this figure is in resource units,
for example, 500 computers, but it can also be monetary. If monetary, you can
type this amount with our without the decimal point. For example, 1000 or
1000.00. Credit amounts need to be specified by a minus sign (e.g., -1000).

¢ From/To Date (Miscellaneous and Credit Transactions only). The date range
that the transaction occurred.

¢ Frequency (Recurring Transactions only). The frequency that the transaction
should occur (that is, every month, every 6 months, every quarter, etc.). Frequency
is based on the calendar year (January-December).

e Enter transaction on (Recurring Transactions only). The period in which the
transaction should be processed. The number of periods correlates to the value in
the Frequency select box. For example, if Every 6 months is selected for frequency,
six periods appear (Period 1 represents January and July, Period 2 represents
February and August, etc.)

Note that the date parameter used by the Transactions collector determines which
recurring transactions are processed. For example, if the collector is run in June
with a date parameter of Current, and the transaction is set to Once a year and
Period 1 (January), the transaction will not be processed.

e Begin/End Processing on (Recurring Transactions only, optional). The date
range in which you want recurring transactions to be processed. CIMS Server will
not process recurring transactions before or after these dates. The default is the first
day of the current month to December 31, 2199.

e Notes. Any relevant comments.

4 When you are finished, click Add to save the transaction and return the transaction
list page. If you do not want to save the transaction click Return.
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Editing Transactions

To edit miscellaneous and credit transactions:

1 On the transaction list page, click the date for the transaction(s) that you want to edit
in the Set the Date Range or From/To select boxes.

2 Click Refresh. All transactions within the specified date range appear.

3 Click the Edit button for the transaction that you want. to edit. For a description of
the settings that you can edit, see Adding Transactions on page 6-3.

4 When you have completed the edits, click Update to save the edits and return to the
transaction list page. If you do not want to save the edits, click Return.

To edit recurring transactions:

1 Click Edit for the transaction that you want. For a description of the settings that you
can edit, see Adding Transactions on page 6-3.

2 When you have completed the edits, click Update to save the edits and return to the
transaction list page. If you do not want to save the edits click Return.

Deleting Transactions

To delete transactions:

On the transaction list page, click the Delete button for the transaction that you want to
delete. You can also delete the transaction from the edit transaction page. In this case,
the delete transaction page opens indicating the date and time that the transaction was
deleted.

Navigating Transactions
You can navigate to the transaction pages by:
m Clicking Admin » Transactions.
Or

m Within an open transaction list page, clicking another transaction type in the Select
Type select box.
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Troubleshooting

This chapter describes problems you may encounter while using CIMS Server Web
Reporting and how to solve them. If you cannot find the answer to your question here,
please contact CIMS Lab (see Contacting Technical Support on page 7-5).

ConNectioN PrODIEMS .....uvuniiiiiiiiiiiiii ittt it iiiiieittieiieneenteassenocnnnnnnns 7-2
Unable to connect to the CIMS Server Web Reporting Website ......................... 7-2
The CIMS Server Web Reporting Web site is not opening properly ....................... 7-2
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Connection Problems

Unable to connect to the CIMS Server Web Reporting Web site

Verify the following:
®m Your Internet or network connection is working properly.

®m You have appropriate network permissions and are using Internet Explorer 5.5 or
later.

B You entered the correct URL.

®m You have the required security permissions for the CIMS Server program folders
discussed in Assigning CIMS Server Folder Security Permissions on page 1-7.

For assistance troubleshooting these problems, contact your system administrator.

The CIMS Server Web Reporting Web site is not opening properly

Try the following:
m Restart IIS by clicking Start » Run, type iisreset /restart, and then click OK.

B Check the IIS security settings (refer to the CIMS Server Administrator’s Guide for more
information)

m Ifyou are using Crystal Reports 8.5, make sure that you have applied the Crystal patch
Crystal Decisions ActiveX Viewer Patch.exe and any other patches recommended
by CIMS Lab. If you are using Crystal Reports 9, make sure that you have installed
Service Pack 2. Crystal Reports patches and services packs are available on the CIMS
Lab FTP site (ftp://ftp.cimslab.com) and CIMS Product CD. The path on both the FTP
site and CIMS Product CD is CIMSServer\CrystalPatches.

m Install the latest service pack for Microsoft SQL Server.

Log On Problems

System will not accept user ID or password

Make sure that you are typing the correct user ID and password. Note that the user
password is case-sensitive.

If the password is invalid, another possible cause is that your CIMS Server administrator
did not click Change when he added your password in the User Maintenance dialog box
in CIMS Server Administrator. The administrator must click Change to save the
password regardless of whether he is adding the password for the first time or is changing
the password. For more information about setting the user ID and password, refer to the
CIMS Server Administrator’s Guide.
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Error message appears when trying to run a spreadsheet or
publish a report

If you receive the following messages when you try to run a spreadsheet or publish a
report, you do not have the correct security permissions for the CIMS Server program
folders discussed in Assigning CIMS Server Folder Security Permissions on page 1-7. Contact
your CIMS Server administrator or system administrator.

Spreadsheet Message

Your Web Userid does not have sufficient access rights to create spreadsheets. Please
have the CIMS Web Administrator enable write permissions for the IIS Web User to the
..\CIMSLab\Server\Web folder on the CIMS Server. Consult the CIMS Server Administrator's
Guide for more information.

Published Report Message

Your Web Userid does not have sufficient access rights to create published reports. Please
have the CIMS Web Administrator enable write permissions for the IIS Web User to the
..\CIMSLab\Server\Reports\Published folder on the CIMS Server. Consult the CIMS Server
Administrator's Guide for more information.

Reports take a long time to generate

Make sure that your Internet or network connection is working properly. It could be that
excessive network usage is slowing down either the connection or the server. If you are
using the ActiveX viewer and would like to stop a report that has begun loading, click the
Stop Loading button (see Stopping a Report from Loading (ActiveX Viewer Only) on

page 3-4).

If you or other users would like to view the same report again, you can avoid waiting for
the report to generate by publishing or saving the report. For more information, see
Publishing Reports on page 2-12 or Saving Reports on page 3-8.

Problems viewing reports

Change the viewer used to view reports. For more information, see Choosing a Crystal
Report Viewer on page 5-6.

If you are using the Crystal Report ActiveX viewer and report headers and data do not
appear in the report, you may need to use the HTML or Java viewer instead. You may not
have administrative privileges to allow the ActiveX viewer to be automatically
downloaded and installed on the computer on which your are trying to run the report.

Old data appears in reports

One or more old loads have not been removed from the database. Unload the old data.
For more information, refer to the CIMS Server Administrator’s Guide.
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Cannot drill down in reports

Certain items do not have any additional information available. If you place the cursor
on an item and the cursor icon becomes a magnifying glass or a hand, you can drill
down. If it does not, there is no detailed information available about the item.

If you cannot drill down on items that should have drill down capability, install the
ActiveX patch from Crystal. CIMS Lab provides this patch on the CIMS Lab FTP site and
the product CD (...\CIMSServer\CrystalPatches\Crystal Decisions ActiveX Viewer
Patch.exe).

Error message appears when running reports

If one of the following error messages appears when running a report:
B A time-out message that appears immediately.

B -2147192179 An error has occurred on the server in attempting to access the
data source.

Click Administration » Database » Database Object Manager in CIMS Server
Administrator and add any database objects that do not exist in the database (that is, No
appears in the Exists column for an object or objects).

If this does not solve the problem, drop all stored procedures, indexes, triggers, and
views in the Database Objects Manager dialog box and then create them again.

Important! « Do not drop the tables in the Database Objects Manager dialog box.
Dropping a table removes the table and its data from the database.

To view a more detail error message, run the report directly from Crystal Reports (not
from the Web browser).

Reports are missing from reports lists

If reports that you used to be able to access are missing from reports lists, your CIMS
Server administrator may have removed access to those reports from you user group.
Contact your CIMS Server administrator.
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General Problems

Web reporting session is timing out before or after session timeout
value

If you change the Session Timeout Minutes value, the change will not take effect until
you restart IIS. For instructions on how to restart IIS, see page 7-2.

Computer locks up or runs slowly

The computer might not have enough memory to process. Try running the application
on a PC with more memory (preferably 256 MB or more).

Contacting Technical Support

The CIMS Lab Technical Support department is here to answer your questions on any
aspect of CIMS Lab products.

CIMS Lab technical support can be reached in the following ways:

m Telephone: (800) 283-4267 in USA and Canada; 916-783-8525 International
B E-mail: support@cimslab.com

m Fax request: (916) 783-2090

International customers may contact one of our authorized international partners.
Contact CIMS Lab for more information.

In addition, customers may visit the Customer Area on our Web site for product
downloads, updates, technical documentation, and password information. We are on
the Web at http://www.cimslab.com.
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Standard Reports

This appendix describes the standard reports provided with CIMS Server.

About CIMS Server REPOIES ....c.viuiiuiiiiiiiitieeieiieieeiesesaesessesscsssssssccssnaes A-4
Location of CIMS Server Reports . . ... ...t i A-4
Report Naming Conventions .............. . i A-5
Conventions Used in This AppendiX ......c.covuieieiiiiiieieiiiieieneniiieneniieecenencnnns A-5
Reports BY FIle Name ......ouiniiiiiiiiiiiiiiiiiiiiiiiiiiiitieieieeeensnccsesscscncncncns A-6
L] - ') 1T A-8
Cost Trend—Accounts Graph . ... ... o e A-8
Cost Trend—Rates Graph . ......... .. i e e e A9
Resource Trend Graph .. ... ... A-10
Drill DOWN REPOIES . ..vvnininieiiiiieieiiiieieitiieteteneusesenescecesescssacasencncns A-11
Invoice Drill Down for Rate Group Report .......... .. ... i A-11
Invoice Drill Down for Rate Group by Date Report . ............... . ... ..., A-13
Invoice Drill Down for Units Report . ... ... . A-14
Invoice Drill Down for Units by Date Report ........... ... ... ... ... . o il i A-16
Multilevel Drill Down for Units Report ........ ... . i A-17
2 1 10 A-19
Client Audit Report ... ... A-19
Rate Audit Report . ... ... A-21
Transaction Audit Report . ... A-23
Batch Report . ... A-24
Account Budget for Period and YTD Report . ......... .t A-25
Line Item Budget for Period and YTD Report ........ ... ... i, A-26
Configuration Report . . .. ... oo A-27
CICS Transaction RepOrt .. ... ... e A-28
Client REPOIt . ... A-29
Account Summary Daily Report . . ... .. A-30
Account Summary Daily 2 Report . ... . A-31
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DB2 Summary RepOrt . .. ... A-32
Detail by Rate Group Report .. ... ... i A-33
Detail by Rate Group/ldentifier Report ....... ... ... . .. A-34
Detail Rate Codes by Identifiers . ......... ... A-35
Detail Rate Codes by Identifiers/Account ......... .. ... . . i A-36
MS Exchange 2000 Resource Report . ... ... i A-37
Invoice by Account Level V2 Report . ... ..o A-38
Alternate Invoice Report ... ... ... e A-38
Account Total Invoice Report ... ... . A-40
Invoice with Budget Report . .. ... A-41
INVoice REPOIt . . .. A-43
Invoice by Account Level Report ... ... .. A-45
Invoice with Shifts Report . ... . A-47
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Run Total Percent Report . . . ... oo A-50
Run Total Rate Group Percent Report ......... ... .. .. i i A-51
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Zero Cost Center Invoice Report . ... .. A-53
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JOD COSt REPOIt . ..o e A-56
MS SQL Server 2000 Resource Report ........ ... A-58
Percentage Report . ... ... A-59
Rate Report . ... ... A-60
TOp COSt REPOIt ... A-61
Top 10 Bar Graph Report .. ... e e A-63
Top 10 Pie Chart Report .. ... ... e e e A-65
Top Accounts for Rate Report ... ... o A-67
CostTrend RepOIt . . ... A-68
Cost Trend by Rate Report . . ... ... i i A-69
Resource Usage Trend Report . . ... .. .o i A-70
Transaction REPOIt . .. ... o e A-71
Cost Variance RepOIt . ... ... e A-72
Cost Variance Drill DOWN RepOIt . ... ...t e e A-73
Resource Variance Report ... .. ... o i A-74
Disk Directory Resource Report ............ i A-75
Account Summary by WeeK Report . ......... . A-76
Account Summary by Week—Wide Report ........ ... ... i A-77
Account Summary YTD RepOrt ... ..o A-78
Account Summary YTD—Wide Report . ... ... A-79
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Spreadsheets .......ocuiuiiiiiiiiiiiiiiiiiiiiiii ittt ittt eieaaaae A-80
Invoice Spreadsheet . ....... ... A-80
Run Total Invoice Spreadsheet .. ........... . . . i A-81
Invoice by Rate Group Spreadsheet ......... ... ... . . i A-82
Invoice by Account Code Spreadsheet ......... .. ... ... i A-83
Proration by Total Amount Spreadsheet ........... .. ... . ... . .. . il A-84
Proration by Rate Code Spreadsheet .......... ... . ... .. . i A-85
Proration by Rate Group Spreadsheet ......... ... .. ... . i A-86
Top 10 Accounts for Rate Spreadsheet ....... ... .. ... . .. . i i A-87
Account Summary Week Spreadsheet .......... ... ... . A-88
Account Summary YTD Spreadsheet .......... ... .. ... . i A-89
Account Summary YTD by Rate Spreadsheet ........... .. ... ... . ... ... .. A-90
Account Summary YTD Cost by Rate Group Spreadsheet .............................. A-91
Crosstab RePOIES .. .ovueieiiii ittt ittt iiiiirititiasteassasnssnssnsensnscnnens A-92
Daily Crosstab—Charges . ...... ... i A-92
Daily Crosstab—Usage .. ... ... A-93
Detail by Identifier Crosstab .. ........ ... . A-94
Detail by Identifier by Date Crosstab .......... ... ... . i A-95
Monthly Crosstab—Charges ... ...... ... ottt i A-96
Monthly Crosstab—Usage ............. . i A-97
Ssummary Crosstab—Charges . ... ...ttt A-98
Summary by Rate Group Crosstab—Charges .............. ittt A-99
summary Crosstab—Usage . ........... . i A-100
Summary by Rate Group Crosstab—Usage .......... ... ... A-101
WeeKly Crosstab—Charges ......... ... A-102
WeeKIly Crosstab—USage . . ... ...t e A-103
=) 18] 5] = 1 (< A-104
Report Both Template . . ... . A-104
Report Cost Template . . ... ... i e e e A-106
Report Resource Template . ... .. i A-107
Spreadsheet Both Template . .......... .. A-107
Spreadsheets Cost Template .......... ... . i i A-109
Spreadsheets Resource Template ............ ... ... A-110
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About CIMS Server Reports

CIMS Server produces chargeback and resource accounting reports based on IT usage
data from your organization. To help you to easily create reports that display the
information that you need, CIMS Server includes a variety of standard reports that you
can use as templates. Standard reports are available as . rpt files for Crystal Reports and
.rd1 files for SQL Server Reporting Services.

This appendix provides a description of each standard report with the exception of CIMS
Advanced Spreadsheets, which are described in Standard Advanced Spreadsheet
Descriptions on page 4-14. The reports examples shown in this appendix reflect Crystal
Reports; however, the same data would appear in a Reporting Services report.

For more information about the different types of reports available, see Introduction to
Report Types on page 2-2.

Location of CIMS Server Reports

If CIMS Server was installed in the default location, reports are located in the following
folders. Each of these folders contains the subfolders Standard, Custom, and Published.
For example, ReportsMSRS\Standard, ReportsMSRS\Custom, and ReportsMSRS\ Published.

Crystal Reports

m C:\Program Files\CIMSLab\Server\Reports85 (contains Crystal 8.5 reports for SQL
Server only)

®m ...\ReportsORADBZ (contains Crystal reports for Oracle and DB2)

m ...\ReportsSQL (contains Crystal reports for SQL Server)

SQL Server Reporting Services Reports
m C:\Program Files\CIMSLab\Server\ReportsMSRS

CIMS Advanced Spreadsheets
m C:\Program Files\CIMSLab\Server\AdvSpreadsheets

To use CIMS Advanced Spreadsheets, the spreadsheets must be copied from the
AdvSpreadsheets folder to the folder that contains the Crystal or Reporting Services
reports. For more information, refer to the CIMS Server Administrator’s Guide.

How CIMS Server Web Reporting Determines the Report Folder
to Use

The folder that is used for Web reporting is determined when the CIMS Server database
is initialized. Database initialization is performed as part of the CIMS Server set up
process. For more information about initializing the database and selecting the report
folder, refer to the CIMS Server Administrator’s Guide.
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Report Naming Conventions

The following is the file naming convention for the CIMS Server standard reports for
Crystal Reports and SQL Server Reporting Services:

Character 1 The type of report: (G)raph, (I)Drill down, (R)eport, (S)preadsheet,
(X)Crosstab

Character 2,3,4  Description of report (if template, TMP)

Character 5 Function of report: (R)esource, (C)ost, (B)oth, (U)ser, (X)Other

Note: With the exception of the Job Cost Report, all cost (C) reports
reflect data in the CIMSSummary table.

Character 6,7,8  Numbering sequence for reports of the same type (for example,
invoice, budget, trend)

For example, the file name RBGTCO01 represents the following:

R = Report

BGT = Budget

C = Cost

001 = Report number

Conventions Used in This Appendix

The reports listed in this appendix are grouped by type (graphs, drill down reports,
reports, spreadsheets, crosstab reports, and templates) and are presented in alphabetical
order by file name.

Each report includes a description with the following information:
File name. The name of the report file.

Stored Procedure. The stored procedure used for the report (if applicable). A stored
procedure is a set of SQL statements that can perform both queries and actions that allow
the system to generate reports.

Drill down. The drill down features for the report (if applicable).

Parameters. The parameters for the report such as starting and ending account codes,
account code level, and from and to dates. For a description of these parameters, see
Using Report Parameters on page 2-4.
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Reports by File Name

For easy reference, the following lists each standard report by file name and provides the
page number where you can find the report description. Reports that begin with RTMP or
STMP are report templates, which are in the . ..Standard/Templates folder.

B A-6

GTRDCOO1 page A-8

GTRDCO0Z2 page A-9

GTRDROO1 page A-10
TINXCO01 page A-11
[INXC002 page A-13
[INXCO04 page A-14
TINXCOO5 page A-16
[INXCO06 page A-17
RACLX001 page A-19
RARTX001 page A-21
RATRX001 page A-23
RBATRO01 page A-24
RBGTCO01 page A-25
RBGTCO02 page A-26
RCFGX001 page A-27
RCICRO01 page A-28
RCLTX001 page A-29

RDAYCOO1 page A-30
RDAYC002 page A-31
RDB2RO01 page A-32
RDETROOI page A-33
RDETRO0Z page A-34
RDRIROO0I page A-35
RDRIR00Z page A-36
REX2R001 page A-37
RINVCOOI page A-38
RINVCO0Z page A-38
RINVCOO03 page A-40
RINVCO04 page A-41

RINVCO06 page A-43
RINVCOQ7 page A-45

RINVCO09 page A-47
RIVTCOOI page A-49
RIVTCO0Z page A-50
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RIVTCOO3 page A-51
RIVTCO04 page A-52
RIVZCOO1 page A-53
RIVZCO0Z page A-55
RJOBCOO1 page A-56
RMS2R001 page A-58
RPERX001 page A-59
RRATX001 page A-60

RTMPBOO1 page A-104
RTMPCO01 page A-106
RTMPRO01 page A-107

RTOPCOO1 page A-61
RTOPCO0Z page A-63
RTOPCO03 page A-65
RTOPCO04 page A-67
RTRDCOO1 page A-68
RTRDCO0Z page A-69
RTRDROOI page A-70
RTRNXOO1 page A-71
RVARCO01 page A-72
RVARCO0Z page A-73
RVARROOI page A-74
RWDKROO1 page A-75
RWEKCOO1 page A-76
RWEKCO0Z page A-77
RYTDCO01 page A-78
RYTDCOOZ page A-79

CIMS Server Web Reporting User’s Guide

SINVCOO1 page A-80
SINVCO0Z page A-81
SINVCO03 page A-82
SINVCO04 page A-83
SPERX001 page A-84
SPERX002 page A-85
SPERX003 page A-86
STMPB0O01 page A-107
STMPCO01 page A-109
STMPROO1 page A-110
STOPCO04 page A-87
SWEKCO01 page A-88
SYTDCOO01 page A-89
SYTDCO0Z page A-90
SYTDCOO03 page A-91
XDAYCO01 page A-92
XDAYROO1 page A-93
XDETROO1 page A-94
XDETR002 page A-95
XMONCOO1 page A-96
XMONROO1 page A-97
XSUMCO01 page A-98
XSUMC002 page A-99
XSUMR0O01 page A-100
XSUMR002 page A-101
XWEKCO01 page A-102
XWEKROO1 page A-103
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Graphs

Cost Trend—Accounts Graph
File name: GTRDCO01

Stored Procedure: CIMSSP_Summary_Month

This graph report provides the total charges for all account codes for each month for the
parameters selected followed by charges for individual account codes for each month.

Drill down: None

Parameters:

B Report Year

m Account Code Level

m Starting and Ending Account Code

Report Example

2 CIMS Server - Microsoft Internet Explorer,
File Edit View Favorites Tools  Help

Qs © ) [B) ] Pooer sl @ @ @3- B B

Publish

= 1R e N B

Preview |

PoH e 8

Return

IM5 Lab, Inc. Laurs!
TM5 Lab, Inic. Inkernational
- CIMS Lab, Inc. Services

Cost Trend
Af - CIMS Lab, Inc. Roseville

For 2003

Cost per Month

January February March Aol

Month

505,828 55

June

W January
W February

&) Done

B Internet

Figure A-1 + Cost Trend—Accounts Graph Example

B A-8
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Cost Trend—Rates Graph
File name: GTRDC002
Stored Procedure: CIMSSP_Summary_Month

This graph report provides the total charges for all rate codes for each month for the
parameters selected followed by charges for individual rate codes for each month.

Drill down: None

Parameters:

B Report Year

m Starting and Ending Account Code

Report Example

2l CIMS Server - Microsoft Internet Explorer

Fle Edit Wew Favortes Tooks Help aw

Qe - O B @ @ pSearch ‘*Favuntes @ redia ) @v ;Q; B-)3

Cost Trend Graph 2 Publish Return

| &&=z =] || 44 7 ofiie bW s
Preview

05/390 Jobs Started |
©5(390 Steps Started |
©5/30 Cpu Minutes
©5/330 Cpu Minutes (Initi
05330 Cpu Minutes (Al)

5 Cpu Minutes

Tso Connect Minutes

Tsa Inputs

Tso Qutputs L
Tso Cpu Minutes (Teb)

Tso Cpu Minutes (Initiater)
Tso Cpu Minutes (Al
Total 5108

Disk 5105

Tape 510s

3390 510

3380 510's

3375 510

3480 510's

3420 510's

Wirtus] SI0's

Input Records

Tape Mounts

Disk Data Sets

DBZ Transactions (Recards
DBZ Transaction Cpu Minut
DBZ Transaction Elapsed I
DBZ 1O Activity (Gt Page
MS Windows Oracle logins
MS Windows Oracls sessio ™ |

< il I =]

[

Cost Trend

Tso Cpu Minutes For 2003

Cost per Month

1200

1000

B January
W Fewruary
O mareh

January Fabiuary areh Aaril My June

&) Dane B Internet

Figure A-2 + Cost Trend—Rates Graph Example
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Resource Trend Graph

File name: GTRDR0OO1

Stored Procedure: CIMSSP_Summary_Month

This graph report provides the total resource usage for all rate codes for each month for
the parameters selected followed by resource usage for individual rate codes for each

month.
Drill down: None

Parameters:

m Report Year

m Starting and Ending Account Code

Report Example

2 CIMS Server - Microsoft Internet Explorer

Filg Edit Wiew Favorites Tools  Help

@rac - ()

|ﬂ @ 1) /'? Search 57 Favoritss @ Media £2) - &

Usage Trend Graph

& &=[mr <~

Preview |

Address | @] httpsjvmw. cimsserver, comjreptexec. asp?

countCodeStart=-+Exbofccount CodeStart=-+EAccount CodeEnd=azzzzzzazeticbofccont CodeEnd=zazezezzazis v | [ G Links

4 4 51 of 53+ F M

Publish Return Help ]

M5 Windows SOL Server R A
M5 Windaws SOL Server %
115 FTP Successful Frotoco
115 FTP Redirection Protoc:
115 FTP Clienkt Error Protoc
115 FTP Server Error Protor
celvad

nt
115 Web Successful Protoc
115 Web Redirsction Protoc
115 Web Client Error Protoc
115 Web Server Error Prote
115 Web Time taken
M5 Windows Disk Size in M
M5 Windows Humber of Fil
M5 Exchangs Bytes Sent
M5 Exchange Emails Sent
M5 Exchangs Bytes Recsiv
M5 Exchangs Emails Receh
M5 Windows Elapsed Tims
M5 Windows CPU Time ins
M5 Windows Kernel CPU Ti
M5 Windows User CPL Tim
M5 Windows Read Reques
M5 Windows KB Read
M5 Windows KB Wiritten
M5 Windows Writs Reques
Uribe disk 1/
Unic charactsr 1/
Unibe imags time

%

T

[

[T

Resource Trend
115 Web Bytes Sent

For 2003

Resource Usage per Month

B January
I Feuruary

Januay Fanruary maren Agfil

Month

May June

Resource Usage
—

140,235,845

(I3

1E3]

&) Dane

& Internet

Figure A-3 + Resource Trend Graph Example
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CIMS Server Web Reporting User’s Guide



Standard Reports H

Drill Down Reports

Drill down reports enable you to view a breakdown of resource units by an identifier or
identifiers. Drill down reports are invoked from other reports and cannot be run
independently.

Invoice Drill Down for Rate Group Report
File name: I1INXC001
Stored Procedure: CIMSSP_Dril1down_by_RateGroup

This report enables drill down of the charges for a rate group by identifier name. For
example, the report in Figure A-4 on page A-12 provides a drill down of a rate group for
charges associated with the identifier name Jobname. Charges for each rate code within
the rate group are broken down by the identifier values for Jobname.

This report invokes from the following reports.

m Invoice with Budgets (see page A-41)

m Invoice (see page A-43)

m Invoice by Account Level or Invoice by Account Level V2 (see page A-45)
m Invoice with Shifts (see page A-47)

m Zero Cost Center Invoice (see page A-53)

Drill down: None

Parameters:

m Identifier name

m All other parameters are supplied by the invoice report
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B A-12

Report Example

A CIMS Server - Microsoft Internet Explorer

File Edit Wiew Favorites Tools  Help

Q- O[] B & ) search Sl Favertes ) [+ :; = [ i B A

Address|@ http:jflacalhostiDemojcrystalReportsInteractiveviswer2, sp v Beo @
Publish Return Help s
= M wn LU ® M B @D oRet
Mainframe Tso for CCX-Credit Card by Jobname
Date Range: 11/1/2004 to 11/30/2004
3 T3-Ts0 Cpu Minutes [i5-Ts0 C [i6-Tso Inputs T6-Ts0 Ouiputs -T50 Cpu Minutes
obname Initiator)
LASS00 2.20) 493.19) 2,02
LASS0T 158 1,018.66] 4,192
LASS0Z 2.47] 700,10 450 L
LASS03 1.18] L017.79] 2,00
LASS04 1.16] 736.50) 2,046
LASS05 135 963.61] 4771
LASS06 2.0 95.19) 4,119
LASS07 157] 906.44) 3,848
LASS08 1.01] L004.74) 1731
LAS500 0.58] 436,34 952
LASSI0 123 713,97 2.z4d
LASS11 0.12| 5.02| [
LASS1Z 1.56] 932,69 2,145
P390A .01 .29 1
P3908 2.4z 2,074.61] 3,027
3900 0.03] 0.74) 11
Ml
. L)
&) Dane % Local intranet

Figure A-4  Invoice Drill Down for Rate Group Report Example
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Invoice Drill Down for Rate Group by Date Report

File name: IINXC002

Stored Procedure: CIMSSP_Drilldown_by_RateGroup_Date

This report is similar to the Invoice Drill Down for Rate Group report (see page A-11).
However, it also provides a breakdown of the data by date.

Drill down: None
Parameters:

m Identifier name

m All other parameters are supplied by the invoice report

Report Example

<3 CIMS Server - Microsoft Internet Explorer
File Edt Wiew Favortes Tooks  Help

@Back -0 Iﬂ IELI 3 /Ij\JSEarch 7 Favorites 462 =

BEE
..l:

adress [{€] httpijjlocahostjDemoferystalReportsinteractiveliewer2 asp

len @

&) Dane
—

I Publish Return Help L
= N as LU 21 @ o @ e
. =
Mainframe Tso for CCX-Credit Card by Jobname

Date Range: 11/1/2004 to 11/30/2004

FPT— [[3-Teo Cpu Minutes i5-Teo T [6-Teo Inputs [6-Teo Quiputs

LASS00 [11/8,/2004 0.07| 11.24 32| *
[Ti7972004 0.19 67.51] 227 25t
1171072004 0.9 216.77] 831 870
171172009 0.18) 148.15] 250) B
[ii71272009 1.30) 49,57 653 7
[Total 2.20) 493,19 2,023 223

LASS01 [11/8,/2004 0.22| 45.34 321 360
[Ti7972004 0.47] 254.30) 1,289 1,36¢
[ii710,2009 .64 326.96] 1,921 2,08
171172009 .29 392.05] 661 7L
[Total 158 1,018.66] 4,197 452

LASS02 [11/8,/2004 0.12| 6.64 102| 130
[Ti7972004 0.7 283.20) 1,605] 1,688
[ii710,2009 1.24) 307.61] 2277 2,42t
171172004 0.23] 253.81] B 48
[ii71272009 .09 36,54 73 (]
[Total 2.47] 988,10 4503 281

LASS03 [11/8,/2004 0.08| +.23 74 9
117972004 0.2 270.87] 839 ke

< »

% Local intranet

Figure A-5 « Invoice Drill Down for Rate Group by Date Report Example
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Invoice Drill Down for Units Report

B A-14

File name: IINXC004

Stored Procedure: CIMSSP_Drilldown_by_Rate

This report enables drill down of resource units by identifier name. For example, the
report in Figure A-6 on page A-15 provides a drill down of resource units for the units
associated with the identifier name Jobname. Units are broken down by the identifier
values for Jobname.

This report invokes from the following reports.

Alternate Invoice (see page A-38)

Invoice with Budgets (see page A-41)

Invoice (see page A-43)

Invoice by Account Level or Invoice by Account Level V2 (see page A-45)
Invoice with Shifts (see page A-47)

Run Total Invoice 2 (see page A-52)

Zero Cost Center Invoice (see page A-53)

Drill down: None

Parameters:

Identifier name

All other parameters are supplied by the invoice report
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Report Example

2 CIMS Server - Microsoft Internet Explorer

Filz Edt Wew Favortes Tools  Help o
AL O 5 2)
> |ﬂ @ ) ) search ) pravories @ veda )
i ry. asp?Identii bnametsUb i
Invoice by Account Level Return
& &[0z~ [ 1 o1+ b oM ih
Preview |
—
08/290 Cpu Minutes for AA - CIMS Lab, Inc. Roseville
From 6/1/2002 to 6/20/2003
Jobname Units
ABCODZ 0.03
ABCO16 104
ABCO30 9,85
ABCD37 4,49
ABCOBE 56.51
ABC140 0.45
ABCISOD 0.28
ABCLSOS 0.29
ABCAUDIT 0.04
ABCDLYBK 833
ABCFTPOL 0.02
ABCFTPOZ 0.02
ABCIHOOL 136
ABCINFOL 0.0
ABCUSZ1A 0.0
ABCU3ZLE 0.04
ABCUs22A 0.0 v
L]
&) Dane B Intemet

Figure A-6 + Invoice Drill Down for Units Report Example
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Invoice Drill Down for Units by Date Report

B A-16

File name: IINXC005

Stored Procedure: CIMSSP_Drilldown_by_Rate_Date

This report is similar to the Invoice Drill Down for Units report (see page A-14).
However, it also provides a breakdown of the data by date.

Drill

down: None

Parameters:

m Identifier name

m All other parameters are supplied by the invoice report

Report Example
-2 CIMS Server - Micrasoft Internet Explorer, E‘@l@‘
Fle Edt Wew Favortes Tooks Help I
A& A >3 B g
Qe - © |ﬂ @ ) I seach 5 pravories @Preda @) (- Az )3
address | &) http: ffwww.cimsserver, comffsscondary  aspPldentifier—4-JobnameGDriDownDet ail=YE Sasubrrit x=27asUbrit.y=12 .Gu Links
I Invoice by Account Level Publish Return Help e |
& &[0z~ [ 1 of 1+ (] b .
Preview |
a
08/3290 Cpu Minutes for AA - CIMS Lab, Inc. Roseville
From 6/1/2002 to 6/20/2003
Jobname Units
DATE
ABCOD2
6/2/2003 0.03
Total for: ABCODZ 0.03
ABCO16
5/30/2003 0.20
6/2/2003 021
6/3/2003 021
6/5/2003 021
6/6/2003 0.21
Total for: ABCO16 104
ABCO30
5/30/2003 0.40
6/2/2003 2,20
6/3/2003 2,67
6/4/2003 0.60 v
b
&) Dane B Internet

Figure A-7 + Invoice Drill Down for Units by Date Report Example
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Multilevel Drill Down for Units Report
File name: IINXC006
Stored Procedure: CIMSSP_Drilldown_3D

This report enables drill down of resource units by up to five identifier names. For
example, the report in Figure A-8 on page A-18 provides a drill down of resource units
by the identifier values associated with the identifier names System ID, Jobname, and
Work ID.

To enable this report, the report file name IINXC006 must be entered in the Configuration
dialog box in CIMS Server Administrator (refer to the CIMS Server Administrator’s Guide).
If this option is not set, the Invoice Drill Down for Rate or Invoice Drill Down for Rate
by Date report is invoked.

This report invokes from the following reports.
m Alternate Invoice (see page A-38)

m Invoice with Budgets (see page A-41)

m Invoice (see page A-43)

m Invoice by Account Level or Invoice by Account Level V2 (see page A-45)
m Invoice with Shifts (see page A-47)

m Zero Cost Center Invoice (see page A-53).
Drill down: None

Parameters:

m Identifier name 1

m Identifier name 2

m Identifier name 3

m Identifier name 4

m Identifier name 5

m All other parameters are supplied by the invoice report

CIMS Server Web Reporting User’s Guide A-17 N



B Standard Reports

Report Example

2l CIMS Server - Microsoft Internet Explorer ;
File Edt Wew Favortes Tools Help L7
- vy s R -
Qo= © [ (&) & P Soroons @ 3- 055 [ B A-
Address [ €] bttpijlocahostiDemofcrystalReportsinteractiveviswer2 asp v B @
I Publish Return Help o
Pl R R . S — e G
CIMS F-
A I N
Invoice Drilldown
CCX - Credit Card
Pages Printed - Local
Date Range: 11/1/2004 to 11/30/2004
System 1D
Jobname
Work 1D
8YS2
ARDIDALY
oooz 120
ARDIDALY 120
ARLIDALY
oooz 144
ARLIDALY 144
DIBA
oooz 552
DIeA 552
8YS2 816
v
&) Dane %) Local intranet

Figure A-8 + Multilevel Drill Down for Units Report Example
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Reports

Client Audit Report
File name: RACLX001
Stored Procedure: CIMSSP_AuditClient
This report tracks changes to the CIMSClient table and contains the following:
m Date and time the change was made
m The type of change that was made:
e U = update to existing data
e [ =addition of new data
e D =deletion of data
m Windows user ID
m Client account code
® Old account name (if applicable)
m New account name (if applicable)
Drill down: None
Parameters:
m From and To Date

m Audit Type
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Report Example

2 CIMS Server - Microsoft Internet Explorer,

File Edit View Favorites Tools  Help

Qe - O \ﬂ @ {h ) search ‘*Favnmtas @ redn 2

acidress | @] hitpflocalhostreptexer. aspiRange=180 %42F1%2F19988FromDate=1 1-018fromManth=1&fromDay=1&fromyear=199830ateEnd=12%2F31%2F2004; ¥ ﬂGn Links >
Client Audit Report Publish Return
& @ o Lo >y o || o4 | B
Preview |
-
Client Audit Report
Date/Time Changed  Type UserID Account Code OM Account Name New Account Name
1052003 3:5503FM D CIMSL&BDebora uu Security
1092002 3:5432FM U CIMSLABRDebora A4DDDD Administration Department 14
1052003 3:54123PM 1 CIMSL&BDebora A£4DDDD
1092002 3:5402FM U CIMSLABRDebora Ak Administration Administration Site &
L]
&) @ |
b
€] Done % Local intranet

Figure A-9 + Client Audit Report Example
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Rate Audit Report
File name: RARTX001
Stored Procedure: CIMSSP_AuditRate
This report tracks changes to the CIMSRate table and contains the following:
m Date and time the change was made
m The type of change that was made:
e U = update to existing data
e [ =addition of new data
e D =deletion of data
® Windows user ID
m Rate code
m Old and new rate value
m Old and new rate per resource unit or per thousand unit indicator:
e M (Per thousand units)
e Blank (Per unit)
m Old and new resource conversion factor:
e 1 (Divide total resource value by 60)
e 2 (Divide total resource value by 3600)
e 3 (Divide total resource value by 1000)
e 4 (Multiply total resource value by 60)
e 5 (Divide total resource value by 60000)
et (Multiple total resource value by user-defined number)
e Blank (No conversion factor)
m Old and new zero cost indicator:
* N (The rate will not be included in zero cost calculations)
e Blank (The rate will be included in zero cost calculations)

Drill down: None
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Parameters:

m From and To Date
m Rate Code

m Audit Type

Report Example

2 CIMS Server - Microsoft Internet Explorer,

File Edit View Favorites Tools  Help

Qe - O \ﬂ @ /h ;‘J Search \:,[\L(Favw\tes @ e £ (- ;. B3

address | @] hittp flocalhost reptexec  sspRange=1 BDateStart=1 %2F 1 %2F 1 99B&F romDate=1 996-01-01&fromMonth=16fromDay =1 BfromVear—19988DateEnd=12%2F 31 %zFzon4 ¥ | [Ed 6o Liks ™

Rate Audit Report Publish Return

(% & @ WA Lot »ob o || ok | =B

Preview |

Rate Audit Report

Raie Yalue Per Thou  Res Comv Zero Cost
Date/Time Changed  Type UserID Rate Code oM New OM New OM New OM New

1092003 4:2636FM U CIMSLABDeborah -TECH 5000

10/9i200%  4:26:16F I

CIMSLABDeborah -TECH

10072003 42508FM D CIMSLAB\Deborah LLY208 0.00
100972003 424:44FM U CIMSLAB\Deborah Z001 250 3.50
L
] 3 |8
bl
Ig Done % Local intranet

Figure A-10 + Rate Audit Report Example
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Standard Reports H

Transaction Audit Report
File name: RATRX001
Stored Procedure: CIMSSP_AuditTransaction

This report tracks changes to the CIMSTransaction table and contains the following:

Date and time the change was made

The type of change that was made:

e U = update to existing data or transaction marked as deleted

e [ =addition of new data

User ID (usually the Windows user ID or SQL Server user ID)

Account code

Old and new rate code

Old and new amount
Drill down: None
Parameters:

®m From and To Date

m Audit Type

Report Example

<2 CIMS Server - Microsoft Internet Explorer EE'E‘
File Edit View Favorites Tools  Help #

Qe - © ¥ @ @ ) search ¢ Favories @ ede 2 - ; L3

adldress | @] hittpffvoni-webtestz{reptexec. asp?R ange=5aDateStark=10%2F L % 2F 20038FromDake=101%2F 1 %2F 20038 romMonth=106fromDay =1 BfromVear—20038DateEnd—10%: | [Ed 6o Liks

trans audit Publish Return Help e
= | [ T oft #h .
Preview |
i
Transaction Audit Report
Date/Time Changed ~ Type UserID Account Code  OM Rate Code New Rate Code OM Amount New Amount
100072003 12:07:23PH 1 54 AA EZMONEY 5000.00
100072003 12:01:02PH O 54 DDWWWWGLA Z016 Z016 5000 é0.00
L
L 3
L]
&) Done % Local intranet
-

Figure A-11 + Transaction Audit Report Example
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B Standard Reports

Batch Report
File name: RBATR001
Stored Procedure: CIMSSP_Batch

This report provides OS/390 batch job data for the parameters selected. This data is taken
from the CIMSDetail table.

Drill down: None

Parameters:

m Account Code Level

m Starting and Ending Account Code

®m From and To Date

Report Example

A CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools Help ]
Qe - O \ﬂ @ ) ) search g ravories @ medis €2) 3
Address | ] hitp: | fuwaw, cimsserver.comreptexec. asp?Invaicel evel=1&Accaunt CodeStart=+acboAccount Codestart countCad: 22zzz2z28boAccountCadzE; E Links
Batch Report Publish Return Help )
& & 7=l ~ 1 of 1+ > M h .
Preview |
# ABCD16-JESZ A -
# ABCD30-JESZ
- ABCD37-JESZ T
-
# ABCDEE-JESZ
# ABC140-JESZ H
i AocIn0D o2 Resource Report in Job Name Sequence
 ABCISS-JESZ
1 ABCAUDIT-JES2 Account Range: All
! ABCOLVBK-JESZ Date Range: 6/1/2003 to 6/30/2003
# ABCFTPOI-JES2 cPu CPU (INIT) CPU (ALL)
5 ABCFTPOZ-JESZ JOB NAME  SUB-ID ACCOUNT J0BS  STEPS s555.55 s555.55 555.55 DISK 510
# ABCIHOOL-JES2
[l ABCINFOL-JESZ ABCOOZ JESZ A 1 2 184 0.04 209 9,
[+l ABCU3Z1A-JES2 ABCOLE JESZ A 4 192 50.28 6,57 5820 45,8
 ABCU321B-JES2 ABCO30 JES2 A 2 261 567.06 7.55 664.73 3,417,¢
[+l ABCU322A-JES2 RBCO37 JESZ A q 2 226,25 273 245,65 475,
[£}- ABCUZ228-JES2 RBCOBE JEsz | AA 5 185 Z,525.65 426 7,954, 50 4,203,¢
[£1- ABCUZ234A-DES2 ABC140 JESZ AA 1 21 26,94 0.76 30.05 13,0
[l- ABCUZ238-JES2 ABC150D JESZ AA 1 58 16,74 159 20,97 108,
(- ABCUZ244-JES2 ABC1505 JESZ AA 1 61 17.43 173 2167 108,
'+ ABCU3Z4E-JES2 ABCAUDIT  JESZ A4 4 32 179 102 200 E
'+ ABCU3ZSA-JES2 ABCDLYBK  JESZ A4 1 1 423,28 0.0 46110 0,8
'+ ABCU32SE-JES2 ABCFTPOL JESZ AA H H 079 019 104
'+ ABCU46LA-JES2 ABCFTPIZ JESZ AA H H 0.63 016 104 F
"+ ABCU461E-JES2 ABCIHODL  JESZ AA 5 5 68.12 0.58 69.12 1,8
ABCUATLA-JES ABCINFOL  JESZ  AA 5 54 2.86 2.52 5.48 :
* ::Eﬂ:;;iﬁi ABCUZIA  JESZ AA 1 7 034 0.20 0.55 3
H -
" e oz sass sz s Lo 22 13 i i
 ABCL4BLA-JES2 CANES] 3 |0
v
&) Done @ Internet
=

Figure A-12 « Batch Report Example
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Standard Reports H

Account Budget for Period and YTD Report
File name: RBGTC0O01
Stored Procedure: None

This report provides actual, budget, and difference charges by account code for the
parameters selected. This report includes totals for the calendar period selected and year
to date (YID).

This report reflects the amount for the Overall Account Budget for the account code as
set in the CIMSClientBudget table. For more information about setting budgets, refer to
the CIMS Server Administrator’s Guide.

Drill down: None

Parameters:

m Starting and Ending Account Code
m Account Code Level

m Calendar Period

Report Example

2 CIMS Server - Microsoft Internet Explorer

Fle Edt View Favorites Tools Help o
Qe - ) (%] B G0 POseach §'¢raaies @Preda §2) - g 3
</ ~ Tl | /- P J =
ddress ] hittps v, cimsser ver, comjrephees, sSpPACCOUREC oSt art =+ A oUnkC e Start—+ACtoUnt CodeEnd. boAceountCodsEnd nvolcelevel=\v| B Go | Liks
~
Account Budget for Period ¥TD Publish Return Help
& &% - T oft dh .
Preview |
—~
Account Budget for Period and YTD
From: 06/01/200% o D6/30/2003 YTD
AccauntCode Actual Budget Difference Actual Budget Difference
AA-CIMS Lab, Inc, Roseville
s1,003.58 s5.333.33 77274 s21,065.65 5000000 17106565
BB-CIMS Lab, Inc, Gibbsbore
818874 2s.000.00 ttem T 235, 437.83 150,000.00 g3,437.83
GC-CIMS Lab, Inc. Laurel
ss.15488 50,000.00 -5 194,65 385,053.54 300,000.00 9308384
DD-CIMS Lab, Inc, International
10,6378 10,000.00 3378 ssevzas 50,000.00 a1z7.82
EE-CIMS Lab, Inc, Services
1110930 16,055.67 s497.37 szast60 100,000.00 476432
Grand Total 15517007 160,000.00 4,829.93 1,257.811.18 260,000.00 -237.811.18
v
~
&) Done ® Internet
L

Figure A-13 + Account Budget for Period and YTD Report Example
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B Standard Reports

Line Item Budget for Period and YTD Report
File name: RBGTC002

Stored Procedure: CIMSSP_LineItem Budget

This report provides actual, budget, and difference charges by account code, rate group
and rate code description for the parameters selected. This report includes totals for the

calendar period selected and YTD.

This report reflects the amount for the individual resource budgets for the account code
as set in the CIMSClientBudget table. For more information about setting budgets, refer

to the CIMS Server Administrator’s Guide.
Drill down: None

Parameters:

m Account Code Level

m Calendar Period

m Starting and Ending Account Code

Report Example
2 CIMS Server, - Microsoft Internet Explorer E@
Fle Edt View Favortes Toos Help o
o ) Al © < o 23
Qe - O - ¥ B G| P § = 3
address (] hktp:fum,cimsserver.comjreptescec. ssprInvoicel svel=1 &-VearPeriodStart=2003%2F8RAccoUnt CodesStart=-+irbofceountCodeStart=+ccountCodeEnd=zezzzzzezatic ¥ | g G0 Links
Line Item Budget Publish Return Help L/
& & =[x = T of 1+ » M & =
Preview |
—
From: 06/01/2003 to 06/30/2003 YTD
Account Actual Budget Difference Actual Budget Differt
AA-CIMS Lab, Inc. Roseville
DB2 Transactions (Retords)
0.26 125 0.99 2,86 7.50
DB2 Transaction Elapsed Minutes
0.04 0.83 0.73 0.57 5.00
057390 DB2
0.30 2.08 1.78 3.43 12.50
Unix disk O
451 208 -2.43 432,44 12,50
Unix character VO
0.03 167 L4 278 10.00
Unix image time
167.05 208,33 4128 250,43 1,250.00
Unix connect time
3519 25.00 -10.19 157.20 150,00
Unix user CPU
0.18 167 149 890 10.00 v
< | 3 &
s
&) Done B Intemet
=

Figure A-14 - Line Item Budget for Period and YTD Report Example
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Standard Reports H

Configuration Report
File name: RCFGX001

Stored procedure: None

This report provides information contained in the CIMSConfig table.

Drill down: None

Parameters: None

Report Example

2} CIMS Server - Microsoft Internet Explorer
File Edt Wew Faworites Tools  Help

Q- (¢ [@ & ) search ¢ Favories @ mede €2 K- =N

P 3

Address | @] http:jjwn.cimsserver. comjreptexec. aspireport= onfiguratior FHO01L.Fpt

I Configuration Publish Return

& & [ix ~| [ 1 of1 b

Preview |

Help

B

Links **

CIMS _.
Configuration Report

Organization:
Big Time Company
Corporate Headguarters
3013 Douglas Blvd.
Suite 120
Roseville, CA 95661

Invaoicing:

MNext Invoice Number 97
Invoice Mumber Type 1

Directories:

ChWProgram Filesh\CIMSLabhServersReportshStandardy,
C:hWProgram Files\CIMSLabhServeryReportsiCustomy,
C:hProgram Files\CIMSLabhServeryReportsyPublished,

Standard Reports
Custam Reports
Published Reports

(£

=3

&) Dane

B Internet

Figure A-15 + Configuration Report Example
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B Standard Reports

CICS Transaction Report
File name: RCICRO01
Stored Procedure: CIMSSP_CICS

This report provides data for CICS transactions by transaction ID for the parameters

selected. This data is taken from the CIMSDetail table.
Drill down: None

Parameters:

m Account Code Level

m Starting and Ending Account Code

m From and To Date

B Trans ID Start

m Trans ID End

Report Example

2 CIMS Server - Microsoft Internet Explorer

File Edt View Favortes Tools  Help o
> NG S .3 25
eﬁack ) \ﬂ @ ) ) search e ravories @ medis §2) =S 3
fcldress | €8] hitps s, cimsser ver. com/reptexet. aspPinvaicel evel=1 B ccount CodeStart=-+ &cboActount CodeStart countCodeEnd=zzzezzezaztbofecountCodeEnd=zzzzzzez: ¥ | g G0 Links >
CICS Transaction ID Report Publish Return Help =
& & g oz~ 1 of 1+ > oM h .
Preview |
3 A‘
+8j2003
< 1oamm: CIMS
Account Range: All
Date Range: 1/1/1998 to 1273172004
TRANS cPU TERMINAL TERMI
TRAN TIME TIME INPUTS ouTeP
1) Account Code DATE COUNT  _S5555.55555 99555.59559
CESF A 3142003 6 0.03299 002636 6
CESF BB 73142003 z 0.00953 0.00842 H
CESF  cC 7/31/2003 & 0.09227 003011 6
CESF 312003 13 0.13479 0.06483 14
CESF 14 0.13479 0.06489 14
CESN  AA 73142003 50 311549 0.58108 50
CESN 312003 50 511549 058103 50
CESN 50 3.11549 0.58109 50
CESS  C 3142003 1 0.00357 000234 1
CESS T3 200E 1 000357 000254 1
CESS 1 0.00397 0.00294 1 3
<)) |-
™
&) Dane 4 Internet

Figure A-16 + CICS Transaction Report Example
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Standard Reports H

Client Report
File name: RCLTX001

Stored procedure: None

This report provides the information contained in the CIMSClient table for the

parameters selected.
Drill down: None

Parameters:

m Starting and Ending Account Code

Report Example

<3 CIMS Server - Microsoft Internet Explorer

e

Filz Edt Wew Favortes Tools  Help a
Qe - () [H] [F] (D DOsearch Fpreornss @Pvede €2 (- L 3
fdldres | €] hiep: ffwww, dimsserver, comfreptexec, asprAccountCadeStart=+ xbofccountCodeStart=+ Account CodeEnd=zzezzezazzicbodccount CodeEnd=zezzez: v | [Eg G0 Links >
I Client Publish Return Help e
& & [z | [ 1 of 1+ > oM & .
Previen |
—~
AA - CIMS Lab, Inc. Roseville
Contact: CIMS Lab administrator
Department: Administration
Office: Main Office
Address: 3013 Douglas Boulevard, Suite 120
Roseville, CA 95661-3842
EMAILL: irfomcimslab. corn
FAX1: (916) 783-2090
FAXZ:
IPPHONE1:
MOBILEPHONE1:
PAGERL:
VOICEL: (916) 783-8525
VOICEZ: (800) 283-4267
WEBURLL:
AAAAAA - Roseville - CIMS Lab Administration
v
v
&) Dane # Internet

Figure A-17 + Client Report Example
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B Standard Reports

Account Summary Daily Report

B A-30

File name: RDAYC001

Stored Procedure: CIMSSP_Summary_Day

This report provides total daily and monthly charges by account code and rate code

description for the parameters selected.

Drill down:

m Double-click a day or the charge for a day and a breakdown of charges by rate code

description for the day appears.

Parameters:
B Account Code Level

m Starting and Ending Account Code

m From and To Date

Report Example
72 CIMS Server, - Microsoft Internet Explorer, ;
File Edt View Favorites Toos Help o
Q- © ¥ @ % SO seach o ravories @ eds ) - & 3
Address | @] http: ffum.cimsserver. com/reptese. ssprInvoicel svel=1BAceount CodeStart=-+&rboAccount CodeStart=+&AccountCodeEnd boAccountCodeEnd v B ks ?
Account Summary Daily Publish Return Help &
& &|7s 100z L] 2 ofs+ b oM i B
Preview |
: Lah, Inc.RnseviI Account Charde ~
% CIMS Lah, Inc. Laurel [BB - CIMS Lab, Inc. Gibbsboro |
% CIMS Lab, Inc. Inkernational
4 CIMS Lab, Tnc. Services June 2003
6/1/2003 281.89
6/2/2003 505.73
6/3/2003 4,490.40
6/4/2003 450,32
6/5/2003 723.18
6/6/2003 21%.36
6/7/2003 595.94
6/8/2003 676.89
6/9/2003 4,303.24
6/10/2003 2,432.10
6/11/2003 1,420.14
Total for June 2003 16,097.19
Total for BB - CIMS Lab, Inc. Gibbshoro 16,097.19
v
£ >
v
&) Dane B Internet

Figure A-18 + Account Summary Daily Report Example
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Account Summary Daily 2 Report
File name: RDAYC002
Stored Procedure: CIMSSP_Summary_Day

This report is similar to the Account Summary Daily report (see page A-30). However,
the month (rather than the account code) appears as the top level of the report.

Drill down:

m Double-click a day or the charge for a day and a breakdown of charges for the day by
account code appears. Double-click an account code and a breakdown of charges for
the day by rate code description appears.

Parameters:
B Account Code Level

m Starting and Ending Account Code

m From and To Date

Report Example
3 CIMS Server, - Microsoft Internet Explorer \ZHEWE\
File Edt ‘View Favorites Tools Help o
OBack -9 \ﬂ g" _;_‘, /r“Saarch ‘w_;‘_\‘\'.‘«:’Favthes @ reda £2) - 5 3
Address | &) hitp: | fuwaw, cimsserver.com|reptexec aspPInvaicel evel=1&Accaunt Codestart boaccountCodestart: countCodeEnd: boAccountCodeEnd ~ ﬂGn Links >
Account Summary Daily 2 Publish Return Help &
& &7 002 | [ 1 ooft 4 .
Preview |
o
=, ¥
cIMS
Account Summary By Day From: 6/1/2003 To: 6/30/2003
Month
Day Charge
June 2003 |
£/1/2003 SEILe0
6/2/2003 7,255.24
6/3/2003 10,586.16
6/4/2003 8,502.74
6/5/2003 9,898.59
6/6/2003 4,763.24
6/7/2003 8,661.15
6/8/2003 7,951.28
£/9/2003 11,785.33
6/10/2003 14,194.24
/11,2003 11,567, 44
Total for June 2003 100,767, 20
Report Total 100,767.20
v
< >
v
&) Dane # Internet

Figure A-19 + Account Summary Daily 2 Report Example
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B Standard Reports

DB2 Summary Report
File name: RDB2R001
Stored Procedure: CIMSSP_DB?

This report provides DB2 data for the parameters selected. This data is taken from the
CIMSDetail table.

Drill down: None

Parameters:

m Account Code Level

m Starting and Ending Account Code

®m From and To Date

Report Example

‘A CIMS Server - Microsoft Internet Explorer

File Edt View Favortes Toos Help a
- B | O Ao \ ] px
Q- ¥ S seach ¢ Favaries @ Meda 42) e B ] 3
DB2Z Summary Return -
| % & @i =] | u 4 & of 12+ PoHos | ‘ =
Preview |
= PT1L ~
[ 2
= PTaL
<em CIMS
i
Account Range: All
Date Range: 6/1/2003 to 6/30/2002
NUM OF TRANS ACCUM TRANS a
sYs DB2 cPU cPU ELAPSED ELZ
10 AUTHID PLANNAME ACCOUNT CODE TRANS TIME TIME TIME T
FTi1  ZEKEMTP  DSHBIND oD 13,604 2,551.68 1,176.39 7,326.68
FTIL  ZEKEMTF  DSHBIND 13,604 755168 1,176.39 3,326.68
PTLL ZEKEMTP 13,604 2,551.68 1,176.39 7,326.68
PT1L 24,261 3,820.32 1,428.10  66,709.14
PTzz  DCBATCH  DSHUTIL An 72 s0.92 000 280.08
P2z DCBATCH  DSWUTI 7z 0.9z [ 780.08
FT22  DCBATCH  PLCAPLAN A 8 1211 000 46,76
FTzz  DCBATCH  PLCAPLAN 8 1211 000 4576
PT22 DCBATCH 80 63.03 0.00 326.84
PTz2  DCC3ADM  DISTSERY BE 4,521 354,38 000 2,527.93 v
S ) a3 |&
b
&) Dane & Local intranet

Figure A-20 « DB2 Summary Report Example
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Standard Reports H

Detail by Rate Group Report
File name: RDETR001
Stored Procedure: CIMSSP_Dri1ldown_by_RateGroup

This report provides total resource units used for the first eight rate code descriptions in
a rate group for the parameters selected. If applicable, a total for the next highest level of
the account code appears. For example, in Figure A-21, total units appear for account
codes AAAAAA, AADDDD, AAFFFF, and AAMMMM. The sum of these totals appears for account
code AA (the next highest level).

Drill down: None
Parameters:
m Rate Group

B Account Code Level

Starting and Ending Account Code

m From and To Date

Report Example

2l CIMS Server - Microsoft Internet Explorer,

File Edt View Favorites Toos Help Iz
> ) Al © S 2| -
Q= -© ¥ @G ) search 5 ¢ Favaries @ e ) & 3
Address | @] http: | fuwaw, cimsserver. comfreptexec, aspTRateGraup=2+05%2F 390+ Batch-+ chargestdnvoiceLevel=28AccountCodeStart=+&cboAccountCodeStart=+&AccountCodene ¥ | [gg G0 Links >
Detail by Rate Group Publish Return Help fa ]
& &% [l <] 1oof 1+ > oM & .
Preview |
=)- CTMS Lab, Inc. Roseville ~
by Admmi
Roseville - CIMS Lab Deve B @ b |
Roseville - CIMS Lab Finan ' l Ms
Rosevile - Marksting & Sal A ’
#| CIMS Lab, Inc, Gibbshora =
% CIMS Lab, Inc. Laurel Detail
#) CIMS Lab, Inc. innal
#) CIMS Lab, Inc, Services
Account Code 08/330 Jobs 08/390 Steps 05/330 Cpu 05/390 Cpu 05/390 Cpu Bateh Cred
L Started tarted Minutes Mintes Minutes (Al
Description (Initiators)
[[Aassss - Rosevile - CIMS Lab Administration
4,523 5,212.80 12517 5,656.11
AADDOD - Roseville - CIMS Lab Development
124 248 233.85 9.04 26%.02
AAFFFF - Roseville - CIMS Lab Finance
105 231 593.33 7.87 603,62
AAMMMM - Roseville - Marketing & Sales
2 2 0.04 0.06 0.10
A - CIMS Lab, Inc. Roseville
1,003 5,004 6,040,02 142,14 6,532.85
]
£ L35 | & W
™
&) Dane #® Internet

Figure A-21 + Detail by Rate Group Report Example
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B Standard Reports

Detail by Rate Group/ldentifier Report
File name: RDETR00?
Stored Procedure: CIMSSP_Drilldown_by_RateGroup_Identifier

This report is similar to the Detail by Rate Group report (see page A-33). However, the
resource units are broken down by identifier value for the identifier name selected.

Drill down: None

Parameters:

® Rate Group

B Account Code Level

m Starting and Ending Account Code
® From and To Date

m Identifier

Report Example

<3 CIMS Server, - Microsoft Internet Explorer

File Edt View Favorites Tools Help F

Qu- O XK@ & ) search 57 Favartes @ e 2) = L3

fcldress | €] hittps s, cimsser ver, com/reptexet. aspTRateGroup=2-+0S%2F390- Batch  chargestdnvoiceLevel=2EdccountCodeStart=+ &xbofccountCodeStart=+ &AccountCodetne v | (£ 60 Links >

Detail by Rate Group/Identifier Publish Return

& &% 10z~ M 4 3 of 3+ > M #h .
Puewew}
= CIMS Lab, Inc. Roseville ~

e

- Roseslls - Marketing & Sal

) CIMS Lab, Tnc. Gibbshora Detail by Jobname

#) CIMS Lab, Inc, Laurel
#| CIMS Lab, Inc, International
#) CIMS Lab, Inc, Services

Account 05390 Jobs 05/330 Steps 05330 Cpu 05/390 Cpu 05390 Cpu Batch Cred
Started Started Minutes Minutes Minutes (&1
Jobnarne (Tnitiators)

[ £40DDD - Roseville - CIMS Lab Development

BKALICAT 4 0.14 0.00 0.15
BRALIDLE 2 10 0.25 .01 0.28
BRALIRES 1 S 0.1z 0.00 0.14
BRALISPL 1 10 0.21 .01 0.24
BIALISTL 1 S 0.06 0.00 0.07
BRALISTZ 2 10 0.1z .01 0.13
BKALISY1 4 0.1z 0.00 0.14
BIALISY2 2 10 0.26 .01 0.29
BKALISYZ 4 013 0.00 0.14
BRALISY 4 1 9 0.25 .01 0.29
BIALISYS 1 9 0.26 .01 0.30
BKFWKPD1 1 10 0.02 .01 0.03
DaAD3I 2 4 0.63 .01 0.74
DAMZT 1 z 0.24 .01 0.26
mEALLAC 3 & ann nan i

<

|
|~
|

=3

&) Dane # Internet

Figure A-22 + Detail by Rate Group/Identifier Report Example
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Standard Reports H

Detail Rate Codes by Identifiers
File name: RDRIR001
Stored Procedure: CIMSSP_Detail_I5_R5

This report shows resource units consumed for a maximum of five rate codes and five
identifiers.

Drill down: None

Parameters:

® Account Code Level

m Starting and Ending Account Code
m From and To Date

m Rate Codes (5 maximum)

m Identifiers (5 maximum)

Report Example

<3 CIMS Server, - Microsoft Internet Explorer

File Edt ‘View Favorites Tools Help Fr
Qe - () \ﬂ @ N /Ij‘JSearch ‘i‘\'(‘Favthes [ ] - ;,; Uil B év

Acdiress [ €] i fmmw, cmsserver.com/CrystalReportsinteractiveViewer, asp?CIMSFLAG1 =adnvaicelevel=1 3ACR angeDisplay=Account-+Range% 32+l -AccountsaeGroupTree=gdce | [ 5o @

Detail By Multiple Identifiers Publish Return

9. vhn RS

Detail Rate Codes by Identifiers
Account Range: All Accounts
Date Range: 11/1/2004 to 11,/30,/2004

J0BNAME WORK 1D SYSTEM 1D sarfanes stons Somrtad R i
BLSIPRMI sTC cIMD 1.00 1.00 0.04
BPRAS sTC cIMD 8.00 8.00 0.00
cIMsoz TS0 cIMD 13.00 13.00 =
CIMS0ZRM JESZ cIMD 3.00 21.00 1.29
CIMS02RE JESZ cIMD 10,00 19.00 1.70
cIMs03 TS0 cIMD 11.00 11.00

CIMSO3AL JESZ cIMD 32.00 42,00 0.84
CIMS03CE JESZ cIMD 4.00 2.00 0.01
CIMS03GT JESZ cIMD 1.00 1.00 0.00
CIMS03GN JESZ cIMD zz.00 37.00 0.75
CIMS03TM JESZ cIMD 19.00 23.00 0.56
CIMS03UN JESZ cIMD 2.00 4.00 0.02
[ ELE) TS0 cIMD €.00 €.00

cIMSo401 JESZ cIMD 2.00 12,00 0.28
cIMs0447 JESZ cIMD 4.00 24.00 0.24
CIMS0443 JESZ cIMD 2.00 s.00 0.06
CIMS0491 JESZ cIMD 1.00 4.00 013
CIMS0493 JESZ cIMD 2.00 10,00 0.34
CIMS0494 JESZ cIMD 4.00 16.00 0.56

£

[REEETY WR7 cimn 2.0n Z4.0n n.ea

[CI]E

B Internet

Figure A-23 « Detail Rate Codes by Identifiers Report Example
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B Standard Reports

Detail Rate Codes by Identifiers/Account
File name: RDRIR002
Stored Procedure: CIMSSP_Detail_I5_R5

This report shows resource units consumed by account code for a maximum of five rate
codes and five identifiers.

Drill down: None

Parameters:

B Account Code Level

m Starting and Ending Account Code
m From and To Date

m Rate Codes (5 maximum)

m Identifiers (5 maximum)

Report Example

<3 CIMS Server, - Microsoft Internet Explorer

Fle Edt View Favorles Tools Help
Qe - () \ﬂ @ () ) search 5l Favortss ) - &8 o, § év

Acdiress [ ] it fmm, cmsserver.com/CrystalReportsinteractiveViewer, asp?CIMSFLAG1 =adnveicelevel=1 3ACR angeDisplay=Account-+Range% 32+ Al -AccountsaeGroupTree=vesc | [ 5o @

Detail By Multiple Identifiers with Acct Publish Return

9. vh RS &

Detail Rate Codes by Identifiers/Account
Account Range: All Accounts
Date Range: 11/1/2004 to 11,/30,/2004

JOBNAME WORK_ID SYSTEM ID Mainframe Mainframe Mainframe Cpu
Jobs Started Steps Starbed Minutes

€CX - Credit Card

CLASS00 TS0 CIMD 10,00 10,00

CLASS000 JESZ CIMD 1.00 0.00 L
CLASS001 JESZ CIMD 2.00 8.00 0.26

CLASS00Z JESZ CIMD 4.00 T.00 0.14

CLASS003 JESZ CIMD 3.00 15.00 0.52

CLASS004 JESZ CIMD 5.00 17.00 0.57

CLASS00S JESZ CIMD 2.00 14.00 0.69

CLASS00E JESZ CIMD 2.00 4.00 0.36

CLASS007 JESZ CIMD 2.00 16.00 0.33

CLASSO0L TS0 CIMD 10,00 10,00

CLASS010 JESZ CIMD 1.00 12.00 0.14

CLASS011 JESZ CIMD 1.00 4.00 0.13

CLASS01Z JESZ CIMD 1.00 4.00 0.14

CLASS013 JESZ CIMD 4.00 20.00 0.68

CLASS014 JESZ CIMD 4.00 16.00 0.56

CLASS01S JESZ CIMD 2.00 18.00 1.23

CLASS01E JESZ CIMD 1.00 4.00 0.36

CLASS0Z T50 CIMD 11.00 11.00

CLASS020 JESZ CIMD z.00 24.00 0.29 o

< | 3
&) # Internet

Detail Rate Codes by Identifiers/Account Report Example
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MS Exchange 2000 Resource Report
File name: REX2R001
Stored Procedure: CIMSSP_Detail_Resource

This report provides Exchange 2000 Server data for the parameters selected. This data is
taken from the CIMSDetail table.

Drill down: None

Parameters:

m Account Code Level

m Starting and Ending Account Code

®m From and To Date

Report Example

3 CIMS Server - Microsoft Internet Explorer (=[S
i

Fle Edt View Favorites Tools Help
o - O . B 2 -
Qe - O \ﬁ @ ) search g Favories ) &2 B 3 é

Address [ €] Rt [fumnw, cmsserver.com(CrystalReportsInkeractivevismer. 3sp?iCR angeDisplay—Account-+Rangsd s+ Al-Accountsadnvoicel evel=L iccount CodeStart=auiccountCads | (£ Go @

Exchange 2000 Publish Return

2 9P R

ROCA-MAILL

MS Exchange 2000 Resurce R;port

Account Range: All Accounts
Date Range: 11/1/2004 to 11,/30,/2004

EMAILS BYTES
SERVER NT USER NAME ACCOUNT SENT SENT

ROCA-MAILL administrator@cim WTH o o

zlab.com
ROCA-MAILL al.marley@cimslab T a o

lcom
ROCA-MAILL ann.wilson@eimsla WTH o o 4

b.cam
ROCA-MAILL bruce.clayton@cim RTM o a

slab.cam
ROCA-MAILL  caralyn com 13 39,790
ROCA-MAILL caralynlynch@cim cOM o o

slab.com
ROCA-MAILL cynthia COomM 325 2,797,298
ROCA-MAILL cynthiamurayama com o o

cimslab.cam

ROCA-MAILL  deborah DEP 45 27,784,419
ROCA-MAILL deborsh.sparks@ci CEP o o

mslab.com
ROCA-MAILL del CEP 18 2,212,887
ROCA-MAILL del.ence@cimslab, DER a o

com
ROCA-MAILL  gary ATM 37 1,579,499
ROCA-MAILL gary.mi\ler@:\ms\a ATM o o

.com &

\ >

B Internet

B

Figure A-24 + MS Exchange 2000 Resource Report Example
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Invoice by Account Level V2 Report
File name: RINVC001

See [nvoice by Account Level Report on page A-45.

Alternate Invoice Report
File name: RINVC002
Stored Procedure: CIMSSP_Summary

This report provides charges by account code and rate code description for the
parameters selected. An optional graph showing total expenses by account code is also
included.

Drill down:
m Double-click a bar on the graph and the invoice appears.

m Click the units for a rate and a new page appears to enable a drill down of units by
identifier. This page invokes the report Invoice Drill Down for Rate (see page A-14),
Invoice Drill Down for Units by Date (see page A-16), or Multilevel Drill Down for
Units (see page A-17).

m Double-click a rate code description or its corresponding rate or charge and the next
lower level of the account structure appears. This drill down can be continued
through the account structure.

Parameters:

Account Code Level

Invoice Number

Display Graph

Starting and Ending Account Code

m From and To Date
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Report Example

2 CIMS Server - Microsoft Internet Explorer

Filg Edit View Favorites Tools Help

Qu- O XK@ 6 ) search 5o Favortes @ Meda €2) (- :\; <] i

fddress | @] hitp: | fuwan, cimsserver.com|reptexec. aspPInvaicel evel=1&dnvoic ph countCodestart: bhoaccountCodestart: countCodeEnd=zzzzezezazinl v | [gd G0 Links >
Alternate Invoice Publish Return

| % & @[z < || u 4 5 of ot PoH e84 | =

Preview |

CIMS Lab, Ine. Rosaville ~

CIMS Lab, Inc, Gibbshora
CIMS Lab, Inc, Laurel
CIMS Lab, Inc. Inkern:

Invoice No. 5

Invoice Billing Period: 6/1,/2003 to 6/30,/2003

Big Time Company
Corporate Headquarters
2013 Douglas Blud.
Suite 120

Roseville, CA 05661

EE - CIMS Lab, Inc. Services

Units Rate Charge
05/390 Jobs Started 41 250000000 10250
05/390 Steps Started 16 0.50000000 8.00
05/390 Cpu Minutes 0.01 20, 00000000 0.1z
05/390 Cpu Minutes (Initiators) 0.01 0, 00000000 0.00
05/390 Cpu Minutes (all) 0.01 0, 00000000 0.00
Total SI0s 3 0.0000 /M 0.00
Disk S10s 3 0.2500 /M 0.01
Input Records z 1.00000000 /i) 0.00
Disk Data Set: 2 0, 25000000 0.50 3
1)) S T T @ |
|
&) Dane #® Internet

Figure A-25 + Alternate Invoice Report Example
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Account Total Invoice Report
File name: RINVC003

Stored Procedure: CIMSSP_Account_Summary

This report provides the total charges by each level of the account code structure for the

parameters selected.

Drill down:

m Click the Invoice link and a complete invoice for the account code level appears (see

Invoice Report on page A-43).
Parameters:
m Starting and Ending Account Code
m From and To Date

Report Example

<2 CIMS Server - Microsoft Internet Explorer

File Edit Wiew Favorites  Tools  Help
. Y A D) 4y " 3 = ) PY
@ Bk - () |ﬂ @ B ) ssarn 57 Favorites @ e €2) = 32
Address | €8] hitpif v, cimsserver comjreptexet, asprAccountCodeStart=-+ &cboAccount CodeStart countCodeEnd=zzezzzzazethofcountCodeEnd=zazezezzazRange=seDat ¥ | [5g Go  Links
Account Total Invoice Publish Return Help 2
S =[z - || M 8 of o+ > oM # B
Preview |
—i
- CIMS Lab, Inc. Inkernational =
1M Lo, e, Sereics CIMS Account Total Invoice
Account Range: All
Date Range: 6/1/2003 to 6/30/2002
Account Invoice Amount
CIMS Lab, Inc. Gibbsboro 16,889.70 Invoice
- Gibbsboro - CIMS Lab Development 15,114.31 _Invoice
- - Gary 766.43 Invoice
- - - BBDDDDGGblackd.exe blac 20.74 Invoice
- - - BBDDDDGGblackice.exe blac sz.82 Invoice
- - - BBDDDDGGdIIhost.exe dith 388.58 Invoice
- - - BBDDDDGGgarym garym 22.04 Invoice
- - - BEDDDDGGIRLMPROC* 64.52 Invoice
- - - BBDDDDGGlIssrv.exe llss 0.34 Invoice
- - - BBDDDDGGralph [ 0.00 Invoice
- - - BBDDDDGGralph fusr 0.00 Invoice
- - - BBDDDDGGralph 4Dgifts 0.2¢ Invoice
- - - BBDDDDGGralph adm 0.12 Invoice
- - - BBDDDDGGralph arsap 6.12 Invoice
- - - BBDDDDGGralph bin 1.56 Invoice
- - - BBDDDDGGralph demos 1.56 Invoice
- - - BBDDDDGGralph george 11.40 Invoice
- - - BBDDDDGGralph gpereyo 0.12 Invoice o
< | slam 5|
™
€] Done B Internet

Figure A-26 + Account Total Invoice Report Example
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Invoice with Budget Report
File name: RINVC004
Stored Procedure: CIMSSP_LineItem Budget

This report provides charges by account code, rate code description, and rate group for
the parameters selected. This report also includes a Budget and Variance field for the
calendar period selected and YTD Charges, Budget, and Variance fields.

Drill down:

m Click the units for a rate and a new page appears to enable a drill down of units by
identifier. This page invokes the report Invoice Drill Down for Rate (see page A-14),
Invoice Drill Down for Units by Date (page A-16), or Multilevel Drill Down for Units
(see page A-17).

m Click the rate group name in the Total line and a new page appears to enable a drill
down of charges by identifier. This page invokes the report Invoice Drill Down for
Rate Group (see page A-11) or Invoice Drill Down for Rate Group by Date (see
page A-13).

Parameters:
m Account Code Level
m Calendar Period

Invoice Number

Starting and Ending Account Code
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Report Example

< CIMS Server - Microsoft Internet Explorer |
File Edt View Favorkes Tools  Help w

Qe - O @ @ ) frj Search 57 Favorites (@ edia €2 E/;{v ,1_\‘ 32
Address | &) hitpif v, cimsserver comjreptexet asprInveicelevel=18¢ear PeriodStart=2003%2F6adnvoicehumber=18Account CodeSkart=+&cboAccount CodeStart: countCode v | [ Go  Links 7
i Publish Return
Preview |
—
Invoice with Budget Invoice No. 1 =
Billing Period: 6/1/2003 to 6/30
Big Time Company
GCorporate Headquarters
23012 Douglas Blvd.
Suite 120
Roseville, CA 95661
AA
ATTH:
Units Rate Charges Budget “ariance YTD Charges YTD BudgetyYTD v
DB2 Transactions (Records)
0.01500000 0.28 128 0.99 288 750
DB2 Transaction Elapsed Minutes
0.27 015000000 0.04 0.63 0.79 0.57 5.00
Total 05/390 DB2
0.30 2.08 1.78 3.43 12.50
Unix disk I/Q
45.20 0.10000000 4,51 2,08 243 432,44 12,50
Unix character 1/0 v
/o & o
|
€] Done B Internet

Figure A-27 « Invoice with Budget Report Example
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Invoice Report
File name: RINVC006
Stored Procedure: None

This report provides charges by account code, rate code description, and rate group for
the parameters selected. This report is invoked by clicking the Invoice link for the
account code in the following reports.

m Account Total Invoice (see page A-38)
m Top Cost (see page A-61)

m Top 10 Bar Graph (see page A-63)

m Top 10 Pie Chart (see page A-65)

Drill down:

m Click the units for a rate and a new page appears to enable a drill down of units by
identifier. This page invokes the report Invoice Drill Down for Rate (see page A-14),
Invoice Drill Down for Units by Date (page A-16), or Multilevel Drill Down for Units
(see page A-17).

m Click the rate group name in the Total line and a new page appears to enable a drill
down of charges by identifier. This page invokes the report Invoice Drill Down for
Rate Group (see page A-11) or Invoice Drill Down for Rate Group by Date (see
page A-13).

Parameters:

m All parameters are supplied by the report from which the invoice is invoked.
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Report Example

2 CIMS Server - Microsoft Internet Explorer, E‘@lg‘
Fle Edt View Favorites Toos Help >
<) m @ (0 D search 5 ¢ Favaries @Pmeda ) - 3

Go  Llinks **
Invoice Help e
& & [l - [ 1 of 1+ (] b .
Preview |
—~
Invoice Billing Period: 6/1/2002 to 6/20,/2002
Big Time Company
Corporate Headquarters
3013 Douglas Blvd.
Suite 120
Roseville, CA 05661
BBDDDD
Units Rate Charge
05390 Jobs Started s08 250000000 1,270.00
05/390 Steps Started 1,378 0,50000000 689,00
05390 Cpu Minutes 58.78 20, 00000000 1,175.64
05390 Cpu Minutes (Initiators) 111 0,00000000 0.00
05390 Cpu Minutes (A1) 60.74 0, 00000000 0.00
| 08/3290 Batch charges 3,134.84
Tso Cpu Minutes 533 2500000000 133.25
Tso Connest Mindtes 45,014.80 0,25000000 11,253.69
Tso Inputs 21,375 2, 00000000/ 42.75 o) [
A
&) Done B Intemet
—

Figure A-28 « Invoice Report Example
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Invoice by Account Level Report

File name: RINVC007

Stored Procedure: CIMSSP_Summary

This key report provides charges by account code, rate group, and rate code description
for the parameters selected. An optional graph showing total expenses by account code
is also included.

Drill down:

Double-click a bar on the graph and the invoice appears.

Click the units for a rate and a new page appears to enable a drill down of units by
identifier. This page invokes the report Invoice Drill Down for Rate (see page A-14),
Invoice Drill Down for Units by Date (page A-16), or Multilevel Drill Down for Units
(see page A-17).

Click the rate group name and a new page appears to enable a drill down of charges
by identifier. This page invokes the report Invoice Drill Down for Rate Group (see
page A-11) or Invoice Drill Down for Rate Group by Date (see page A-13).

(Invoice by Account Level V2 only) Double-click a rate code description or its
corresponding rate or charge and the next lower level of the account structure appears.
This drill down can be continued through the account structure.

Parameters:

Account Code Level

Invoice Number

Display Graph

Starting and Ending Account Code

From and To Date
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A-46

Report Example

@ CIMS Server - Microsoft Internet Explorer

Fle Edt Wew Favortes Tooks Help i
Q- O [« @ & ye Favorites %) - il 3 A
Address [ €] http:jjlocalhostiDemo/CrystaReportsIntaractiveviewer asp v B @
~
R - e R S h— e
E-ATM Transactions Cl MS .
B-Credit Card
B-Commercial Loans Invoice
#-Drafts and Collections Billing Period: 11/1/2004 to 11/30,/2004
#-Electronic Deposits Invoice No. 1
#-Mortgages
& 929 The Big Time Company
Online Electronic Payments Corporate Headquarters
H-Retirement 2013 Douglas Blvd.
B-Secure Sales - Internet Cor geseville, ca 95661 L
#-Telephone Transactions United States of America
BE-Wire transfers
ATM - ATM Transactions
Units Rate Charge
Lines Printed - Local 40,600 0.0010 M 0.00
Pages Printed - Local 2,100 0.0000 0.00
PsfNumber Of Lines Printed 196,140 o.0000 /M 0.00
Psf Number Of Pages Printed 3,540 0.0000 0.00
PsfNumber Of Imprassions 3,852 0.000% 1,92
PsfNumber Of Feet Of Paper 3,168 0.0010 21z
Mainframe Printer/Reader charges 5.04 |
v
< | &
&) % Local intranet

Figure A-29 « Invoice by Account Level Report Example (Crystal Reports)
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Invoice with Shifts Report
File name: RINVC009
Stored Procedure: CIMSSP_Summary_Shift

If the CIMSSummary table contains multiple shift codes for a rate code, this report
provides charges by account code, rate group, and rate code description broken down by
shift for the parameters selected.

Drill down:
m Double-click a bar on the graph and the invoice appears.

m Click the units for a rate and a new page appears to enable a drill down of units by
identifier. This page invokes the report Invoice Drill Down for Rate (see page A-14),
Invoice Drill Down for Units by Date (page A-16), or Multilevel Drill Down for Units
(see page A-17).

m Click the rate group name in the Total line and a new page appears to enable a drill
down of charges by identifier. This page invokes the Invoice Drill Down for Rate
Group (see page A-11) or Invoice Drill Down for Rate Group by Date (see page A-13)
report.

Parameters:

m Account Code Level

® Invoice Number

m Display Graph

m Starting and Ending Account Code

®m From and To Date
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Report Example

2 CIMS Server - Microsoft Internet Explorer

File  Edt Wiew Favorites Tools Help 7
- A o ay T
Qu- O @& ) search ' Favories @ Medis €2 e B 3
fdddress | €] hitp flocalhostreptexec. asprinvoicel evel=18dnvaic ph countCodestart=+&choAccountCodestart: countCodeEnd=zzzzzzzzzzinbofccountCe ¥ | [ o Links 7
Invoice with Shifts Publish Return
| % & @iz <] || 1 4 [T ‘ =
=i
CIMS Lab, Inc. Gibbshoro
CTMS Lah, Inc. Laurel b
CIMS Lab, Inc, Inkernational
- Invoice No. 1
Invoice Billing Period: 6/1 /2002 to 6/20/2003
The Bia Time Combanv
Corporate Headauarters
3013 Doualas Blvd.
Roseville. CA 95661
United States of America
AA - CIMS Lab, Inc. Roseville
Units Rate Charge
CICS Transaction Minutes 0.34
shift 1 173 0, 16000000 0,31
shift 2 166 0. 01600000 0.03
CICS Cpu Minutes 5.82
shift 1 0.06 30, 00000000 169
shift 2 017 2500000000 413
CICS Transactions 3.27
shift 1 161 0, 01500000 242
shift 2 570 0,00150000 0.85
CICS Input Messages 2.50
shift 1 111 0, 01500000 167 v
</ a .
hd
&) Dane & Local intranet

Figure A-30 « Invoice with Shifts Report Example
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Run Total Invoice Report
File name: RIVTC001
Stored Procedure: CIMSSP_Summary

This report provides total charges by rate group and rate code description for the
parameters selected.

Drill down:

m Double-click a rate code description or its corresponding units, rate, or charge and
and a breakdown of data by account code appears.

Parameters:
m Account Code Level
m Starting and Ending Account Code

®m From and To Date

Report Example

2l CIMS Server - Microsoft Internet Explorer ‘_ Htllﬁ
File Edit Wiew Favorites Tooks  Help 5
. Al D <A 2 . 2 o
Q- ©  [x] B & ) search < Favaries ) = H3a
Address |@ http:jflacalhostiCSDewiCrystaRepartsInteractiveyiswer . asp?Inwoicel svel=18Canfigorghame=The-+Big+ Time-+CompanytConfighddressLine1 =Corporate-+Headouar V| B @
~
I Run Total Invoice Publish Return Help 2
[Zn = TN N VR A I 5 N W EC W €
Mainframe Batch charges CIMS ,f S
Mainframe Tso charges ] oy
Mainframe Input/Output chipun Total Invoice
Mainframe Printer/Reader :rA(m““th“wn" Accounts
Mainframe Storage charges gilling Period: 11/1/2004 to 11/30,/2004
The Big Time Company
Corporate Headquarters —
3013 Douglas Blvd.
Roseville, CA 95661
United States of America
Units Rate Charge
Mainframe Jobs Started 151 4,0000 485,00
Mainframe Steps Started 657 0.4000 206,20
Mainframe Cpu Minutes 5.49 20,0000 94,89
Mainframe Cpu Minutes (Initistors) 0.34 2.0000 0,38
Mainframe Cpu Minutes (All) 6.34 2.0000 3,20
Total Mainframe Batch charges 775.75
Tso Cpu Minutes 1,39 25,0000 34,80
Tso Connect Minutes 997.36 00250 2493
Tso Inputs 34,474 z.0000 /M 63,95
Teo Outputs 35,200 z.0000 M 104,09
Tso Cpu Minutes (Initistor) 0.02 0.0000 0.00
Tso Cpu Minutes (All) 1.66 0,0000 000w
< | Bl
& ] Local intranet

Figure A-31 + Run Total Invoice Report Example
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Run Total Percent Report
File name: RIVTC002
Stored Procedure: CIMSSP_Summary

This report is the same as the Run Total Invoice report (see page A-49) except that the
drill down includes percent total by account code in addition to units, rate, and charge.

Drill down:

m Double-click a rate code description or its corresponding units, rate, or charge and
and a breakdown of data by account code appears.

You can set the number of account codes that appear in the drill down using the TopN
parameter. For example, if you type 2 as the TopN parameter, only the account codes
with the highest and second highest charges appear when you drill down. If you leave
the TopN parameter blank, all account codes for the parameters selected appear.

Parameters:

Account Code Level

m TopN

Starting and Ending Account Code

®m From and To Date
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Run Total Rate Group Percent Report
File name: RIVTC003
Stored Procedure: CIMSSP_Summary
This report provides charges and percentage by rate groups for the parameters selected.
Drill down:

m Double-click the charge or percentage for a rate code description and breakdown of
data by account code appears.

You can set the number of account codes that appear in the drill down using the TopN
parameter. For example, if you type 2 as the TopN parameter, only the account codes
with the highest and second highest charges appear when you drill down. If you leave
the TopN parameter blank, all account codes for the parameters selected appear.

Parameters:

Account Code Level

m TopN

Starting and Ending Account Code
® From and To Date

Report Example

<3 CIMS Server, - Microsoft Internet Explorer

Filz  Edt View Favorites Tools Help o
. A @ &5 A= I 38
@Back ) \ﬂ g" ) D seerh Slpravories @ veds 2 = 3
address | @] hitp: o, cimsserver.c asp?Invaicelevel: ph=3&Account CodeStart=-+&cboAccountCodeStart: countCadeEnd: boAccountCodeEnd= v | [og G0 Liks >
Run Total Rate Group Percent Publish Return Help a
& &7 0 ] [ 1 ooft 4 .
Preview 1

& ch charges A
+ 05(390 Tso charges

f
) 05/390 Input/Output charges B
| 05390 Printer/Reader charge Cl MS - ‘.é(; ’
+ 05/390 Storage charges 2
+ ©5/390 DEZ ch
e |  CIMS Run Total Rate Group Percent

- Unix backaround job type chal
# Unix storage charges

- Unix filesystem

+ Oracle charges

M5 Windows storage charges
M5 Windows Oracle charges

M5 Windows SCL Server

Account Range: All
Date Range: 6/1 /20023 to 6/20/2002

Big Time Company
GCorporate Headquarters

4 M5 115 2013 Douglas Blvd.
#)- M3 Exchange Suite 120
M5 Windows Processes Roseville, CA 95661
Rate Group Charge %%
| Total O5/390 Batch charges 20,895.13 19.40%
Total 05/390 T=o charges 12,064.15 11.20%
Total 054390 Input/Output charges 11,560,22 10.74%
Total 05/390 Printer/Reader charges 401,854 0.37%
Total 0S5/390 Storage charges 8,491.25 7.89%
Total 0S/390 DB2 charges 0,30 0.00%
Total Unix interactive job type charges 4z1.90 0.39% @
. 5 e . s . e 5
v
&) Dane ® Intemet
L

Figure A-32 + Run Total Rate Group Percent Report Example

CIMS Server Web Reporting User’s Guide A-51 H



B Standard Reports

Run Total Invoice with Shifts
File name: RIVTC004
Stored Procedure: CIMSSP_Summary

This report is the same as the Run Total Invoice report (see page A-49) except that the
units, rate, and charges for each rate code description are broken down by shift if the
CIMSSummary table contains multiple shift codes for a rate code.

Drill down:

B Double-click a rate code description or its corresponding units, rate, or charge and
and a breakdown of data by account code appears.

Parameters:
B Account Code Level
m Starting and Ending Account Code

m From and To Date

Report Example

/A CIMS Server, - Microsoft Internet Explorer (=3
Fle Edt Wew Favortes Tooks Help &
. Al @ < 2 - B o
Q- © [« B & ) search ¢ Favaries ) = H3a
Address [ €] bttpijlocalhostiCsDeviCrystaReportsntractiveviewer . sspPlnwoicel svel=1 BConfignrgame=The--Biq+ Time-+Company&ConfigddressLine] Corporate-Headauar | [ G0 @
I Run Total Invoice with Shifts Publish Return Help had
ERUN- Rl R e . el G
Mainframe Batch charges 73
Mainframe Tso charges £ ik
Mainframe Input/Output chipun Total Invoice Shifts
Mainframe Printer/Reader :rA(m““th“g!m" Accounts
Mainframe Storage charges pijing period: 11/1/2004 to 11/°30/2004
The Big Time Company B
Corporate Headquarters
3013 Douglas Blud.
Roseville, CA 95661
United States of Ametica
Units Rate Charge
Mainframe Jobs Started 265.00
Shife 1 10 2.00000000 20.00
Shife 2 1139 3.00000000 357.00
Shift 2 22 4.00000000 82.00
Mainframe Steps Started 206.30
Shife 1 33 0.20000000 660
Shife 2 499 0.30000000 149.70
shift 3 125 0.40000000 50,00
Mainframe Cpu Minutes 24.80
Shife 1 n7e 1R.AnAANRAA zan ¥
X | &
&) % Local intranet
=

Figure A-33 + Run Total Invoice with Shifts Report Example
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Zero Cost Center Invoice Report
File name: RIVZC001
Stored Procedure: None

This report provides zero cost invoicing by account code for the parameters selected. You
can adjust the total invoice amount or the amount for each rate by the zero cost amount.

This report first displays the Zero Cost Center Factor Report. The Zero Cost Center Factor
Report shows the zero factor difference between the total amount due for all account
codes and the zero cost amount. You can run the Zero Cost Center Factor Report
independently (see page A-55).

Drill down:

m Click the units for a rate and a new page appears to enable a drill down of units by
identifier. This page invokes the report Invoice Drill Down for Rate (see page A-14),
Invoice Drill Down for Units by Date (page A-16), or Multilevel Drill Down for Units
(see page A-17).

m Click the rate group name in the Total line and a new page appears to enable a Drill
down of charges by identifier. This page invokes the report Invoice Drill Down for
Rate Group (see page A-11) or Invoice Drill Down for Rate Group by Date (see
page A-13).

Parameters:

m Starting and Ending Account Code
m Account Code Level

® From and To Date

m Invoice Number

m Zero Cost Processing Option

m Zero Cost Amount
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Report Examples:

CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Toaols Help

Qo © BB G Pown dyroor @ @ 32 8 L3

fcldress | €] hiktps o, cimsserver.c .asp?accountCodeStart=+&rboAccountCodeStar b=+ BAccount CodeEnd=zzzzzzzzzztcboccount CodeEnd=zzzzzzezzztdnvoicel evel= ¥ Go  Links

2ero Cost Center Invoice Publish Return

| % @@= = 4 & of6+ P e84 | =

Previen |

Zero Cost Center Invoice Siling period: 67212003 1 o) 0] S603

Big Tine Company
Corporate Headquarters
2013 Douglas Blvd.
Suite 120

Roseville, CA 95661

AA-CIMS Lab, Inc. Rosewille

M5 Exchange Emails Sant
M3 Exchangs Bytes Received
MS Exchange Emails Recaived

Total M5 Exchange

M3 Windows Elapzed Time in seconds
MS Windaws CPU Time in seconds

MS Windows Kernel CPU Time in seconds
M3 Windows User CPU Time in seconds
M3 Windows Resd Requests

MS Windows KB Read

MS Windows KB Written

MS Windaws Write Requests

Windows Pages

Total M5 Windows Processes [

Sub Total 37,681.90
Zero Reduction Factor 0.97505186
Amount Due

&) Dane B Internet

Figure A-34 + Zero Cost Center Invoice—Factor Total Report Example

CIMS Server - Microsoft Internet Explorer

File Edt View Favorites Tools  Help

Qo - © ) [B) ] Pooer oo @ @ @3- % B[ B

Acress @) hitp oy, cimsserver com/reptexec  ssp?AccountCadeStart=+EcboAccountCodeStart=+BAccount CodsEnd=zzzzazezasbchoAceount CodsEnd=azezezzzaztrwoicel evel= | B Go  Links >

Zero Cost Center Invoice Publish Return
| % @@= =  u4 & af 7+ P o [ ‘ ]
Preview |
= Invoice Na. 1 ~|
Zero Cost Center Invoice Billing Period: 6/2/2003 15 830 3003 L
Big Time Company
Corporate Headquarters
3013 Douglas Blvd.
Suite 120
Roseville, CA 95661
AA-CIMS Lab, Inc. Roseville
Units Rate Charge
MS Windows Disk Size in ME 69,393.57 0.00000975 |M 0.00
MS Windows Mumber of Files a6 0.00195010 009
Total MS Windows storage charges 0.08 =
M5 Exchange Bytes Sent 178,651,851 17.22
M5 Exchange Emails Sent 1,048 0.00087505 § 0.00
M3 Exchangs Bytes Recsived 411,967,162 0.00146258 4 602.53
M3 Exchangs Emails Recaived 5,290 0.00029252 a.00
Total MS Exchange 619,76
MS Windows Elapred Time in seconds 0.00000000 0.00
MS Windows CPU Time in seconds 0.00009751 0.00
MS Windows Kernel CPU Time in seconds 0.00146258 | 0.00
MS Windows User CPU Time in seconds 0.00
MS Windows Read Requests 24.25
MS Windows KB Read 1.55
MS Windows KB Written 0.49
MS Windows Write Requests 5,408,441
Windows Pages 0.00000000 0.0
Total MS Windows Processes 6,502.76
Total Amount Due
~
|
&) Dane D Intemet

Figure A-35 « Zero Cost Center Invoice—Factor Rates Report Example

CIMS Server Web Reporting User’s Guide
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Zero Cost Center Factor Report
File name: R1V7C002

Stored Procedure: None

This report appears as the first report in the Zero Cost Center Invoice (see page A-53);
however, you can also run this report independently. The last page of this report provides
the zero factor difference between the total amount due for all account codes and the

zero cost amount.

Drill down:

m Double-click a rate code description or its units, rate or charge and a breakdown of

charges by account code appears.
Parameters:
m Starting and Ending Account Code
m From and To Date

m Zero Cost Amount

Report Example

2l CIMS Server - Microsoft Internet Explorer

File Edt View Favorites Tools  Help

Qe - ) \ﬂ @ A /.HSEarEh ‘;E‘Favw\tes @ reda £2) - & 3

Address | @) http: uws. cimsserver. com/reptese. ssp?AccountCodeSt st =+BrboAccountCodeSt art=+BAccountCodeEnd

Zero Cost Center Invoice Publish

& |7 |5~ M 4 3 of 4+ 3

Previen |

hoAccountCodeEnd:

Links **

~

rvoiceLevel= v | (£ Go

Return Help

@

+-BB

s cC Total MS 118

+- DD
+-EE

MS Exchange Bytes Sent

MS Exchange Emails Sent

M5 Exchange Bytes Recaived
MS Exchange Emails Received

Total MS Exchange

M5 Windows Elapsed Time in seconds
M5 Windows CPU Time in seconds

15 Windows Kernel CRLU Time in seconds
M5 Windows User CPU Time in seconds
M5 Windows Read Requests

MS Windows KB Read

MS Windows KB Written

M5 Windows Writs Requasts

Windows Pages

Total M5 Windows Processes

10,407.37

Amount Due
Zero Value

Zero Factor

107,686.58
105,000.00
0.97505186

Page 3

£

@ Done

& Tnternst

Figure A-36 * Zero Cost Center Factor Report Example
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B Standard Reports

Job Cost Report

B A-56

File name: RJOBCOO1

Stored Procedure: CIMSSP_JobCost

This report provides costs by job name. Rather than using costs from CIMSSummary
table, this report calculates costs directly using rate code values and options (rate shifts,
resource conversion, etc.) from the CIMSRate table.

The following is a description of each of the columns in this report:

Job Name
Sub-ID
Account
Jobs

CPU Cost

Tape I/O Cost
Disk I/O Cost

Other I/O Cost

Input Data Cost

Print Cost

Job Cost

Drill down:

Jobname identifier value.
Work IDidentifier value.
Account code.

Number of jobs.

Cost for rate code Z003 (Mainframe CPU Minutes) +
7020 (TSO CPU Minutes).

Cost for rate code Z007 (Tape SIOs).
Cost for rate code Z006 (Disk SIOs).

Cost for rate code Z021 (TSO Inputs) + 2022 (TSO
Outputs).

Cost for rate code Z014 (Input Records).

Cost for rate code Z016 (Lines Printed—Local) + Z017
(Pages Printed—Local) + Z018 (Print Time Minutes—
Local).

Sum of preceding cost columns: CPU Cost through
Print Cost.

m Click any item in a line and a breakdown of for all items in the line appears.

Parameters:

B Account Code Level

m Starting and Ending Account Code

m From and To Date
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Report Example

2 CIMS Server - Microsoft Internet Explorer

Fle Edt View Favortes Tools Help =
Qu-Q @G ) search e Favores 2 f e -
Address |ﬂ http:/flocalhost/Demofactivexviewer, asp?Invoicel evel=1&Account CodeStark=8AccountCodeEnd=zzzzBAccount Start=18AccountLength=48DateStart=11%2f 1%2f 200430 Vl Go @
Job Cost Publish Return Help &
S o <] M 4] Z ots » oM a4 “EFystalege
Preview |
+ ACCTPRTZ-0002 - o]
+ ACCTPRT3-0002
+ ARO1DALY-0002
+ AROZDALY-0002
+ AR10DALY-0002
. ARTIDALY-D00Z - Job Cost Report
+ AR1SDALY-0002
+ AR1EDALY-0002 Account Range: All
+ ARZZDALY-0002 Date Range: 11/1/2004to 11/30/2004
G- ARZ4DALY-0002 TAPE 1/0 DISK 1/0 OTHER 1/0
+) Be7PrHl-0002 JOB NAME  SUB-ID JOBS cosT cosT cosT
+ BAS95-0002 CPU CARD INPU
+ BAGTI-0002 ACCOUNT COST COST
+ BBIEOM-0002
G- BLSIPRMIL-5TC CIMS0494  JES2  WTX 2 $2.87 $0.00 $0.27 $0.00 40
* BRRASSTC CIMS04 TS0 WTX [ $49.93 $0.00 $0.62 $5.14 30
* CIF0060-0002 CIMS06DE  JES2  WTX 16 $19.30 $0.00 $0.36 $0.00 0
- CIF058-0002 CIMSDEDL  JES2 WTX 19 $37.40 $0.00 $3.83 $0.00 $0
) CIMS02RM-JES2 CIMSOSPR. JES2 WTZ 23 $1.84 $0.00 $0.07 $0.00 $0
# CIMS502-T50 CIMSOSRC  JES2 WTZ 2 $0.10 $0.00 $0.00 $0.00 $0
) CIMS02XX-JES2 CIMS06SE  JES2 WTZ 6 $1.86 $0.00 $0.04 $0.00 $0
# CIMS03AL-IE52 CIMs08SM  JES2  WTX 1 $3.00 $0.00 $0.12 $0.00 30
# CIMS03C5-JE52 CIMS06 TS0 WTL 13 $125.19 $0.00 $1.32 $19.56 0
# CIMS03GI-JES2 CIMS0§WC  JES2  WTX 11 $10.51 $0.00 $1.76 $0.00 0
# CIMSO3GN-IE52 CIMS06WS  JES2  WTX 17 $9.16 $0.00 $0.30 $0.00 30
# CIMS03TH-IE52 CIMS08 TSO WTE 1 $0.62 $0.00 $0.00 $0.03 $0
+ CIMS03-T50 CIMSIOAL JES2  WTX 5 $0.51 $0.00 $0.02 $0.00 0
# CIMS3UN-E52 CIMSIOR  JES2  WTX 11 $22.81 $0.00 $0.97 $0.00 3
. CIMS0401-1E52 Amazin oA T e 1172 s 10 nA 1547 214 en ¥
- o) <0 | | |
b
&) Dane % Local intranet

Job Cost Report Example
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B Standard Reports

MS SQL Server 2000 Resource Report
File name: RMS2R001

Stored Procedure: CIMSSP_Detail_Resource

This report provides SQL Server 200 trace file data for the parameters selected. This data
is taken from the CIMSDetail table.

Drill down: None

Parameters:

B Account Code Level

m Starting and Ending Account Code

m From and To D

Report Example

File Edt View Favorites Tools Help

ate

72 CIMS Server, - Microsoft Internet Explorer;

Q- Q ¥ @ & ) search 5o Favortes )

hmt
=

g3 a

Address [{€] bt fummw, cmsserver.com(CrystalReportsinkeractivevismer. 3sp?iCR angeDisplay—Account-+Rangsd s+ Alk-Accountsadnvoicel evel= iccount CodeStart—auiccountCads | [£3 Go @

2 99:-PR

ROCA-DEMO
ROCA- W e

SQL Server Z00O

CIMS

Account Range: All Accounts
Date Range: 11/1/2004 to 11,/30,/2004

MS SQL Server 2000 Rsource Report

Publish Return

&)

SERYER DATABASE NT USER NAME ACCOUNT REIE?]'I%{DS (milliseconds) (milligep:'o
ROCA-DEMO TEL 743 40,018.0540 £
ROCA-DEMO Administrator MTE 17 S.4e60
ROCA-DEMO backupuser WT= 2 0.3500
ROCA-DEMO BatchDema DAC 1 51,1330 t
ROCA-DEMO Greg TEL 1 3,842.3060
ROCA-DEMO SVETEM TEL 364 387,756.1720
ROCA-DEMO CIMSServer TEL 1,852 986,433.7610 £
ROCA-DEMO CIMSServer Administrator WT= 99 1,614.9810 1%
ROCA-DEMO CIMSServer BatchDema WT= 4 1,601.5130 1
ROCA-DEMO CIMSServer Greg TEL 2 11,432.8330
ROCA-DEMO CIMSServer SVETEM 881 100 0.9900
ROCA-DEMO CIMSServerApp TEL £,513 4,586,436.4610 4l
ROCA-DEMO CIMSServerApp administrator TEL T 3,143.5380
ROCA-DEMO CIMSServerApp BatchDema ATH 4 125.1200
ROCA-DEMO CIMSServerApp Greg TEL 2 8,004.8330
ROCA-DEMO CIMSServerApp SVETEM TEL 1 0.0100
ROCA-DEMO CIMSServerMM TEL 132 152,099.6900
ROCA-DEMO CIMSServerWatson OME 3 204.4050
ROCA-DEMO master Administrator MTE & 5,201.2350 1,67 4

< | 2
B Internet

Figure A-37 « MS SQL Server 2000 Resource Report Example

B A-58
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Percentage Report
File name: RPERX001

Stored Procedure: CIMSSP_Summary

This report provides the total charge by account code for the parameters selected and
specifies the percentage of that charge in relationship to the total charges for all account
codes. This report also provides a breakdown of the percentage by rate group and rate

code description for each account code.

Drill down:

m Double-click an account code and a breakdown of percentage by rate group appears.
Double-click a rate group and a breakdown of percentage by rate code description

appears.
Parameters:
m Account Code Level
m Starting and Ending Account Code
m From and To Date

Report Example

3 CIMS Server, - Microsoft Internet Explorer

File Edit View Favorites Tools Help

- A2 A ) - &
@Back ] \ﬂ g" (n) | search 5 7 Favories @ veda 2] =

Y

EFX
=

fcldres | €] hitps s, cimsserver. comjreptexet. aspPinvaicel evel=1 BAccount CodeStart=-+ &cboActount CodeStart countCodeEnd=zezezzezaztbofecountCodeEnd=zzzzzzez: ¥ | (g G0 Links >
Percentage Publish Return Help e
& &7 0z ] [ 1 ooft 4 .
Preview |
G20 CIMM5 Lab, Inc. & ~
% CIMS Lab, Inc. Gibbsbora R
% CIMS Lab, Inc. Laursl .
% CIMS Lab, Inc. Inkernational 3
- CIMS Lab, Inc. Services i
Account Range: All
Date Range: 6/1/2003 to 6/30/2002
Charge O
AR - CIMS Lab, Inc. Roseville 37,681.90 34.99%
BB - CIMS Lab, Inc. Gibbsboro 16,889.70 15.68%
CC - CIMS Lab, Inc. Laurel 40,481.11 37.59%
DD - CIMS Lab, Inc. International 7,316.57 6.79%
EE - CIMS Lab, Inc. Services 5,317.30 4.94%
Run Total 107,686.58
v
£ >
v
&) Dane 4 Internet

Figure A-38 + Percentage Report Example
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Bl Standard Reports

Rate Report

B A-60

File name: RRATX001

Stored procedure: None

This report provides the information contained in the CIMSRate and CIMSRateGroup

tables.
Drill down: None

Parameters: None

Report Example

2 CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools Help

Q- O HE G Lo @vn @ 22 8 LB

Addrecs | @] hitp e, cimsserver.ci

.asprreport

|x @& = |1 4] U o1t

Preview |

TXO0L.rptereporttemplatefile=

Publish

P oe |8

Return

Rate Report

print
Description Order

Rete  Per  Rsre Zero Resource  Flat
Value thou Conv Cost DecPos  Fees

[T

pise  cPU
Value Comments

Rate Table: STANDARD

Rate Group: 1 - All unassigned rat
Rate: LLYL03 s

Rate Group: 2 - 05/390
Rate; 2001
Rate; 2002
Rate: 2003
Rate; 2032
Rate: 2033
Rate; CREDEAT
Rate; SMF30CET
Rate Group: 3 - 05/390 Tso charges
Rate; 2020
Rate: 2204
Rate; 2021
Rate; 2022
Rate: 034
Rate; 2035
Rate: 2036

&) Dane

| 4 Internet

Figure A-39 « Rate Report Example
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Top Cost Report
File name: RTOPC001
Stored Procedure: CIMSSP_Summary

This report provides the account codes with the highest charges for the parameters
selected. For example, if you type 3 as the TopN parameter, the three account codes with
the highest charges appear (see example Figure A-40 on page A-62). If you leave the
TopN parameter blank, the account codes with the ten highest charges appear.

Drill down:

m Click the Invoice link and a complete invoice for the account code level appears (see
Invoice Report on page A-43).

B Double-click an account code or its corresponding percent or charge and a
breakdown of charges by rate group appears.

Parameters:
m TopN

m Account Code Level

Starting and Ending Account Code

®m From and To Date
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Report Example

2 CIMS Server - Microsoft Internet Explorer

File  Edit View Favorites Tools  Help F-

Qe - ) ¥ B Gh Ooeoch Frroonss @vede @) (- B [ B

Address | @) http: | fuwas, cimsserver. comfreptesec, asp? TopH=38Invoicel evel=18Account CodeStart: boAccountCodestart: countCodeEnd=zzzzzzzzazinbofccountCodeEnd: + | g o Links >
Top 10 Cost Publish Return

| % & @hme o W4 Lo >y o || dh | =

Previen |

[

CIMS Top 3 Cost Report

Account Range: all
Date Range: 6/1/2003 to 6/30/2002

Account % Charges

CC-CIMS Lab, Inc. Laurel 37.59% 40,481.11 Lnvoice =

AA-CIMS Lab, Inc. Roseville 34.99% 37,661.90 Inveice

BB-CIMS Lab, Inc. Gibbsboro 15.68% 16,889.70 Lnvoice

Other Accounts 11.73% 12,633.87

Total 107,686.58

v
~|

&) Dane B mternet

Figure A-40 + Top Cost Report Example
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Top 10 Bar Graph Report
File name: RTOPC002
Stored Procedure: CIMSSP_Summary

This report is similar to the Top Cost Report (see page A-61). However, it provides
accounts codes with the 10 highest charges for the parameters selected and it provides
the data in bar graph as well as table format.

Drill down:

m Click the Invoice link and a complete invoice for the account code level appears (see
Invoice Report on page A-43).

m Double-click an account code or its corresponding percent or charge and a
breakdown of charges by rate code description appears in both bar graph and table
format.

Parameters:
B Account Code Level
m Starting and Ending Account Code

m From and To Date
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Bl Standard Reports

Report Example

Note ¢ In the following example, there are only five account codes for the account
code level selected.

2 CIMS Server - Microsoft Internet Explorer

File Edt View Favorites Tools Help -

Q- O HE G Lo i @ @ 3-8 U3

Address | @] http: | fuwa, cimsserver.com|reptexec, aspPInvaicel evel=1&Accaunt Codestart

boAccountCodeStart: countCodeEnd=zzzzzzzzzzinboAccountCodeEnd=zezzzezz ¥ | |gd o Links

Top 10 Bar Graph Publish Return

| % @& = || W «[ 1t yoroe |

Preview |

CIMS Top 10 Cost Report

AccountRange: All
Date Range: 6/1/2003 to 6/30/2003

Account Charges

@

W cc
[
Oes B
g oo =
O ee
account 5 charges
Ce-cims Lob, Tne. Loarel T Toast.ir Invo
AR-CIMS Lob, T 34.99% 37,681.90
86-CIMS Lob, T 25.68% 16,880.70
0D-CIMS Lab, T 6795 731657
EE-CIMS Lob, Inc. Services £.94% 531730 Inva
Total 107,686.58
v
v
&) Dane | # Internet

Figure A-41 + Top 10 Bar Graph Report Example
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Top 10 Pie Chart Report
File name: RTOPC003
Stored Procedure: CIMSSP_Summary

This report is similar to the Top Cost Report (see page A-61). However, it provides
accounts codes with the 10 highest charges for the parameters selected and it provides
the data in pie chart as well as table format.

Drill down:

m Click the Invoice link and a complete invoice for the account code level appears (see
Invoice Report on page A-43).

m Double-click an account code or its corresponding percent or charge and a
breakdown of charges by rate code description appears in both pie chart and table
format.

Parameters:
B Account Code Level
m Starting and Ending Account Code

m From and To Date
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Bl Standard Reports

Report Example

Note ¢ In the following example, there are only five account codes for the account

code level selected.

2 CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools Help

Qo © BB G Do drroors @ @ 32 8 L3

|x @& |1 «f

Preview |

Address | @) hitp: | fuwa, cimsserver.com|reptexec, aspPInvaicel evel=1&Accaunt Codestart

boAccount Codestart:

Y

CIMS Top 10 Cost Report

Account Range: Al

Date Range: 6,/1,/2003 to 6/30,/2003

Account Charges

countCadeEnd=zzzzzzezzzbcboAccount CodeEnd=zzzzzzzz ¥ | [ Go

Publish

Return

I

B CIMS Lab, Inc. Laurel 37 6%

B CIMS Lab, Inc. Roseville 36.0%

O CMS Lab, Inc. Gibbsboro ~ 15.7%

[0 CMS Lab, Inc_ International ~ B.8%

B CIMS Lab. Inc. Services 4.8%

Total: 100.0%
Account o Charges
CC-CIMS Lab, Ine. Lourel 37.50% a0,481.11
AA-CIMS Lob, Tne. Raseville 34.90% 37,681.90
BB-CIMS Lob, Inc. Gib 15.68% 16,885.70
DD-CIMS Lab, Ine. Int 5.79% 7,316.57

EE-CIMS Lob, Tne. Services 4945 5,317.30 Inuoice

Total

107,686.58

&) Dane

| 4 Internet

Figure A-42 « Top 10 Pie Chart Report Example
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Top Accounts for Rate Report
File name: RTOPC004

Stored Procedure: CIMSSP_Summary

This report provides the account codes with the highest usage of a specified rate code for
the parameters selected. For example, if you type 3 as the TopN parameter, the three
account codes with the highest rate code usage appear (see example Figure A-43 on
page A-67). If you leave the TopN parameter blank, the account codes with the ten

highest rate code usage appear.

Drill down: None

Parameters:

m TopN

m Account Code Level

m Starting and Ending Account Code
m From and To Date

m Rate Code

Report Example

2l CIMS Server - Microsoft Internet Explorer

Fle Edt View Favorites Toos Help >
Q- Q ¥ @& O search S Favories @ veda ) (- ; L3
Address |e;| hittp: v, cimsserver ,com{reptexec. asp?Top+M=3aInwoicel evel=1&Account CodeStart=+achoAccount CodeStark=+&AccountCadeEnd: boficcounkCodsEn V| Beo ks »
Top 10 By Rate Code Publish Return Help Lo
& [l +| [ T of1 #h .
Previen |
a
. E
CIMS Top 3 Accounts for Rate
Account Range: all
Date Range: 6/1 /2003 to 6/30/2002
05/390 Jobs Started
Account Units Rate Charge Y%
AR-CIMS Lab, Ine. Roseville 1,208 250 3,015.00  6Z.52%
BE-CIMS Lab, Inc. Gibbsboro 405 250 101250 21.00%
CC-CIMS Lab, Inc. Laurel 225 2,50 56250  11.66%
Run Total 1,929 4,822.50
o) | 8
b
&) Done B Intemet
|
Figure A-43 « Top Accounts for Rate Report Example
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B Standard Reports

Cost Trend Report
File name: RTRDCO01
Stored Procedure: CIMSSP_Summary_Month

This report provides total charges by account code for each month of the year for the
parameters selected. Monthly charges for each account code are presented on a single
line.

Note ¢ To print this report, use landscape mode on legal paper.

Drill down: None

Parameters:

B Account Code Level

B Report Year

m Starting and Ending Account Code

Report Example

<3 CIMS Seryver, - Microsoft Internet Explorer

Filg Edit View Favorites Tools Help

Qe - ) ¥ B (i Doeweh Fpreonss @vede @) (- L L3

Address [ €] bt [fumw, cmsserver.comreptexcec. asp?InvoiceL evel=1 &aar—20038ccount CodeStart=+BcboAccountCodeStart=-+&Account CodeEnd: bonccountCodef ¥ | B G0 Liks *
Cost Trend Publish Return Help &
& % [0r =] T e b oM oe | &
Preview |
+) CIMS Lab, Inc. Rosevile -~

+] CIM5 Lab, Inc. Gibbsboro
+| CIM5 Lab, Inc. Laurel
+| CIM5 Lab, Inc. International

Cost Trend For 2003

Account Charges by Month
January February March April May June

Af - CIMS Lab, Inc, Roseville

87,382 4,443 82,234 110,604 105,392 37,682
BB - CIMS Lab, Inc. Gibbsboro

28,985 38,709 33,247 71,273 43,058 16,390
CC - CIMS Lab, Inc. Laursl

32,868 53,335 54,213 1,400 111,072 40,451
DD - CIMS Lab, Inc, International

11,080 4,617 3,702 7,323 18,517 7,317
[EE - CIMS Lab, Inc. Services

€103 7,788 6,264 11,550 3,388 5517

[~
|

< |

&) Done ® Intemet
L

Figure A-44 + Cost Trend Report Example
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Cost Trend by Rate Report
File name: RTRDC002
Stored Procedure: CIMSSP_Summary_Month

This report provides total charges by rate code description and rate group for each month
of the year for the parameters selected.

Note ¢ To print this report, use landscape mode on legal paper.

Drill down: None

Parameters:

m Account Code Level

B Report Year

m Starting and Ending Account Code

Report Example

2 CIMS Server - Microsoft Internet Explorer,

Fle Edt View Favorites Toos Help >
Qe - Q¥ @ & ) search ¢ Favarites @ medn ) - L 3
address (@] hitp o, cinsserver com|reptexec  ssp7Involcel evel=1 BYear—2003RAccountC odeStart=+ErboAccountCodeStart=+account CodsEnd=zzazazezastchofccountCodefr | 5 Go  Links ™
Cost Trend by Rate Publish Return Help e
& &7 - M 4 7 oof 7+ > oM dh .
Preview |
# O5{390 Batch A
 O5[390 Tso
1 O5{390 InpULjOLtpuE charges i |
 OS{390 Printer Reader
) 05/390 Storage Al
 O5}390 DEZ
T Cost Trend For 2003
- Unix background -
- Unix storage Rate Charges by Month
- Unix filesystem
# Oracle
- M5 Windows Starage January February March April May June
4 S wWindows Oracle Unix disk /O 3 398 E3 5 8 a0
1 M Windows 5L Server Unix character 1/O 1 3 1 ] ] 0
B LIS Unix image time 174 225 143 343 79 477
- M5 Exchange Unix connect time 51 68 53 112 45 58
1 M5 Windows Processes Unix user CPU! 1 10 3 2 1 1
Unix systemn CPU 1 & 2 7 o 0
Unix total CPU & 41 13 17 3 3
Unix memory 12 B 17 7 34 2
Unix imnage court 869 3,520 1,230 322 120 z38
Unix logins 25 42 #3 24 13 13
Unix interactive job 1,186 8,406 1,539 1,439 303 833
type charges
v
< ) 38 | il L3
v
@ Done B Intemet

Figure A-45 + Cost Trend by Rate Report Example
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B Standard Reports

Resource Usage Trend Report
File name: RTRDROO1
Stored Procedure: CIMSSP_Summary_Month

This report provides total resource usage by rate code for each month of the year for the
parameters selected. This report is ordered by account code, rate group, and rate code.

Note ¢ To print this report, use landscape mode on legal paper.

Drill down: None
Parameters:

m Account Code Level
B Report Year

m Starting and Ending Account Code

Report Example

2 CIMS Server - Microsoft Internet Explorer

File Edt View Favorites Tools Hslp
- IPel o r 3
Q- QO 3@ & ) sesrch Fovorites @ Meds ) =N 3
fcldress | €] hitps e, cimsser ver, comjreptexet. aspPinvaicel evel=1 countCodestart=-+&rboAccountCodeStart=+ &Account CodeEnd=zezzzezzzzicboiceountCodet v | (g G0 Links >
Resource Usage Trend Publish Return Help &
& & = o~ M 4 10 of 14+ [ h .
Preview |
* CIMS Lab, Inc. Roseville ~
* CIMS Lab, Inc. Gibbsboro 7 3
+ [ . Laurel y ] ¥
+ CIMS Lab, Inc. International el 5 =
B by e Servies Resource Usage Trend
Account For 2003
Rate Usage by Month
January February March April May June
GG - CIMS Lab, Inc. Laurel
08/3290 Batch charges
057390 Jobs Started 300 438 324 651 626 225
057390 Steps Started 1,784 3,262 2,479 4,762 4,741 1,680
05/390 Cpu Mintes 357,74 258,30 165.07 35%.54 298,83 148,64
05/390 Cpu Mintes 358,08 260,61 166,73 118,92 314 111
(Initiators)
05/390 Cpu Mindtes 386,90 282,44 179.07 386,33 324,77 161.16
(ally
0S5/390 Tso charges
Tso Cpu Minutes 7.67 7.0 461 8.31 6.83 160
Tso Connect Minutes 5,633.82 16,008, 44 6,259.56 7,115.68 12,004,580 1,555.60
Tso Inputs 24,215 18,840 11,334 20,475 11,344 3577
Tso Outputs 25,208 19,857 13,297 22,838 13,774 4,001
Tso Cpu Minutes (Teb) 3.97
Tso Cpu Minutes 7.75 7.18 469 2,40 012 0.04
(Initiator) a
< >
v
&) Dane ® Intermet
=

Figure A-46 + Resource Usage Trend Report Example
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Standard Reports H

Transaction Report
File name: RTRNX001

Stored procedure: None

This report provides the Miscellaneous, Recurring and Credit, transactions for the
parameters selected. For more information about transactions, see Chapter 6, Using

Transactions.
Drill down: None

Parameters:

® Transaction Type
m Starting and Ending Account Code
® From and To Date

Report Example

2l CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools  Help 'a
Q Back ~ \ﬂ @ ;l /._U Search ¢ Favartes @ media £7) = 3
Address [{€] hitp [fumw, cmsserver.comreptexcec. 3sp?TransactionType=ABiccountCodeStart=+BcboiccountCodeStart=-+&Account CodeEnd: boccountCodeEnd—zzz: ¥ | [Ed G0 Liks *
Transaction Report Publish Return Help Lo
& ¢ [l =) [ T of 1+ > M dh .
Previen |
—~
Transaction Re po rt From Date: 61112003 To Date: 6/30/2003
Recurring Transactions Aot Codss: through 2277227772
Resource Date Start  Date Siop
Account Code Rate Code Amount  Frequency Processing Processing
3434342 3
Z002 051390 Steps Started 0 Bvery quarter, period 2 1102001 1263102199
Hotes: TEst
v
< >
v
&) Done B Intemet
=

Figure A-47 + Transaction Report Example
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B Standard Reports

Cost Variance Report
File name: RVARC001
Stored Procedure: CIMSSP_Variance

This report provides a comparison of charges by account code, rate code description, and
rate group for a specified month and the month prior for the parameters selected.

Drill down: None

Parameters:

m Account Code Level

m Report Month

B Report Year

m Starting and Ending Account Code

Report Example

<3 CIMS Server - Microsoft Internet Explorer

Fle Edt View Favortes Tools Help "

@Back - \ﬂ E" _;_‘, /r“Saarch \f‘\'{Favnntes @ reds £2) - & 3

Address | @&] hktp:ffum.cimsserver.comjreptescec. ssprInvoicel svel=1 &ML astReportingear=21998ML astReportingMonth=128ML astReportingDate=December-+21998GroupType=18 ¥ | g Go  Links

Cost ¥ariance Publish Return Help e
B & =] | M A[ s b Mo &
Preview |
# CIMS Lab, Inc. Roseville ~
+ [EG oro ~ -
+1 CIMS Lab, Ine. Laurel g T
* CIMS Lab, Inc. International Cl Ms 2 »{; T
+ CIMS Lab, Inc, Services e
Cost Variance  june 2003
BB-CIMS Lab, Inc. Gibbsboro
May 2003 Jun 2003 Variance Percent
©5/330 Jobs Started 5,377.50 1,012.50 -4,365.00 -8L17
05/390 Steps Started 2,302.00 426,00 -1,874.00 -BL41
©5/350 Cpu Minutes 4,284.05 2,083.74 -2,200.31 -51.36
057390 Batch charges 11,563.55 3.524.24 ~§,439.31  -70.54
Teo Cpu Mindtes 470,22 60,27 -408.95 -87.18
Teo Connect Minutes 14,938.12 7,455.32 -7,482.80 -50.09
Teo Inputs 214,65 17.39 -19%.26 -9L.90
Tso Qutputs 115.57 9,16 -106.41 -92.07
057390 Tso charges 15,736.56 7.542.14 8,196.42  -52.08
Disk SI0s 923,53 352,93 -576.66 -62.0%
Tape SI0s 1,284.05 679.38 -604.68 -47.09
057390 Input/Output charges 7,213.65 T,032.31 ~1,181.34  -53.37
Input Records 56,85 3312 -23.73 -41.74
057390 Printer/Reader charges $6.85 3312 ~Z3.73  -4L74
- - - _————— [ — _—— -— b
< >
v
&) Dane B Intemet
L

Figure A-48 + Cost Variance Report Example
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Standard Reports H

Cost Variance Drill Down Report
File name: RVARC002

Stored Procedure: CIMSSP_Variance

This report provides a comparison of charges by rate code description and rate group for
a specified month and the month prior for the parameters selected.

Drill down:

m Double-click a rate code description or its corresponding monthly totals, variance, or

percent and a breakdown of data by account code appears.

Parameters:

B Account Code Level
B Report Year

m Report Month

m Starting and Ending Account Code

Report Example

<3 CIMS Server, - Microsoft Internet Explorer

Fie Edt ‘View Favortes Tools Help i
@ Back ~ \ﬂ @ 1) /\', )seatch ¢ Favories @ Meds {§2) - & 3
ficldress | €] hitps s, cimsser ver, comjreptexet. aspPinvaicel evel=1 asth 1995 LastRep h=128MLastReportingDate=December +21998Gr v | g G0 Links >
Cost ¥ariance Drilldown Publish Return Help o
& &%= o~ [ 1oof 1+ [ b .
Preview |
+1 051390 Batch charges -~
+I 054390 Tso charges
[ Input{Output charges) g B
- 054390 Printer/Reader charge , ;
+I 05{390 Storage charges -,
+I 051390 DEZ charges - =
mmeeemeda | COSt Variance Drilldown June 2003
1. Unix background job type chal
+| Unix storage charges May 2002 Jun 2002 Variance Percent
#1 Oracle charges
+1 M5 Windows storage charges ©05/390 Jobs Started 17,212.50 4,822.50 -12,390.00 7198
+ M5 Windaws Oradle charges ©5/390 Steps Started 15,692.50 5,105.00 -10,587.50 67.47
1 M5 Windows SGL Server ©5/390 Cpu Minutes 22,782.16 10,967.63 -11,614.53 5186
M5 115 057590 Gatch charges 55,667.16 70,895.13 T54,752.05  62.48
- M5 Exchange
1 M5 Windows Pracesses Tsa Cpu Minutes 1,097.20 30239 -734.51 72,44
Tso Connect Minutes 36,760.90 11,656.42 -25,102.48 -68.29
Tso Inputs 367.58 67.48 -300.40 -8L.66
Teo Cutputs 208,13 35,59 -172.24 -52.76
To charges EEID J064. 76,369, 8.
057390 Tsa ch 3643411 12,064.18 76,369.93 E8.61
Disk 510s 15,418.22 6,825.54 -5,502.58 5573
Tape 510s 10,278.41 4,734.68 -5,543.73 -53.94
057390 Input/Output charges Z5,696.63 11,560.22 T14,136.41  55.01
Tnput Revords 860,75 AL54 TA58.01 e
057390 Frinter/Reader charges T,660.75 30189 T1,456.51  -78.40
Disk Data Sets 27,841.00 8,431.25 -18,349.75 -63.50
NC 73200 CFavana « F=vnac 77 RA1 NN R/ AQ1 DK -10 =40 75 P ]
< 3 i€
v
ane nternel
2] 0 Inkernet
L

Figure A-49 « Cost Variance Drill Down Report Example
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B Standard Reports

Resource Variance Report
File name: RVARROO1
Stored Procedure: CIMSSP_Variance

This report provides a comparison of resource usage by account code, rate group, and
rate code description for a specified month and the month prior for the parameters
selected.

Drill down: None
Parameters:

m Account Code Level
B Report Year

m Report Month

Starting and Ending Account Code

Report Example

72 CIMS Server, - Microsoft Internet Explorer, r__”'ilg‘
File Edt View Favorites Toos Help &
Q- ©Q ¥ @ & ) search ¢ Favarites @ meda F) - 3
Address [{€] hitpe fumm, cmsserver.comfreptexcec. aspInvoiceL evel=1 ast i 19980 astReporti h—128MLastReportingDate=Decemper+219386r ¥ | [ G0 Links *

Resource ¥ariance Publish Return Help 2
B &l =] | M A s b M o= | &
Preview |
¥ CIMS Lab, Inc. Rosevile ~
% CIM Lab, Inc. Gitbsboro - .
- CIMS Lab, Inc. Laurel (75 &
# CIMS Lab, Inc. International ;lv i
afl Crr A
Resource Variance June 2003
EE-CIMS Lab, Inc. Services
May 2003 Jun 2003 Variance Percent
05/390 Batch charges
©5/330 Jobs Started 123 44 -79 -64.23
051390 Steps Started 3 16 -17 -5L52
©5/330 Cpu Minutes 055 0.0t -0.54 -98.75
05/390 Input/Output charges
Disk 5108 a0z 36 -266 -88.08
05/390 Printer/Reader charges
Input Records 12 2 -10 -83.33
05/390 Storage charges
Disk Dats Sets 16 H -14 -87.50
Unix interactive job type charges
Unix disk /O 5 ks 10 4216
Unix character 1/O 43,906 39,118 -4,785 -10.90
Unix image time 762,42 71412 -48.30 -6.33
Unix connect time 94.20 99,71 551 585 @
< >
v
&) Done B Intemet
=

Figure A-50 + Resource Variance Report Example
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Standard Reports H

Disk Directory Resource Report
File name: RWDKROO1
Stored Procedure: CIMSSP_Detail_Resource

This report provides windows disk storage data for the parameters selected. This data is
taken from the CIMSDetail table.

Drill down: None

Parameters:

m Account Code Level

m Starting and Ending Account Code

®m From and To Date

Report Example

3 CIMS Server - Microsoft Internet Explorer MEE
File Edt View Favorites Toos Help >
. NG . B 3 .
Q- Q ¥ @ % ) gearch ¢ Favarites ) &2 o, .- Y
Address [ ] bt ffummw, cmsserver.com(CrystalReportsInkeractivevisuer. 3sp?CR angeDisplay—Account-+Rangs s+ Alk-Accountsadnvoicel evel=L iccount CodeStart=auiccountCads | (£ Go @
windows Disk Publish Return
2 9P R
CIMSLAB-C
ROCA-SRYL Commen .
ROCA-SRVL Users Disk Directory Resource Report
E-WWwFTP Account Range: All Accounts
Date Range: 11/1/2004 to 11,/30,/2004
N
SERVER FOLDER ACCOUNT
CIMSLAB-C BackupExecData RTM
CIMSLAE-C CatRoot TEL
CIMSLAB-C certsry DEP
CIMSLAE-C clients ONE -
CIMSLAB-C Com cCR
CIMSLAE-C config RTM
CIMSLAB-C dllcache RTM
CIMSLAB-C dns 851
CIMSLAE-C drivers TEL
CIMSLAB-C DTCLog MTG
CIMSLAE-C eHpOrt ONE
CIMSLAB-C GroupPaolicy RTM
CIMSLAE-C iaz ONE
CIMSLAB-C ie_de TEL
CIMSLAE-C inetsry DAC
CIMSLAB-C LLs DEP
CIMSLAE-C Microsoft RTM
CIMSLAB-C mui DEP
CIMSLAE-C HNETMOMN WTH
CIMSLAB-C npp com R
Lo >
&) B Internet

Figure A-51 « Disk Directory Resource Report Example
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B Standard Reports

Account Summary by Week Report
File name: RWEKCO01

Stored Procedure: CIMSSP_Summary_Day

This report provides the total weekly and monthly charges by account code and rate code

description for the parameters selected.

Drill down:

m Double-click the charge for a week and a breakdown of charges by rate code

description appears.
Parameters:
m Account Code Level
m Starting and Ending Account Code
m From and To Date

Report Example

2 CIMS Server - Micrasoft Internet Explorer, ElE‘El
Ez

Fle Edit Wew Favortes Tools Help .
Qe - & [¥] A @ ) search 57 Favorites @ veda €2 - 3
Address @] http:/fmaw.cimsserver comjreptexec. asp?Invoicel evel=1 &AccountCodeStart=+EcboAccountCodeStart=+EAccount CodeEnd: bofceountCodeEnd vIBe ks *
Account Summary by Week Publish Return Help i
& =[x - 1 oft &4 .
Preview |
4 CIMS Lab, Inc. Resevile &l
28 CIMS Lab, Inc, Gibbsboro
# CIMS Lab, Inc. Laurel o Ly =3
4l CIMS Lab, Inc. International ' IMS o A{l by
- CIMS Lab, Inc, Services g i
Account Summary By Week  rrom: 6/1/2003 To: 6/30/2003
Account Charge
AA - CIMS Lab, Inc. Roseville
wWeek of 6/1/2003 to 6/7/2003 20,722.47
Week of 6/8/2003 to 6/14/2003 16,959.43
June 2003 37,681.50
Total for A& - CIMS Lab, Inc. Roseville 37,661.50
[BB - GIMS Lab, Inc. Gibbsboro |
wWeek of 6/1/2003 to 6/7/2003 7,264.62
week of 6/8/2003 to 6/14/2003 9,624,688
June 2003 18,889.70
Total for BB - CIMS Lab, Inc. Gibbsboro 16,889.70
CC - CIMS Lab, Inc. Laurel
week of 6/1/2003 to 6/7/2003 22,443.70 »
< >
~
&) Done & Internet
L

Figure A-52 + Account Summary by Week Report Example
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Standard Reports H

Account Summary by Week—Wide Report
File name: RWEKC002

Stored Procedure: CIMSSP_Summary_Day

This report is similar to the Account Summary by Week report (see page A-76). However,

the weeks are displayed across the top of the page.

Drill down:

m Double-click an account code and a weekly breakdown of charges by rate code

description appears.

Parameters:

m Account Code Level

B Report Year

m Report Month

m Starting and Ending Account Code

Report Example

EIEX

M CIMS Server - Microsoft Internet Explorer

File Edt View Favorkes Tools  Help L
. o D) < . n = LB P
@ ok BREK ) ) searh 57 Favorites @ viedis E2) =Y 3
Links >
Account Summary by Week - Wide Publish Return Help ~
S & =[m | [ 1 of1 L] .
Preview |
- CIMS Lah, Inc, Rosevils ~
& CIMS Lah, Inc, International —
- CIMS Lab, Inc, Services Account Summary By Week
Charges
6/1/2003 €/8/2003 6/15/2003 6/22/2008  &/29/2003 MTD
&7(2003 Af14/2003 E/21/2003 282003 A/30/2003
AA - CIMS Lab, Inc. Roseville
l ! i 51
BB - CIMS Lab, Inc, Gibbsbore
18 15
< - CIMS Lab, Inc, Laurel
W 311 18,451.11
CD - CIMS Lab, Inc. International
1 1,780.1 15
EE - CIMS Lab, Inc. Services
it 5151 1
Report Total 585,238 52,447.68
hd
&/ a2 |4
b
@Dune B Internet

Figure A-53 + Account Summary by Week—Wide Report Example
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B Standard Reports

Account Summary YTD Report
File name: RYTDC001

Stored Procedure: CIMSSP_Summary_Month

This report provides the total monthly and YTD charges by account code, rate group, and

rate code description for the parameters selected.

Drill down:

m Double-click a month or the charge for a month and a breakdown of charges by rate
group appears. Double-click a rate group and a breakdown of charges by rate code

description appears.
Parameters:
B Account Code Level
B Report Year

m Starting and Ending Account Code

Report Example
3 CIMS Server - Micrasoft Internet Explorer, ElE‘El
Fle Edit Wew Favortes Tools Help i
Qe - BEEK ) ) search 57 Favorites @ reda £2) - 3
address | ] httpiffwaw, dimsserver comfreptexec. aspInvoiceL svel=14tear—2003Account CodeStatt—+BcbofccountCodeStart—+ccountCodeEnd bonccountCodet v | [Ed Go  Links *
Account Summary YTD Publish Return Help i
Z &= < 1 oft &4 .
Preview |
Sl civs ~
- CIMS Lab, Inc, Laurel 3 F -
- CIMS Lab, Inc. International ] 4 e
- CIMS Lab, Inc, Services AL 2 LS
Account Summary Year To Date For: 2003
Account Charge
| AA - CIMS Lab, Inc. Roseville
January 2003 87,381.95
February 2003 84,449,22
March 2003 82,234.27
#pril 2003 110,604.39
May 2003 105,202.23
June 2003 37,681.90
¥TD A& - CIMS Lab, Inc. Roseville 507,743.96
BB - CIMS Lab, Inc. Gibbshoro
January 2003 28,984.62
February 2003 36,708.66
March 2002 33,246.62
April 2003 71,272.80
May 2003 43,056.39
June 2003 16,880.70
¥TD BB - CIMS Lab, Inc. Gibbsboro 230,158.79
CC - CTMS | ah. Tne. | aureal ~
< >
~
&) Done B Internet
L

Figure A-54 + Account Summary YTD Report Example
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Standard Reports H

Account Summary YTD-Wide Report
File name: RYTDC002

Stored Procedure: CIMSSP_Summary_Month

This report is similar to the Account Summary YID report (see page A-78). However, the

months are displayed across the top of the page.

Drill down:

m Double-click an account code and a monthly breakdown of charges by rate code

description appears.
Parameters:
m Account Code Level
B Report Year
m Starting and Ending Account Code

Report Example

< CIMS Server - Microsoft Internet Explorer
File Edit  Wew Favorites  Tools  Help

Qe - () |£] @ _:J /:“Search ‘-;'-':.'Favnrites e KRS

£ 3a

EEX
-~

address &) httpiffwaw, dmsserver camiCrystaReportsInteractivelfiewer  asp7IvoiceL evel=18fear=20048ACRangeDisplay=Account-Range

I+ AccounkseAccount Cod

v B @

Publish

Account Summary YTD - Wide

2 99:-PR

- ATM Transactions

- Credit Card

- Commercial Loans

- Drafts and Collections

Account Summary Year To Date
Account Range: All Accounts

Return

DEP - Electronic Deposits Year: 2004
P ear Charges by Month
MTG - Mortgages January | Fabruary | March | April | May |
ONE - Online Electronic Payments
July | August | September | October | November |
RTM - Retirement
551 - Secure Sales - Internet Commeries  A1M ~ ATM Transactlons
TEL - Telephone Transactions 4a154 La035.16
B-WTX - Wire transfers 5515.35 3.545.66 3784.67 LETTES 216580
CeR - Credit Card
21,502.93 2,752.96
14,506.59 16,230.61 FL165.69 156.833.82 T2518.74
COM - Commarcial Loans
223.07 5.654.88
23,111.3% F2,547.45 22,371.70 EEEED 13,572.54
DAC - Drafts and Collections
12,38 6,965.24
3,686.41 4,373.21 4,765.68 6,410,168 3,0233.32
DEP - Electronic Deposits
58720 5.636.53 it
G | 2
[&) B Internet

Figure A-55 + Account Summary YTD—Wide Report Example

CIMS Server Web Reporting User’s Guide

A-79 N



B Standard Reports

Spreadsheets

This section describes the CIMS Server spreadsheets. When you run a spreadsheet, CIMS
Server Web Reporting presents the report data in Microsoft Excel. In addition to viewing
the report in the Web browser, you can also save the spreadsheet as an Excel or other file
or publish the report for all users. For more information, see Working With Spreadsheets
on page 3-9. You must have Excel installed on the client running the spreadsheet.

Invoice Spreadsheet

B A-80

File name: SINVC001

Stored Procedure: None

This spreadsheet provides invoice information for the parameters selected.
Drill down: None

Parameters:

m Account Code Level

m Starting and Ending Account Code

m From and To Date

Report Example

2 CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools  Help
Qoo - BREEAIPeE Fovorites @ Meda ) = 3
Address | @] http: | fuwa, cimsserver.comreptexec, asp?Invaicel evel=1&Accaunt CodeStart boAccountCodestart: countCodeEnd=CCRchoAccountCodeEn: ¥ a Go  Links >
Spreadsheet Invoice * Return
H30 - £/15£2003
A B € D E F G H 1 J
1 | AccountWame AccountCode RateCode RateDescripti RateGroup  GroupTitle StartDate EndDate Resourcelnits RateValue Per s
2 CIMS Lab, IniAA Zool 0S5/390 Jobs 2 05/390 Batch 6/1/2003 6/30/2003 1,452.00 2.50
3 | CIMS Lab, IntAA Zooz 05/390 Steps 2 05/390 Batch 6/1/2003 6/30/2003 7,135.00 0.50
4 CIMS Lab, IniAA Z003 0S5/390 Cpu f 2 05/390 Batch 6/1/2003 6/30/2003 314.29 20.00
5 | CIMS Lab, IntAA Z032 05/390 Cpu § 2 05/390 Batch 6/1/2003 6/30/2003 3.44 0.00
6 CIMS Lab, IniAA Z033 0S5/390 Cpu f 2 05/390 Batch 6/1/2003 6/30/2003 357.27 0.00
7 | CIMS Lab, IntAA Zoz0 Tso Cpu Miny 3 05/390 Tso 6/1/2003 6/30/2003 9.9z 25.00
8 CIMS Lab, IniAA ZZ04 Tso Cannect | 3 05/390 Tso 6/1/2003 6/30/2003 16,218.45 0.25
9 | CIMS Lab, IntAA Z0z1 Tso Inputs 3 05/390 Tso 6/1/2003 6/30/2003 29,003.00 200 M
10 |CIMS Lab, IriAA Z022 Tso Qutputs 3 05/390 Tso 6/1/2003 6/30/2003 30,826.00 1.00 M
11 |CIMS Lab, Ini A& Z035 Tso Cpu Miny 3 05/390 Tso 6/1/2003 6/30/2003 011 0.00
12 |CIMS Lab, IniAA Z036 Tso Cpu Minu 3 05/390 Tso 6/1/2003 6/30/2003 10.60 0.00
13 |CIMS Lab, Ini A& 2005 Total S10s 5 05/390 Input 6/1/2003 6/30/2003 26,625,572.00 000 M
14 |CIMS Lab, IriAA 2006 Disk SI0s 5 05/390 Input 6/1/2003 6/30/2003 16,325,356.00 0.25 M
15 |CIMS Lab, Ini A& Z007 Tape SI0s 5 05/390 Input 6/1/2003 6/30/2003 10,300,216.00 035 M
16 |CIMS Lab, IniAA Z014 Input Record: 6 05/390 Printe 6/1/2003 6/30/2003 386,100.00 1.00 M
17 |CIMS Lab, Ini A& ZZ0% Tape Mounts 7 05/390 Stora 6/1/2003 6/30/2003 1,992.00 0.00
18 |CIMS Lab, IniAA ZZ06 Disk Data Sel 7 05/390 Stora 6/1/2003 6/30/2003 18,375.00 0.25
19 |CIMS Lab, Ini A& ZZ33 DBZ Transact 10 ©5/390 DB2 6/1/2003 6/30/2003 17.00 0.0z
20 CIMS Lab, IriAA 2734 OB2 Transact 10 0S/390 DBZ 6/1/2003 6/30/2003 0.27 015
21 |CIMS Lab, Ini A& LLALOL Unix disk 1/0 12 Unix interacti: 6/1/2003 6/30/2003 44,38 0.10
22 |CIMS Lab, IniAA LLalnZ Unix characte 12 Unix interacti- 6/1/2003 6/30/2003 17,502.97 0.00 M
23 |CIMS Lab, Ini A& LLALDZ Unix image tit 12 Unix interacti: 6/1/2003 6/30/2003 17471 0.038
24 |CIMS Lab, IriAA LLAln4 Uniz connect 12 Unix interacti- 6/1/2003 6/30/2003 362.80 0.10
25 |CIMS Lab, Ini A& LLALDS Unix user CPL 12 Unix interacti: 6/1/2003 6/30/2003 18.79 0.01
26 |CIMS Lab, IniAA LLALO6 Uniz systern 12 Unix interacti- 6/1/2003 6/30/2003 317 0.02
27 |CIMS Lab, Ini A& LLALD? Unix total CPL 12 Unix interacti: 6/1/2003 6/30/2003 21.98 0.03
28 |CIMS Lab, IniAA LLA10B Uniz mernory 12 Unix interacti- 6/1/2003 6/30/2003 1,724,530.10 0.00 M
29 [CIMS Lab, Ini A& LLALDS Unix image cc 12 Unix interacti: 67142003 6/30/2003 7.,260.00
14 «[» M} SINVCOOL.rpt / |4
&) Done 0 Internet

Figure A-56 + Invoice Spreadsheet Example
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Run Total Invoice Spreadsheet
File name: SINVC002

Stored Procedure: None

This spreadsheet provides total invoice information by rate code for the parameters

selected.

Drill down: None

Parameters:

m Starting and Ending Account Code

m From and To Date

Report Example

icrosoft Internet Explorer

Fle Edt View Favortes Tools Help
[EE ¥ @] 0| O sench Slpravories @vedo ) - & 3
& http: Jumawn cimsserver.c .aspPAccountCodestart=+&choAccountCodesta d boaccountCodeEnd: =920at v | |z G0 >
Run Total Return
F43 hd 6/30/2003
A B 5 D E F G H .
1 |RateCode  RateDescription RsteGroup  GroupTitls StartDate  EndDate  Resourcelnits  RateValue  Per 1000
2 |zooy ©05/390 Jobs Started 2 03/390 Batch 6/1/2003  £/30/2003 2,649.00 250
3 |zo02 05/390 Steps Started 2 03/390 Batch 6/1/2003  5/30/2003 13,398.00 0.50
4 |zoo3 O5/390 Cpu Minutes 2 05/390 Batch 6/1/2003  £/30/2003 598,22 2000
5 |zo32 05/390 Cpu Minutes (Initistors) 2 03/390 Batch 6/1/2003  5/30/2003 5.05 0.00
6 |zo33 ©O5/390 Cpu Minutes (All} 2 05/390 Batch 6/1/2003  £/30/2003 860,28 0.00
7 |zoz0 Tso Cpu Minutes 3 05/390 Tso 6/1/2003  5/30/2003 1651 25.00
& |zzo4 Tso Connect Minutes 3 05/390 Tsa 6/1/2003  £/30/2003 52,707.13 .25
9 |zoz1 Tsao Inputs 3 05/390 Tso 6/1/2003  5/30/2003 52,912.00 2.00 M
10 zozz Tso Outputs 3 05/390 Tsa 6/1/2003  £/30/2003 56,395.00 100 M
11 |z035 Tsa Cpu Minutes (Initiator) 3 05/390 Tso 6/1/2003  5/30/2003 0.25 0.00
12 |zo36 Tso Cpu Minutes (All} 3 05/390 Tsa 6/1/2003  £/30/2003 18.10 0.00
13 |zoos Tatal 5105 5 03/390 Input/Output charass 6/1/2003  6/30/2003  43,176,613.00 0.00 M
14 |zooe Disk 5105 5 05/390 Input/Output charges 6/1/2003  &/30/2003  33,381,169.00 025 M
15 | z007 Tape 5105 5 03/390 Input/Output charass 6/1/2003  6/30/2003  15,735,444.00 035 M
16 2014 Input Records & 0S/390 Printer/Reader 6/1/2003  £/30/2003 429,266.00 100 M
17 |zz05 Tape Maunts 7 03/390 Storage 6/1/2003  5/30/2003 2,509.00 0.00
16 |zz06 Disk Data Sets 7 054390 Sterage 6/1/2003  £/30/2003 47,330.00 .25
19 2233 DB2 Transactions (Records) 10 05/330 DB2 6/1/2003  5/30/2003 17.00 0.02
20 |zz34 DEBZ Transaction Elapsed Minutes 10 05/390 DBZ 6/1/2003  £/30/2003 027 015
21 |LLatot Unix disk 1/0 12 Unix interactive 6/1/2003  5/30/2003 400.60 0.10
22 |LLAL0Z Unix character 170 12 Unix interactive 6/1/2003  £/30/2003 101,519 50 000 M
23 |LLAl03 Unix image time 12 Unix interactive 6/1/2003  5/30/2003 5,296.13 0.09
24 |LLAL04 Unix connect time 12 Unix interactive 6/1/2003  £/30/2003 612,98 0.0
25 |LLALOS Unix user CPU 12 Unix interactive 6/1/2003  5/30/2003 30,50 0.01
26 |LLALOE Unix system CPU 12 Unix interactive 6/1/2003  £/30/2003 13.97 ooz
27 |LLao? Unix tatal CPU 12 Unix interactive 6/1/2003  5/30/2003 10446 0.03
26 |LLAL0S Unix memary 12 Unix interactive 6/1/2003  £/30/2003 3,532,685.27 000 M
29 |LLAL09 Unix image count 12 Unix interactive 6/1/2003  5/30/2003 11,308.00 0.02
14 4[> [ WM SINVCOD2.rpt o [« ’
&) Done B Intemet
=

Figure A-57 + Run Total Invoice Spreadsheet Example
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B Standard Reports

Invoice by Rate Group Spreadsheet
File name: SINVC003

Stored Procedure: None

This spreadsheet provides invoice information for the rate codes within a selected rate

group for the parameters selected.

Drill down: None

Parameters:

m Account Code Level

m Starting and Ending Account Code
m From and To Date

B Rate Group

Report Example

CIMS Server - Microsoft Internet Explorer

Return

Links **

H

J

K—

EndDate Resourcelnits  RateVslue Per lﬂﬂé
6/30/2003 26.00 0.80
6/30/2003 153.33 0.25
6/30/2003 7,997.80 1.00 ™
6/30/2003  5,358,022.34 0.00 M
6/30/2003 £7,352,426.64 0.00 ™M
6/30/2003 26,124.24 0.20 MW
6/30/2003 40,118.17 0.80 ™M
6/30/2003  6,427,025.70 0.00 M
6/30/2003 187,653.35 0.06 ™M
6/30/2003 187,976.72 0.00

B A-82

® Tnternst

Fle Edt View Favortes Tools Help
Qe - © ¥ @ @ ) search ¢ Favories @ ede €2 A= L3
ailhess @] bt . cimsssrvs . comjrapkescer . sspPInoicel svsl—] BACeoUNECareSkart—+furbiAreoUntCadeSkart—+ e caunkCodsEnd bofccountCodeEnd v| B
Spreadsheet Invoice by RateGroup
A B [ D E F G
1 | Accounthame AccountCode RateCode  RateDescription EsteGroup GroupTitle  StartDate
2 |CIMS Lab, IniBE LLw101 s Windews Oracle lagins 24 MS windows | £/1/2003
3 |CIMS Lab, TniBE w102 MS Windows Oracle session 24 M3 windows | 5/1/2003
4 |CIMS Lab, IntBE LLw103 MS Windows Oracle connect 24 MS windows | £/1/2003
§ |CIMS Lab, TniBE w104 MS Windows Oracle uga met 24| MS Windows | &/1/2003
G |CIMS Lab, IniBE LLW105 WS Windows Oracle pga mer 24 MS windows | £/1/2003
7 |CIMS Lab, TniBE w108 MS Windows Oracle physical 24| MS Windows | &/1/2003
& |CIMS Lab, IniBE LLw109 WS Windows Oracle physical 24 MS windows | £/1/2003
9 |CIMS Lab, TnBE Lwiin MS Windows Oracle write re: 24 M3 windows | 5/1/2003
10 |CIMS Lab, IniBB w11z MS Windows Oracle messagi 24 MS windows | £/1/2003
11 |CIMS Lab, IniBB w113 MS Windows Oracle messaqi 24| MS Windows | &/1/2003
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
14 4[> [ W SINVCOOZ.rpt / [4]
&) Done
=

Figure A-58 + Invoice by Rate Group Spreadsheet Example
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Standard Reports H

Invoice by Account Code Spreadsheet

File name: SINVC004

Stored Procedure: CIMSSP_Summary

This spreadsheet provides invoice information by account code for the parameters
selected.

Drill down: None

Parameters:

B Account Code Level

m Starting and Ending Account Code

®m From and To Date

Report Example

icrosoft Internet Explorer

Fle Edt View Favortes Tools Help ]
[EE \ﬂ E" ) ) ssarh 57 Favorites @ Media 4£2) - & 3
&) http:Jwmawn cimsserver..com|reptexec. aspPInvaicel evel=4&Accaunt Codestart boaccountCodestart: countCodeEnd: boAccountCodeEnd - .Gn >
Return
05038 hd £/30/2003
A B C D E J K L [} ] 0 =
1 | AccountCode Division Department  User Other RoteCode  RateDescripti RsteGroup  GroupTitle  StertDate  EndDate
2 ARAAAAKK TEAA AAARA KK IBMUSER 2733 DBZ Transact 10 05/330 DB2  6/1/2003 6730/
3 [ARARARKK IEAR ABAA KK IBMUSER zz34 DBZ Transact 10 05/390 DBZ  6/1/2003  6/30/.
4 |ARARAAKKRG AR BAAA KK hobbes / LLR101 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
5 AAAAAAKKhD AR ABAA KK hobbes / LLR10Z Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
B |ARAAAAKKNG AR BAAA KK hobbes / LLR103 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
7 AAAAAAKKhD AR ABAA KK hobbes /home LLR101 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
8 |ARARAAKKNG AR BAAA KK hobbes /hame LLR1DZ Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
9 ARAAAAKKhD AR ABAA KK hobbes /home LLR103 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
10| ARAAARKKNG Ak BAAA KK hobhes /opt LLR101 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
11 | AARARAKKHD AA ABAA KK hobbes /opt LLR10Z Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
12 | ARARARKKDG Ak BAAA KK hobhes /opt LLR103 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
13 | ARRAAAKKHO AA ABAA KK hobbes /mp LLR101 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
14 | ARARABKKDG Ak BAAA KK hobbes /Amp LLR1DZ Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
15 | AARAAAKKHO AA ABAA KK hobbes /mp LLR103 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
16 | ARAAABKKNG Ak BAAA KK hobhes fusr LLR101 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
17 | AARARAKKHO AA ABAA KK hobbes /usr LLR10Z Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
18 | ARARARKKNG Ak BAAA KK hobhes fusr LLR103 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
19 | AARAAAKKHD AA ABAA KK hobbes /var LLR101 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
20 | ARAAARKKNG AR BAAA KK hobbes fvar LLR1DZ Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
21 | AARARAKKHO AA ABAA KK hobbes /var LLR103 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
22 | ARARABKKhG AR BAAA KK hobbes adm LLD101 Unix Black we 15 Unix storage  6/1/2003  6/30/,
23 | AARAAAKKHO AA ABAA KK hobbes arsap LLD101 Unix Block we 15 Unix storage  6/1/2003  6/30/.
24 | ARARARKKNG AR BAAA KK hobbes belayton LLD101 Unix Black we 15 Unix storage  6/1/2003  6/30/,
25 | AARARAKKHO AA ABAA KK hobbes bin LLD101 Unix Block we 15 Unix storage  6/1/2003  6/30/.
26 | ARAAAAKKDG AR BAAA KK hobbes daeman LLD101 Unix Black we 15 Unix storage  6/1/2003  6/30/,
27 | AARARAKKHO AA ABAA KK hobbes george LLa10Z Unix characte 12 Unix interactic  6/1/2003  6/30/.
28 | ARAAARKKNG AR BAAA KK hobbes gearge LLA103 Unix image tit 12 Unix interactis  6/1/2003  6/30/,
29 | AARARAKKHO AA ABAA KK hobbes george LLA104 Unix connect 12 Unix interactic  6/1/2003  6/30/2 —
14« » MM SINVCOD4.pt / [] . N
v
€] Done 4 Internet

Figure A-59 « Invoice by Account Code Spreadsheet Example
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B Standard Reports

Proration by Total Amount Spreadsheet

B A-84

File name: SPERX001
Stored Procedure: CIMSSP_Summary

This spreadsheet enables you to prorate an amount that you enter as a parameter across
account codes. The percentage prorated to each account is based on the total charge
incurred by the account. That is, the higher the total charge for an account, the higher the
percentage of the prorate amount that is assigned to that account.

Drill down: None
Parameters:
B Account Code Level

B Prorate

Starting and Ending Account Code
B From and To Date
Report Example

In the following example, $100,000 is prorated across accounts for the parameters
selected.

A CIMS Server - Microsoft Internet Explorer, @@@
Ty
€

File Edit View Favorites Tools Help

@ ook - \ﬂ E" ) ) ssarh 57 Favorites @ Meda ) - & 3

Address | @] http: | fuwan. cimsserver.com|reptexec, aspPInvaicel evel=1 countCodeStart=+&rhboAccountCadeStart=+&AccountCodeEnd: boaccount ¥ aGn Links >

Proration by Tatal Amount Open with Publish Return
Excel

1 |Account Range: All I

2 Date Range: 6/1/2003 to 6/30/2003

3

4 Account Code Account Name Charges Percent Prorated Amount

5 A4 CIMS Lab, Inc. Roseville 68,224.31 35.77% 35,765.95

6 BB CIMS Lab, Inc. Gibbsbaro 43,92241 17.81% 17,806.05

7 cc CIMS Lab, Inc. Laurel 62,184.32 33.32% 33,317.35

& oD CIMS Lab, Inc. International  18,038.30 7.31% 7,312.69

9 EE CIMS Lab, Inc. Services 14,301.8% 5.80% 5,797.96

10 |Run Total 246,671.23 100% 100,000.00

1

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

26 |

29 i
14 4 » [ M} SPERXODL.rpt |«] B[

v

&) Done B Intemet
=

Figure A-60 + Proration by Total Amount Spreadsheet Example
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Standard Reports H

Proration by Rate Code Spreadsheet

File name: SPERX002

Stored Procedure: CIMSSP_Summary_RateCode

This spreadsheet is similar to Proration by Total Amount report (see page A-85) except
that the prorate amount is applied by account code to the rate code that you select.

Drill down: None
Parameters:
B Account Code Level

B DProrate

Starting and Ending Account Code
® From and To Date
m Rate Code

Report Example

In the following example, $50,000 is prorated across accounts charged for the rate code

7006 for the parameters selected.

A CIMS Server - Microsoft Internet Explorer, @@S‘
Ty
ol

File Edit View Favorites Tools  Help

@ ook - ¥ B @0 O sench Slpravories @Mvedo €2) - &5 LJ &

Adddress | &) hitps s, cimsserver, comreptexet. aspPinvaicel evel=1 countCodeStart=+Ecbofccount CodeStart=-+&ccount CodeEnd=zzazezzazaticboaccountc v | [E G0 Links

Open with Publish

Erneel Return

Proration by Rate Code

Account Range: All
Date Range: 6/1/2003 to 6/30/2003
7006-Disk S10s

#Account Code #Account Name Charges Percent Prorated Amaount
LY CIMS Lab, Inc. Roseville 7,344.72 43.36% 21,678.91
B CIMS Lah, Inc. Gibbshoro 975.22 5.76% 2,878.49
cc CIMS Lab, Inc. Laurel 5,919.47 34.34% 17,472.10
9 oD CIMS Lab, Inc. International 2,700.33 15.94% 7,970.38
10 |[EE CIMS Lab, Inc. Services 0.04 0.00% 012
11 |Run Total 16,939.78 100% 50,000.00
12
13
14
15
16
17
18
14
20
21
22
23
24
25
26
27
28

@~ | e ra =

29
1 4 [¥ [N\ SPERX00Z.rpt / [«

&) Done ® Internet

Figure A-61 + Proration by Rate Code Spreadsheet Example
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B Standard Reports

Proration by Rate Group Spreadsheet

File name: SPERX003

Stored Procedure: CIMSSP_Summary_RateGroup

This spreadsheet is similar to Proration by Total Amount report (see page A-85) except
that the prorate amount is applied by account code to the rate group that you select.

Drill down: None
Parameters:
B Account Code Level

B DProrate

®m From and To Date

® Rate Group

Report Example

Starting and Ending Account Code

In the following example, $30,000 is prorated across accounts charged for rate codes
belonging to the rate group OS/390 Input/Output charges for the parameters selected.

A CIMS Server - Microsoft Internet Explorer, @@@
Ty
€

) ssarch 7 Favorites @ wedia 2 - iz 3

countCodeStart=+Ecbofccount CodeStart=-+&ccount CodeEnd=zzazezzazaticboaccountc v | [E G0 Links

Open with
Excel

Publish Return

Inc.
Inc,
Inc.
Inc,
Inc.

File Edit View Favortes Tools  Help
@ ook - EREK o)
Address | @] http: | fuwan. cimsserver.com|reptexec, aspPInvaicel evel=1
Praration by Rate Group
1 Account Range: All
2 |Date Range: 6/1/2003 to 6/30/2003
3 0S8/390 Input/OQutput charges
4
5 |Account Code #Account Name
B A4 CIMS Lab,
7 BB CIMS Lah,
8 CC CIMS Lab,
9 oD CIMS Lah,
10 |EE CIMS Lab,
11 |Run Total
12
13
14
15
16
17
18
14
20
21
22
23
24
25
26
27
28
29
14 4[» W]\ SPERXDD3.rpt /
&) Done

Charges Percent Prorated Amaount

Roseville 14,179.56 50.87% 15,290.46
Gibbshoro 2,669.80 9.60% 2,878.97
Laurel 8,215.39 29.53% ,858.02
International 2,755.62 9.91% 2,871.51
Services 0.04 0.00% 0.04
27,820.41 100% 30,000.00

0 Internet

Figure A-62 + Proration by Rate Group Spreadsheet Example
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Standard Reports H

Top 10 Accounts for Rate Spreadsheet
File name: STOPC004
Stored Procedure: CIMSSP_Summary_RateCode

This spreadsheet provides the account codes with the highest usage of a specified rate
code for the parameters selected. For example, if you type 3 as the TopN parameter, the
three account codes with the highest rate code usage appear (see example Figure A-63).
If you leave the TopN parameter blank, the account codes with the ten highest rate code
usage appear.

Drill down: None
Parameters:
m TopN

B Account Code Level

Starting and Ending Account Code
m From and To Date
m Rate Code

Report Example

2 CIMS Server, - Microsoft Internet Explorer

File Edit View Favorites Tools  Help u

Qe - © ¥ @ & ) search 5 Favortes @ veda £2) = 3

Open with Publish Return
Excel

Top 3 Accounts for Disk SIOs

Account Range: All

Date Range: 6/1/2003 to 6/30/2003

Account Units Rate Per 1000 Charge )

AR-CIMS Lab, Inc. Rosevills 16,564,291 0.25 /M 4,141.00 48.48%
CC-CIMS Lab, Inc. Laurel 13,183,149 0.25 /M 3,290.79 38.53%
DD-CIMS Lab, Inc. International 2,485,674 0.25 /M (23.94 7.30%

@ | | e ra =

9
10 Run Total 34,167,178 8,541.66
1
12
13
14
15
16
17
18
149
20
21
22
23
24
25
26
27
28
29

4« » MM STOPCOD4.1pt || . N

&) Done D Internet

Figure A-63 + Top 10 Accounts for Rate Spreadsheet Example
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B Standard Reports

Account Summary Week Spreadsheet
File name: SWEKC001

Stored Procedure: None

This spreadsheet provides account summary weekly information by account code for the

parameters selected.

Drill down: None

Parameters:

m Account Code Level

B Report Year

m Report Month

m Starting and Ending Account Code

Report Example

2 CIMS Server - Microsoft Internet Explorer
Fle Edt View Favorites Tools Help i
@ sk - %] @] | O seach e Favories @ ede £2) = 3
&) hitp [, cinsserver. comreptexec. aspPlnvoiceL evel=1 st 1998MLastRep h—128M_astReportinaDate=December+21598Gre ¥ | [ Go >
Spreadsheet Account Summary Week e path Publish Return Help &
K30 hd
A B [ D E F G H | J K L =
1 |AccountCods Accountilame RateDescripti - 6/1/2003 - 6/ 6/6/2003 - 6/ 6/15/2003 - £6/22/2003 - € 6/29/2003 - € MTD =
ah CIMS Lab, Int05/390 Jobs Started 171000 1,732.50 187.50 3,630.00
3 aa CIMS Lab, Tni 05/390 Steps Started 1,703.00  1,750.50 114.00 3,567.50
4 aa CIMS Lab, In05/390 Cpu Minutes 1,336.29  4,642.60 307.15 5,286.04
5 A CIMS Lab, Tn105/390 Cpu Minutes (Initial 0.00 0.00 0.00 0.00
6 A CIMS Lab, 1n05/390 Cpu Minutes (all} 0.00 0.00 0.00 0.00
7 A CIMS Lab, TniTso Cpu Minutes 123.83 100.34 23.75 247.92
& A CIMS Lab, IniTso Connect Minutes 2,553.55  1,611.55 389.55 4,554.65
9 aa CIMS Lab, TniTso Inputs 3102 20,01 6.98 58.01
10 | ah CIMS Lab, IntTso Outputs 16.39 10.60 3.94 30.93
11 |an CIMS Lab, TniTso Cpu Minutes (Initiator) 0.00 0.00 0.00 0.00
12 |an CIMS Lab, IntTso Cpu Minutes (All} 0.00 0.00 0.00 0.00
13 A4 CIMS Lab, TniTotsl 5105 0.00 0.00 0.00 0.00
14 |an CIMS Lab, IntDisk S10s 1,938.87  1,823.76 318.66 4,081.29
15 |AA CIMS Lab, TniTape 5105 162629  1,817.30 16142 3,605.01
16 |AA CIMS Lab, IntInput Recards 288.81 sz.62 14.62 386.05
17 |an CIMS Lab, TniTape Maunts 0.00 0.00 0.00 0.00
18 |AA CIMS Lab, IntDisk Data Sets 2,258.75  2,178.00 307.00 4,743.75
19 |An CIMS Lab, TnDB2 Transactions (Records) 0.26 0.26
20 | an CIMS Lab, InDEZ Transaction Elapsed Minutes 0.04 0.04
21 |an CIMS Lab, TnMS Windows Disk Size in Mi 0.00 0.00 0.00 0.00
22 |an CIMS Lab, InMS Windaws Humber of File 0.0z 0.07 0.01 .10
23 |an CIMS Lab, TniMS Exchangs Bytes Sent 1246 5.49 0.01 17.96
24 |an CIMS Lab, InMS Exchange Emails Sent 0.00 0.00 0.00 0.00
25 |An CIMS Lab, TnMS Exchange Bytes Receive  433.63 209.07 1.37 644.07
26 |AA CIMS Lab, InMS Exchange Emails Receiy 0.00 0.00 0.00 0.00
27 |an CIMS Lab, TnMS Windows Elapsed Time i 0.00 0.00 0.00 0.00
I CIMS Lab, InMS Windaws CPU Time in st 0.00 0.00 0.00 0.00
29 |an CIMS Lab, TnMS Windows Kernel CPU Tir 0.00 0.00 0.00 0.00 —
14 4[> [ v\ SWEKCOO 1.t / [4]
&) Done B Intemet
=

Figure A-64 + Account Summary Week Spreadsheet Example
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Standard Reports H

Account Summary YTD Spreadsheet
File name: SYTDC001

Stored Procedure: None

This spreadsheet provides account summary YID information by account code for the

parameters selected.

Drill down: None

Parameters:

® Account Code Level

B Report Year

m Starting and Ending Account Code
Report Example

File Edit View Favorites Tools  Help

Qe - ) ¥ B (i Ooeweh Gproonss @hvede &) (- 1L L3

[EIX]
'l'.

ZA CIMS Server - Microsoft Internet Explorer E

Address | &) http: e cimsserver.com|reptexec, aspPInvaicelevel=1

Spreadsheet Account Summary YTD Esf:l with Publish

K35 - =

Return

countCadestart=+&rboAccountCodeStart=+ &Account CodeEnd=zzzzzezazzicboAccauntCodeEr ¥ Go  Links

Help

A B C D E F G H

1 Accountcode AccountName January  Fehruary March April May June
2 An CIMS Lah, Inc. Roseville 87,381.95 84,449.22 82,234.27 | 110,604.39  105,392.23 45,536.00
3 BB CIMS Lab, Inc. Gibbsboro 28,984 62 36,708 .68 33,248 .62 71,272.80 43,056.39 20,785.13
4 ccC CIMS Lah, Inc. Laurel 32,868.42 53,335.49 54,213.12 81,399.72 | 111,072.43 50,272.32
5 DD CIMS Lab, Inc. International 11,079.73 4,617 .21 3,701.59 7,322.87 18,517.00 9,488.55
G EE CIMS Lab, Inc. Services ,192.87 7,787,864 6,26357  11,549.7F 9,366.33  10,187.56
7

8

k]

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

1€ 4 p MM\ SYTDCODLrpt / [«

July

J K
August Septe™

bt

»

A

v

&) Done

B Internet

Figure A-65 + Account Summary YTD Spreadsheet Example
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B Standard Reports

Account Summary YTD by Rate Spreadsheet
File name: SYTDC002
Stored Procedure. None

This spreadsheet provides account summary YID information by rate code description
for the parameters selected.

Drill down: None
Parameters:

m Account Code Level
B Report Year

m Starting and Ending Account Code

Report Example

rosoft Internet Explorer

File Edt View Favorites Tools  Help d
(€ BREEAIPeE Fovorites @ Meds ) - & 3
Address | &) http: | fuwan cimsserver.com|reptexec, aspPInvaicel evel=1 countCodeStart=+&rhboAccountCadeStart=+&AccountCodeEnd: boaccountCodeEr ¥ aGn Links >

Spreadsheet Summary YTD by Rate pulult LIATE Return
Al AccountCode
B c D E F G H | J

1 |AccountCode lAccountiame RateDescription Year January  Fehruary March April May June

S CIMS Lab, Ine. 057390 Iobs Startsd 2003 5,307.50 7,767 .50 5,122.50 7,357.50 9,247 .50 3,630.00

3 an CIMS Lab, Inc. 0S/390 Steps Started 2003 4,348.50 £,503.00 4,788.50 6,428.00 7,711.50 3,567.50

4 an CIMS Lab, Ine. 05/390 Cpu Minutss 2003 14,757.02 9,789 .66 5,601.56 15,661.30 | 11,627.59 6,266.04

5 AA CIMS Lab, Inc. 0S/390 Cpu Minutes (Initiators) 2003 0.00 0.00 0.00 0.00 0.00 0.00

B At CIMS Lab, Inc. 05/390 Cpu Minutes (All} 2003 0.00 0.00 0.00 0.00 0.00 0.00

7 AA CIMS Lab, Inc. Tse Cpu Minutes 2003 251.45 247.29 153.03 344,31 456.26 247.92

5 an CIMS Lab, Inc. Tso Connect Minutes 2003 7,631.06 7,037.75 6,32541 | 1571642 | 18,621.58 4,554 65

9 Ah CIMS Lab, Inc. Tso Inputs 2003 £3.99 66.21 32.48 76.38 130.50 58.01

10 A CIMS Lab, Inc. Tso Qutputs 2003 39.98 4z2.02 23.79 48,16 78.78 30.93

11 a4 CIMS Lab, Ine. Tso Cpu Minutes {Tch) 2003 0.00

12 [an CIMS Lab, Inc. Tsa Cpu Minutes (Initiator) 2003 0.00 0.00 0.00 0.00 0.00 0.00

13 A4 CIMS Lab, Inc. Tso Cpu Minutes (All) 2003 0.00 0.00 0.00 0.00 0.00 0.00

14 [an CIMS Lab, Inc. Total S10s 2003 0.00 0.00 0.00 0.00 0.00 0.00

15 A4 CIMS Lab, Inc. Disk SIOs 2003 18,905.60 7,202.18 | 18,071.58  11,849.47 £,138.79 4,081.29

16 |[An CIMS Lab, Inc. Tape S10s 2003 5,470.00 4,928.77 5,590.77 | 1340529 6,267.71 3,605.01

17 a4 CIMS Lab, Inc. 3390 S10's 2003 0.00

18 A CIMS Lab, Inc. 3380 S10's 2003 0.00

IEREYS CIMS Lab, Inc. 3375 S10's 2003 0.00

20 A CIMS Lab, Inc. 3480 S10's 2003 0.00

21 |aa CIMS Lab, Inc. 3420 S10's 2003 0.00

22 |an CIMS Lab, Inc. Virtual SI0's 2003 0.00

23 A CIMS Lab, Inc. Input Records 2003 660.32 696,66 597.39 621.03 1,798.41 386.05

24 |an CIMS Lab, Inc. Tape Mounts 2003 0.00 0.00 0.00 0.00 0.00 0.00

25 |AA CIMS Lab, Inc. Disk Data Sets 2003 6,434.25 5,769.00 6,058.25 8,767.50 | 10,739.75 4,743.75

26 |An CIMS Lab, Inc. DBZ Transactions (Records) 2003 052 052 0.26 078 052 0.26

27 |aa CIMS Lab, Inc. DBZ Transaction Elapsed Minutes 2003 01z 0.09 0.0z 028 008 0.04

28 [an CIMS Lab, Inc. M3 Windows Disk Size in MB 2003 0.00 0.00 0.00 0.00 0.00 0.00

29 |AA CIMS Lab, Inc. MS Windows Humber of Files 2003 0.08 0.08 01z 014 010 010

|44 ¥ [+ SYTDCODZ.1pt / [4] i

~

€] Done 9 Internet

Figure A-66 « Account Summary YTD by Rate Spreadsheet Example
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Account Summary YTD Cost by Rate Group Spreadsheet

File name: SYTDC003

Stored Procedure. None

This spreadsheet provides account summary YID information by rate code description

for the rate group selected for the parameters selected.
Drill down: None
Parameters:

Account Code Level

Report Year

Starting and Ending Account Code

B Rate Group

Report Example

CIMS Server - Microsoft Internet Explorer
File Edit View Favorites Tools Help i
Qe - © ¥ @ @ ) search ¢ Favarites @ media F) - 3
erezerezcboiccountCodetr ¥ | [Ed G0 Links
Year To Date Cost by Rate Select g;’::l‘ th Publish Return Help e |
L34 = =
A B © D E F G H | J
1 AccountCode AccountMarme RateDescription Year January  February March April May [l
2 |aa CIMS Lab, Ine. Roseville MS Exchange Bytes Sent 2003 3.10 611 4.04 742 24.40 18
3 [aa CIMS Lab, Inc. Roseville M3 Exchange Emails Sent 2003 0.00 0.00 0.00 0.00 0.00 0
4 [an CIMS Lab, Ine. Roseville MS Exchange Bytes Received 2003 342,53 503 .63 423,82 58332 1,403.41 666
5 [aa CIMS Lab, Inc. Roseville M3 Exchange Emails Recsived 2003 0.00 0.00 0.00 0.00 0.00 0
[ CIMS Lab, Inc. Gibbsboro  MS Exchange Bytes Sent 2003 0.01 0.0z 0.00 0.2z 4.69 1
7 |ed CIMS Lab, Inc. Gibbsboro M3 Exchange Ernails Sent 2003 0.00 0.00 0.00 0.00 0.00 0
i |eB CIMS Lab, Inc. Gibbsboro  MS Exchange Bytes Received 2003 £8.00 105 .40 47.73 58.55 158,94 171
9 [BB CIMS Lab, Inc. Gibbsboro M3 Exchange Emails Recsived 2003 0.00 0.00 0.00 0.00 0.00 0
10 cc CIMS Lab, Ine. Laurel MS Exchange Bytes Sent 2003 0.00 01z 0.00 0.00 078 a
1 cc CIMS Lab, Ine. Laurel M3 Exchange Emails Sent 2003 0.00 0.00 0.00 0.00 0.00 0
12 |cc CIMS Lab, Ine. Laurel MS Exchange Bytes Received 2003 43,71 106,21 86.03 89,18 122 37 55
13 cC CIMS Lab, Ine. Laurel M3 Exchange Emails Recsived 2003 0.00 0.00 0.00 0.00 0.00 0
14 oD CIMS Lab, Ine. International MS Exchange Bytes Sent 2003 0.03 122 0.01 073 061 a
15 DD CIMS Lab, Inc. International M3 Exchange Ernails Sent 2003 0.00 0.00 0.00 0.00 0.00 0
16 DD CIMS Lab, Ine. International MS Exchange Bytes Received 2003 93.03 141.40 96.94 175,70 60,59 28
17 DD CIMS Lab, Inc. International M3 Exchange Emails Recsived 2003 0.00 0.00 0.00 0.00 0.00 0
18 EE CIMS Lab, Ine. Services MS Exchange Bytes Sent 2003 0.00 0.00 0.00 025 774 3
19 EE CIMS Lab, Inc. Services M3 Exchange Emails Sent 2003 0.00 0.00 0.00 0.00 0.00 0
20 EE CIMS Lab, Ine. Services MS Exchange Bytes Received 2003 0.00 0.00 0.00 2.44 37372 158
21 EE CIMS Lab, Inc. Services M3 Exchange Emails Recsived 2003 0.00 0.00 0.00 0.00 0.00 0
22
23
24
25
26
27
28
29
14 4[> [ W} SYTDCO0Z.rpt / [4]
&) Done B Intemet
L

Figure A-67 + Account Summary YTD Cost by Rate Group Spreadsheet Example
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Crosstab Reports

This section describes the CIMS Server crosstab reports. You can run a crosstab report as
a report or a spreadsheet. The examples in this section show the report format.

Daily Crosstab—Charges
File name: XDAYC001

Stored procedure: CIMSSP_Summary_Day

This report provides total daily charges by account code and rate code description for the
parameters selected.

Drill down: None

Parameters:

m Account Code Level
m Starting and Ending Account Code
m From and To Date

Report Example

M CIMS Server - Microsoft Internet Explorer

Fle Edit Wew Favortes Tools Help w
Qe - © - [x] &) & 0 search 5 Favortes @ veda €2} - i 3
address @] htep: fwnw.cimsserver comjreptexec. aspHnvoicslevel=1 RccountCodeSt art=-+BrboAccountCodeStart=-+&Account CodeEnd bofccountCodeEnd vIBe ks *
Daily Crosstab - Charges Publish Return Help i
& & [liox «| [ 1 of 1+ [ # .
Preview |
~
CIMS |
Account Daily Crosstab - Charges From 6/1/2003 to 6/30/2003
Total All Days 6/1/2003 6/2/2003 6/3/2003
Total All Accounts 107,686.58 5,571.68 7,255.24 10,586.16
Af - CIMS Lab, Inc. Roseville | Total for Account 37,681.90 1,795.19 3,499.16 2,093.37
001 - 05790 Jobs Started 3,015.00 47.50 335.00 65.00
003 - 057790 Steps Started 2,884.50 39.00 321.00 38.00
005 - 05790 Cpu Mintes 5,584.72 44.06 287.79 33.25
013 - Tso Cpu Minutes 202.07 19.76 2.17 4.92
015 - Ta Connest Minutes 3,814.21 284.89 277.83 693.01
016 - Teo Inputs 42.95 7.83 0.26 0.07
016 - Tao Outputs 22.71 4.08 0.14 0.04
032 - Disk 5108 3,354.28 31.88 324.12 34.11
034 - Tape 5108 3,071.81 62.60 597.53 273.68
070 - Tnput Records 360.94 15.00 16.58 015
< >
v
€] Done ® Internet

Figure A-68 + Daily Crosstab—Charges Report Example
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Daily Crosstab—Usage
File name: XDAYROO1
Stored procedure: CIMSSP_Summary_Day

This report provides total daily resource usage by account code and rate code description
for the parameters selected.

Drill down: None

Parameters:

m Account Code Level
m Starting and Ending Account Code

®m From and To Date

Report Example

2 CIMS Server - Microsoft Internet Explorer
p

File Edt Yiew Favorites Tooks  Help W
Q@eeck - ) |ﬂ @ ) /: ) Search \‘::z‘ Favortes @ Media %) 32
Address | 4] http:jwww.cimsserver .comjreptexec. asp?InvaiceLevel=18AccauntCodeStart=+&rhoAccauntCodeStart=+&Account CodeEnd=zzzzzzzzzzticbofccaunt Codend=zzzzzzzz v | [og Go  Links ™
Daily Crosstab - Usage Publish Return Help &,
& & 10z | [ 1 of 14 P M #h .
Preview |
hd
£
Account Daily Crosstab - Resource Usage  rrom 6/1/2003 to 6/30/2003
Total all Days 6/1/2003 6/2/2003 6/3/2003
AM - CIMS Lab, Inc. Roseville
o0l - O5/380 Jobs Started 1,206 19 134
003 - O5/390 Steps Started 5,769 78 642
005 - 054390 Cpu Minutes 279.23 2.20 14.39 1.t
007 - 05/390 Cpu Minutes {Initiators) 2.72 0.05 0.28 ot
008 - 05/390 Cpu Minutes (All) 320.00 2.35 15.44 1.t
013 - Tso Cpu Minutes 8.08 0.79 0.09 0.:
015 - Tso Connect Minukes 15,256.70 1,139.57 1,111.33 2,772
016 - Tso Inputs 21,477 3,918 131
018 - Tzo Outputs 22,709 4,079 139
020 - Tso Cpu Minutes (Initistor) 0.08 0.00 0.00 ot
021 - Tso Cpu Minutes (A1) 8.61 0.85 0.09 (L 2
a o g
b
k&) Done B Internet

Figure A-69 + Daily Crosstab—Usage Report Example
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Detail by Identifier Crosstab
File name: XDETR001

Stored procedure: CIMSSP_Ident_Crosstab

This report provides total charges by rate code for a selected identifier value or values for

the date range selected.
Drill down: None

Parameters:

m From and To Date
m Identifier

m Start and End Value
Report Example

In this example, the identifier selected is Exchange User
values are both deborah.

2 CIMS Server - Microsoft Internet Exploren

and the identifier start and end

Fle Edit Wew Favortes Tools Help a
Qe - O |ﬂ @ ,;\J /-]Search 5\7 Favorites @ vedia ) - 3
Address ] http:/fmaw.cimsserver. comjreptexec. asp?Rangs=9BDateStart=6:2F1%2F 20038 FromDate=672F 1 % 2F 20038fromMonth=68FromDay=18fromyear=20036DateEnd=62 | g4 G0 Links ™
Detail by Identifier Publish Return Help &
& @& [+ [ 1 oft #h .
Preview |
—~
Detail by Identifier Crosstab
Date Range: 6/1 /2003 to 6/20/2002
Exchange User From deborah to deborah
600-MS Windows 601-MS Windows 603-MS Windows 640-MS Exchange | 641-MS Exchange | 642-MS Exchang
SQL Server SQL Server SQL Server Reads Bytes Sent Emails Sent Bytes Received
Records Duration (seconds)
Total 1.00 20.56 72.00 773,947.00 28,00 4,994,659
deborah 100 20.56 72.00 773,947.00 28,00 4,394,659
&
< g 9
&
@Dnr\a & Internet

Figure A-70 < Detail by Identifier Crosstab Report Example
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Detail by Identifier by Date Crosstab
File name: XDETR002
Stored procedure: CIMSSP_Ident_Crosstab_StartDate

This crosstab report provides total and total daily charges by rate code for a selected
identifier value or values for the date range selected.

Drill down: None

Parameters:

m From and To Date
m Identifier

m Start and End Value
Report Example

In this example, the identifier selected is Exchange User and the identifier start and end
values are both deborah.

2 CIMS Server - Microsoft Internet Explorer

Fle Edit ¥ew Favorites Tools Help e
Qe - © - [¥] [ & ) search 57 Favortes @ veda 2 - & 3
address |#&] hitp:/fmaw.cimsserver.comjreptexec. asp?Rangs=9BDateStart=6%:2F1%2F 20038FromDate=672F 1 % 2F20038fromMonth=68FromDay=18fromyear=20038DateEnd=62 ¥ | g G0 Links ™
Detail by Identifier by Date Publish Return Help &
& & [l «| [ 1 of 1+ [ # .
Preview |
m )
(¥ 2
Detail by Identifier by Date Crosstab
Date Range: 6/1 /2003 to 6/20/2002
Exchange User From deborah to deborah
600-MS Windows 601-MS Windows 603-MS Windows 640-MS Exchange
SOL Server SOL Server SQL Server Reads Bytes Sent
Records Duration (seconds)
Total 100 20,56 72.00 773,947.00
debarah Tatal 100 20,56 72.00 773,347.00
62 2005 0.00 0.00 0.00 0.00
3/ 2003 0.00 0.00 0.00 65,164,00
64 2003 0.00 0.00 0.00 3,485.00
65/ 2005 0.00 0.00 0.00 0.00
5/ 2003 0.00 0.00 0.00 62,816.00
5 2003 0.00 0.00 0.00 0.00
102003 0.00 0.00 0.00 65,609.00
et innn nnn nnn nnn 4N 200 nn hd]
< >
v
[&] Done B Internet
=

Figure A-71 « Detail by Identifier by Date Crosstab Report Example
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Monthly Crosstab—Charges
File name: XMONCOO1

Stored procedure: CIMSSP_Summary_Day

This report provides total monthly charges by account code and rate code description for

the parameters selected.
Drill down: None

Parameters:

B Account Code Level
m Starting and Ending Account Code
m From and To Date

Report Example

3 CIMS Server - Microsoft Internet Explorer

EIEX

File Edt Wew Favortes Tools  Help i
@ Back |£] @ 5 fﬂ ) Search J 7 Favoritss @ edia £2) - & 32
Address | &) http:fjwww.cimsserver, comfreptexec, asp7invoiceLevel=18AccountCadeStart=+&cboAccountCadeStart=-+&Account CodeEnd: hoAccountCad v Go  Links
Monthly Crosstab - Charges Publish Return Help *
& & [z« [ 1 of 1+ P M #h .
Preview |
-~
CIMS =
CIMS |
Account Monthly Crosstab - Charges From 6/1/2003 to 6/30/2003
Total All Months 06/2003
Total All Accounts 136,267.56 136,267.56
AA - CIMS Lab, Inc. Roseville | Total for Account 45,536.00 45,536.00
001 - 057390 lobs Started 3,630.00 3,630.00
003 - O5/390 Steps Started 3,567.50 3,567.50
005 - 0S/390 Cpu Minutes 6,286.04 6,286.04
013 - Tso Cpu Minutes 247.92 247.92
015 - Tso Connect Minutes 4,554.65 4,554.65
016 - Tso Inputs 58.01 58.01
018 - Tso Outputs 30.93 30.93
032 - Disk §10s 4,081.29 4,081.29
034 - Tape S10s 3,605.01 3,605.01
070 - Input Records 386.05 386.05 @
< >
v
&) Done B Internet
|

Figure A-72 + Monthly Crosstab—Charges Report Example
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Monthly Crosstab—Usage
File name: XMONROO1

Stored procedure: CIMSSP_Summary_Day

This report provides total monthly resource usage by account code and rate code
description for the parameters selected.

Drill down: None

Parameters:

m Account Code Level

m Starting and Ending Account Code

®m From and To Date

Report Example

2 CIMS Server - Microsoft Internet Explorer

Filg Edit Wiew Favorites Tools  Help
Qu- O ¥ @ & ) ssarch S Favorkes @ Meda 42} 2 :;. <] b7 3
Address | @] http:fjwww.cimsserver, comfreptexec, asp7InvaiceLevel=18sccountCodeStart=+&rbasccountCodeStart=+&Account CodeEnd=zzzzzzzzzztichofccount CodeEnd=zzzzzzzzz ¥ Go  Links >
Monthly Crosstab - Usage Publish Return
| x & &fwr =] || 4 4] 1 of 1+ P os||dA | B
Preview | )
=
Account Monthly Xtab - Resource Usage From 6/1/2003 to 6/30/2003
Total All Months 06/2003
AA - CIMS Lab, Inc. Roseville
001 - OS5/390 Jobs Started 1,452 1,452
003 - O5/390 Steps Started 7,135 7,135
005 - O5/390 Cpu Minutes 314.29 314.29
007 - O5/390 Cpu Minutes (Initistors) 3.44 3.44
008 - 0S5/390 Cpu Minutes (All) 357.27 357.27
013 - Tso Cpu Minutes 9.92 9.92
015 - Tso Connect Minutes 18,218.45 18,218.45
016 - Tso Inputs 29,003 29,003
018 - Teo Qutputs 30,926 30,926
020 - Tso Cpu Minutes (Initistor) 0.11 0.11
021 - Tso Cpu Minutes (4ll) 10.60 10.60 e
1] 3 |l
e
&) Done B Internet
|

Figure A-73 + Monthly Crosstab—Usage Report Example
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Summary Crosstab—Charges
File name: XSUMC001
Stored procedure: CIMSSP_Summary

This report provides total charges by account code and rate code description for the
parameters selected.

Drill down: None

Parameters:

m Account Code Level
m Starting and Ending Account Code
m From and To Date

Report Example

3 CIMS Server - Microsoft Internet Explorer

File Edt Wew Favortes Tools  Help w
Qu- O [¥][@ & ) searh 7 Favorites @ viedis €2) r :\7 3
Address | @) http:fjwww.cimsserver, comfreptexec asp7InvaiceLevel=18sccountCodeStart=+&rbafccountCodeStart=+&Account CodeEnd=zzzzzzzzzatichofccount CodeEnd=zzzzzzzzz ¥ Go  Links
Summary Crosstab - Charges Publish Return Help A
S & [z - [ 1 o1 # =B
Preview |
-
CIMS I
Account Summary Crosstab - Charges From 6/1/2003 to 6/30/2003
057390 Batch charges
001 - 057390 Jobs 003 - 057390 Steps 005 - 05/390 Cpu 007 - 05/390 Cpu
Started Started Minutes Minutes {(Initiators)
AR - CIMS Lab, Inc. Roseville 3,630.00 3,567.50 6, 286,04 0.00
BB - CIMS Lab, Inc. Gibbsboro 1,795.00 F00. 00 2,187.76 0.00
CC - CIMS Lab, Inc. Laurel 745,00 1,085.50 3,109.22 0.00
DD - CIMS Lab, Inc. International 285,00 1,337.50 381,43 0.00
EE - CIMS Lab, Inc. Services 167.50 .50 0.z4 0.00
L
Q) s U
b
&) Done @ Internet
L

Figure A-74 + Summary Crosstab—Charges Report Example
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Summary by Rate Group Crosstab—Charges
File name: XSUMC002
Stored procedure: CIMSSP_Summary_RateGroup

This report provides total charges by account code and rate code description for the rate
codes within a selected rate group for the parameters selected.

Drill down: None

Parameters:

m Account Code Level

Starting and Ending Account Code
m From and To Date
® Rate Group

Report Example

2 CIMS Server - Microsoft Internet Explorer "-_”‘El@‘
Fle Edt View Favortes Tooks Help i

Qe - O \ﬂ @ f . D search ‘irl:."Favur\tEs @ e 2 - & L3

Address | @] http: | Juw. cinsserver. comfreptescer  asp?Invoicel evsl=1 fAccount CodeStart=+arhoAccount CodeStart=+&ccountCodeEnd: hafccountCodeEnd vBe ks ?
Summary Crosstab 2 - Charges Publish Return Help &
& @[l +| [ 1 of i =
Preview |
-
Summary By Rate Group Xtab - Charges  rrom6/1/2003 to 6/30/2003
0S /390 Batch charges
001 - 0S£390 Jobs 003 - 0S/390 Steps 005 - 0S/£390 Cpu 007 - 0S/£390 Cpu
Started Started Minutes Minutes (Initiators)
AA - CIMS Lab, Inc. Roseville 3,630.00 3,567.50 6,286.04 0.00
BB - CIMS Lab, Inc. Gibbsboro 1,795.00 700.00 2,187.76 0.00
CC - CIMS Lab, Inc. Laurel 745.00 1,085.50 3,108.22 0.00
DD - CIMS Lab, Inc. International 285.00 1,337.50 361.43 0.00
EE - CIMS Lab, Inc. Services 167.50 8.50 0.24 0.00
Total All Accounts 6,622,50 6,693,00 11,964,569 0.00
v
< >
v
&) Done B Intemet
—

Figure A-75 « Summary by Rate Group Crosstab—Charges Report Example
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Summary Crosstab—Usage
File name: XSUMR0O1

Stored procedure: CIMSSP_Summary

This report provides total resource usage by account code and rate code description for

the parameters selected.
Drill down: None

Parameters:

B Account Code Level
m Starting and Ending Account Code
m From and To Date

Report Example

2 CIMS Server - Microsoft Internet Explorer,

Fle Edit View Favortes Toos Help Iz
Qe - Q- ¥ @ B ) search 5 ¢ Favories @ e ) - &8 3
Address | &) http: | fuwa, cimsserver.com|reptexec, aspPInvaicel evel=1&Accaunt CodeStart boaccountCodestart: countCodeEnd=zzzzzzzzzzBrboAccountCodeEnd=zzzzzzzzz ¥ ﬂ Go  Links >
Summary Crosstab - Usage Publish Return Help o]
Z & [z <] [ 1 ooft h .
Preview |
.
Account Summary Xtab - Resource Usage From 6/1/2002 to 6/20,/2002
001 - 0S£390 Jobs 003 - 0S/390 Steps 005 - 0S/£390 Cpu 007 - 0S/£390 Cpu
Started Started Minutes Minutes (Initiators)
AA - CIMS Lab, Inc. Roseville 1,452 7,135 314.29 3.44
BB - CIMS Lab, Inc. Gibbsboro 718 1,400 109.38 0.96
CC - CIMS Lab, Inc. Laurel 298 2,171 155.46 1.41
DD - CIMS Lab, Inc. International 114 2,675 19.07 3.23
EE - CIMS Lab, Inc. Services 67 17 0.01 0.01
Total All Accounts 2,649 13,398 598.22 9.05
A
3]} Ea
b
&) Done # Internet

Figure A-76 + Summary Crosstab—Usage Report Example
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Summary by Rate Group Crosstab—Usage

File name: XSUMR00?

Stored procedure: CIMSSP_Summary_RateGroup

This report provides total resource usage by account code and rate code description for

the rate codes within a selected rate group for the parameters selected.

Drill down: None

Parameters:

m Account Code Level

m From and To Date
® Rate Group

Report Example

2 CIMS Server - Microsoft Internet Explorer,
File Edit View Favorites Tools  Help

Qe - O

Starting and Ending Account Code

\ﬂ @ ) ) smach ¢ Favaries @ ieda ) - &8

)3

EEX
%

Summary Crosstab 2 - Usage

& &l ~| [ 1 of 1

Preview |

Address ] http: fum. cimsserver. com/reptesec. ssprInvoicel svel=1BAceount CodeStart=-+&rboAccount CodeStart=+aAccountCodeEnd

]

boAccountCodeEnd

Publish

Return Help

Links **

~

QS /390 Batch charges

Summary By Rate Group Xtab - Usage

From 6/1/2003 to 6/230/2002

001 - 05/390 Jobs 003 - 05/390 Steps | 005 - 05/390 Cpu 007 - 05/390 Cpu
started started Minutes Minutes {Initiators)
AA - CIMS Lab, Inc. Roseville 1,452 7,135 314.28 3.44
BB - CIMS Lab, Inc. Gibbsboro 718 1,400 109.38 0.96
CC - CIMS Lab, Inc. Laurel 2908 2,171 155.46 1.41
DD - CIMS Lab, Inc. International 114 2,675 19.07 3.23
EE - CIMS Lab, Inc. Services 67 17 0.01 0.01
Total All Accounts 2,649 13,398 598.22 9.05
<
v
€] Done @ Itemet
L

Figure A-77 « Summary by Rate Group Crosstab—Usage Report Example
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Weekly Crosstab—Charges
File name: XWEKCOO01

Stored procedure: CIMSSP_Summary_Day

This report provides total weekly charges by account code and rate code description for

the parameters selected.
Drill down: None

Parameters:

B Account Code Level
m Starting and Ending Account Code
m From and To Date

Report Example

3 CIMS Server - Microsoft Internet Explorer

Filg Edit Wiew Favorites Tools  Help

EEX

@ Back ~ Iﬂ IELI p /' ) Search \‘,‘:‘\;‘f Favories @ Media ) - & 3
Address | @] http:jwww.dmsserver, comjreptexec. asp?InvoireLevel=18AccountCodeSt art=-+&rbofccountCodeSt art=-+&Account CodeEnd hafccount CodeEnd: v Go  Lnks
Weekly Crosstab - Charges Publish Return Help i
& &[0z« [ 1 of i+ [ # .
Preview |
a8
CIMS |
5 ", ]
Account Weekly Crosstab - Charges From 6/1/2003 to 6/30/2003
Total all weeks 6/1/2003 6/8/2003 6/15/2003
Total All Accounts 136,267.56 55,238.90 72,029.64 8,999.02
AA - CIMS Lab, Inc. Roseville | Total for Account 45,536.00 20,722.47 22,149.14 2,664.39
001 - 057390 lobs Started 3,630.00 1,710.00 1,732.50 187.50
003 - O5/390 Steps Started 3,567.50 1,703.00 1,750.50 114.00
005 - 0S/390 Cpu Minutes 6,286.04 1,336.29 4,642.60 307.15
013 - Tso Cpu Minutes 247.92 123.83 100.34 23.75
015 - Tso Connect Minutes 4,554.65 Z,553.55 1,611.55 389.55
016 - Tso Inputs 58.01 31.02 zo.01 6.98
018 - Tso Outputs 30.93 16.39 10.60 3.94
032 - Disk §10s 4,081.29 1,938.87 1,823.76 318.66
034 - Tape S10s 3,605.01 1,626.29 1,817.30 161.42
070 - Input Records 386.05 288.81 82.62 14.62 @
< bd
v
&) Dane B Internet
=

Figure A-78 « Weekly Crosstab—Charges Report Example
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Weekly Crosstab—Usage
File name: XWEKROO1
Stored procedure: CIMSSP_Summary_Day

This report provides total weekly resource usage by account code and rate code
description for the parameters selected.

Drill down: None

Parameters:

m Account Code Level
m Starting and Ending Account Code

®m From and To Date

Report Example

2 CIMS Server - Microsoft Internet Explorer

Fls Edt Wew Fowortss Took  Help o
@rac - ) |ﬂ @ ) /: ) Search \Eﬂz‘ Favortes @A Media %) 32
ficress | &) Pttps i, dmsserver comjreptesec asp7lvaiceL evel=2accountCodeStart=-+ExbofccountCodeStart =+ BccoUnt CodeEnd—zazarararadrbodccount Codebnd=zarazare: v | [ 5o ks
Weekly Crosstab - Usage Publish Return Help A
& & [z« [ 1 o1+ P M #h .
Preview |
A
Account Weekly Crosstab - Resource Usage rroms/1/2003 to 6/30/2003
Total All Weeks | 6/1/2003 6/8/2003 6/15/2003
ABAAAR - Roseville - CIMS
(eeth G e 001 - 05390 Jabs Started 2,037 527 474 41t
003 - 0520 Steps Started 11,769 3,060 3,151 2,151
005 - 05290 Cpu Mintes 235.50 57.56 64.05 39.21
007 - OS2 Cpu Mirtes (Initistors) 5.45 1.42 1.48 .91
008 - 057390 Cpu Mintes (all) 254.29 62.48 68.96 42.61
013 - Teo Cpu Minutes 1.18 0.47 0.04 0.z;
015 - Teo Connest Mindtes 8,779.67 2,854.19 225.67 1,963.3:
016 - Teo Inputs 1,423 302 22 51
018 - Teo utputs 1,543 330 25 541
020 - Teo cpu Minuites (Tritistor) .04 .01 0.00 0.0
D21 - Teo Cpu Minutes (all) 1.28 0.50 0.04 0.3
g @ 3 |l
hd
&) Done @ Internet
|

Figure A-79  Weekly Crosstab—Usage Report Example

CIMS Server Web Reporting User’s Guide A-103 N



B Standard Reports

Templates

This section describes CIMS Server report templates. These templates are launched when
you create a report in CIMS Server Web Reporting (see Creating and Running CIMS Web
User Created Reports on page 2-9). Templates can be customized, but custom templates
must be stored in the same directory as the standard templates. If CIMS Server is installed
in the default path, the location is C: \Program Files\CIMSLab\Server\Reports\
Standard\Templates. Please consult CIMS Lab before you customize templates.

Report Both Template

B A-104

File name: RTMPB001
Stored procedure: CIMSSP_Summary

This template produces Both reports that show resource usage and charges by account
code and rate code description for the parameters selected.

Drill down: None
Parameters:

m Account Code Level

Starting and Ending Account Code
® From and To Date
m Four rate codes (selected when report was created)

m Four decimal place options (selected when report was created)
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Report Examples

Figure A-80 shows the creation of a Both report called Job Report. Figure A-81 shows the
resulting report that has been run from the Reports menu.

2 CIMS Server - Build a Report - Microsoft Internet Explorer

Edt View Favorites Toos Help ]

File

Qe - Q¥ @ & ) search 5o Favortes ) - :,‘_ o, . o
address | €] b fumw, cmsserver.com{govDefineCust SUMRpES. 3sp7OUEPLEType=RAReset=trus v B @

CIMS

Server

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Build a Report

Please select parameters for Report
Go to Report: | (New Report) &
Report Type: | Both -

Report Name: | Job Fepart |

Report Description: |

[Jiake visible to all users

Resource Decimal Places
Column 1: | 2001 - Mainframe Jubs Started v
Column 2: | 2003 - Mainframe Cpu Minutes ]
Column 3: | ]
Column 4: | ]
Add
&) © Internet

Figure A-80 + Creating a Report Example

ZA CIMS Server - Microsoft Internet Explorer

File Edt View Favorites Tools Help ]
- Y ®) o, ; >, B i 3 o

@aack Q @ @ _h O ssarch 57 Favortss @ =2 =Y ﬁ 3 é

e | ] hp: . cimsserver,com/gov/CrystalReportsInterartiveiswer  asprInvoicel evel=18fateCod RateCodez=200 Raterodes=aRatecoded: v | [ 6o @

Job Report Publish Return

dministrative Services

ealth & Human Services

epartment of Transportation Job Report

epartment of Corrections

Account Range: All Accounts
Date Range: 11/1/2004 to 11/30/2004

Account Mainframe
Jobs Started Jobs Started  Cpu Minutes Cpu Minutes
Cost Cost

Af-Administrative Services

2.00 18.00
BB-Health & Human Services
117.00 234,00 9.61 96,10
CC-Department of Transpartation
.00 12.00 39.66 396,65
DO-Department of Corractions
9.00 18.00 0.32 3.24
Run Total 141,00 282.00 49.60 495.99
v
4 >
&) B Internet

Figure A-81 + Generated Report Example
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The preceding examples are also applicable to the Cost and Resource reports with the
following exceptions:

m The Report Type is Cost or Resource rather than Both.

B The resulting report shows resource usage or charges, not both.

Report Cost Template
File name: RTMPC001
Stored procedure: CIMSSP_Summary

This template produces Cost reports that show charges by account code and rate code
description for the parameters selected.

Drill down: None
Parameters:

B Account Code Level

Starting and Ending Account Code

® From and To Date

m Eight rate codes (selected when report was created)

m Eight decimal place options (selected when report was created)
Report Example

See page A-105.
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Report Resource Template
File name: RTMPROO1
Stored procedure: CIMSSP_Summary

This template produces Resource reports that show resource usage by account code and
rate code description for the parameters selected.

Drill down: None

Parameters:

® Account Code Level

m Starting and Ending Account Code

m From and To Date

m Eight rate codes (selected when report was created)

m Eight decimal place options (selected when report was created)
Report Example

See page A-105.

Spreadsheet Both Template
File name: STMPB001
Stored Procedure. None

This template produces Both spreadsheets that show resource usage and charges by
account code and rate code description for the parameters selected.

Drill down: None

Parameters:

m Account Code Level

m Starting and Ending Account Code

® From and To Date

m Four rate codes (selected when spreadsheet was created)

m Four decimal place options (selected when spreadsheet was created)
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Report Example

Figure A-81 shows the creation of a Both spreadsheet called Oracle Usage. Figure A-82
shows the resulting report that has been run from the Spreadsheets menu.

2 CIMS Server, - Build a Spreadsheet - Microsoft Internet Explorer

File Edit View Favorites Tools  Help

Q- © ¥ @ & ) smach ¢ Favaries @ vedia §2) (- ; & - 3
acddress | €] hitpe o, cmsserver.com{DefineCustSunRpts. sspPOLpUL Type=SBResst—true

CIMS

Server

~

Beo ks ®

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Build a Spreadsheet

Please select parameters for Spreadsheet
Go to Spreadsheet: | (new Spreadsheet) v
Spreadsheet Type: |Both v

Spreadsheet Name: |Oracle Usage |

spreadsheet Description: |

[IMake visible to all users

Resource
Column 1: [LLE101 - Oradle Legins v
Column 2: [ LLE10Z - Oracle Session CPU ]
Column 3: [LLE103 - Oracle Cannect ]
Column 4: [ LLE104 - Oracle Uga Memory ]
oAdd )
Ig CIMS Server is ready. B Intemet

Figure A-82 + Creating a Spreadsheet Example

CIMS Server - Microsoft Internet Explorer

File Edt View Favorites Tools Help FL
C & Al @ 2 | . B P

Qe - O E @ 0 O sk Sl rsrtes @hveds €8 (- L B 3

Address | @] http: | fwwaw. cimsserver.com|reptexec, asp?Invaicel evel=1&Accaunt CodeStart=+acboAccount Codestart countCodeEnd=zzzzzzzzzztchofccounts v | [eg 6o Links

Oracle Usage Open with Publish Return
Excel

A B [ ¢ T o [ E [ F [ & [H[ v T 0 T K 7

Accountiams AccountCode Oracls Logins Oracls Logins Oracls Sessio Oracls Sessio Oracls Connsct | Oracle Conng Oracle Uga Msmary | Oracls Uga [
CIMS Lab, IniAA 40.00 0.80 32088 73.77  2,514.90 1,131.71 7,073,367.38 17.66
CIMS Lab, InMBE: 58.57 13.50  2,520.00 1,134.00 64,150.92 015
CIMS Lab, ImCC 10.00 0.20 53.07 12,21 3,240.21 1,458.10 2,445,944.94 6.11
CIMS Lab, IniEE 95.00 1.50 511.20 186.58  2,078.07 935.14 9,671,392.14 24.20

R P P ) R Y Y ) Y Y N

i« 4 » [»lSTMPBODLApE 14 | ’”J -
-
&) Done B Intemet
o

Figure A-83 + Generated Spreadsheet Example
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The preceding examples are also applicable to the Cost and Resource spreadsheets with
the following exceptions:

m The Spreadsheet Type is Cost or Resource rather than Both.

B The resulting spreadsheet shows resource usage or charges, not both.

Spreadsheets Cost Template
File name: STMPC001
Stored Procedure. None

This template produces Cost reports that show charges by account and rate code
description for the parameters selected.

Drill down: None

Parameters:

m Account Code Level

m Starting and Ending Account Code

® From and To Date

m Eight rate codes (selected when spreadsheet was created)

m Eight decimal place options (selected when spreadsheet was created)
Report Example

See page A-108.
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Spreadsheets Resource Template
File name: STMPROO1
Stored Procedure. None

This template produces Resource spreadsheets that show resource usage by account and
rate code description for the parameters selected.

Drill down: None
Parameters:

B Account Code Level

Starting and Ending Account Code

®m From and To Date

Eight rate codes (selected when spreadsheet was created)
m Eight decimal place options (selected when spreadsheet was created)
Report Example

See page A-108.
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ASP  Acronym for Active Server Pages. A server-side scripting environment developed
by Microsoft for developing Web pages and applications.

CIMS Server Resource File ¢ The resource file that contains the data that is input into
CIMS Server. The CIMS Server Resource File contains CIMS Server Resource Records.
These records are comma-delimited and can contain a very large number of resource
identifiers and resources. See also identifier and rate code.

cookie ¢ A small text file that stores information about a Web site user. CIMS Server
Web Reporting stores user information, such as the report parameter values entered by a
user, in a cookie.

identifier ¢ In the CIMS Server Resource Record, a unique key that denotes the source
of a resource that has been consumed. Examples include device name, server name,
system ID, phone number, user ID, state code or building number. A consumed resource
can have one to many identifiers.

IIS * Acronym for Internet Information Services. Microsoft software that supports Web
site creation, configuration, and management.

ODBC ¢ Acronym for Open Database Connectivity. An interface providing a common
language for database access.

rate code ¢ A rate code represents the resource units being reported (for example, CPU
time, transactions processed or lines printed). The rate code includes the value for the
resource and other rate processing information.

stored procedure ¢ A set of SQL statements that can perform both queries and actions
that allow the system to generate a report or reports.

URL ¢ Acronym for Uniform Resource Locator. The address for a resource on the
Internet or an intranet.

XML < Acronym for Extensible Markup Language. A meta-markup language that
provides a format for describing structured data. XML allows for more precise
declarations or content and more meaningful search results across multiple platforms.
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